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Introduction

We'd like to extend a warm welcome to all railroad hobbyists and train simulator 
enthusiasts.

With recent advances in both computer hardware and software, we now have a 
powerful Microsoft Train Simulator. Train Simulator has capabilities that are quite 
remarkable. Train Simulator delivers scenery with great fidelity, trains with visual 
beauty, controls with high precision. All of these characteristics make the train 
simulation experience very realistic. Train Simulator makes it possible for you to build 
trains, rolling stock and scenery which duplicate real-life railroad scenarios. In fact, 
you'll be able to build imaginary scenerios too.

We know that most users choose train simulation because they'll never be able to sit 
behind the throttle of a locomotive. Not only does Train Simulator let you drive today's 
modern engines, but it can take you back in time to the age of the steam locomotives. 
And Train Simulator doesn't confine you to the common everyday routes. You can 
make railroad stations from the 1800's complete with the accessories from years gone 
by.

It is with the idea of expanding the world of Microsoft Train Simulator capabilities that 
programmer Louis SInclair has developed Train Sim Modeler.

With Train Sim Modeler even beginning designers can easily create 3D scenery 
objects and trains to enhance their Microsoft Train Simulator environment. To best 
learn to use this new designer tool, we've prepared this manual. Please follow along 
with the topics you'll find here as we introduce you to the basic concepts, terminology, 
and exercises that will get you started using this powerful program. 

Continue with Getting Started. 



Getting Started
 

If you're reading this document, then we assume that you have already installed Train 
Sim Modeler onto your computer system.

The installation is typical of all Windows installations. When you install Train Sim 
Modeler, all of the necessary folders are created and the executable files, accessory 
files, sample parts, templates, textures, projects and documentation are copied to 
your hard drive.

During installation, you'll be asked to type a number in the Serial: field. This number is 
also referred to as your Registration Key provided to you at the time of purchase. 
Please retain a copy of this Registration Key in case you have to reinstall Train Sim 
Modeler at a later time.

If you haven't already done so, install Train Sim Modeler now so that you can follow 
along as we present a series of exercises that will demonstrate many of the program's 
powerful design features.

After the installation, you'll see a new icon on your desktop that looks like this:

As with any other Windows application, double-click on this icon to run it. The first 
time that you run it, Train Sim Modeler will look around on your computer for several 
files including your copy of MSTS. If it isn't able to find MSTS, you'll be asked to 
browse to the MSTS folder manually. For a detailed description, please see 
Preferences in the Reference section of this document.

Go on to the next topic The 3D World 



Setting Train Sim Modeler 
Preferences
 

The first time you start it, Train Sim Modeler will try to find the folder in which your 
copy of Train Simulator is installed. You'll see the following informational message

Press the OK button to continue. If it is unable to find Train Simulator automatically, 
you can manually locate it using the Application Preferences dialog which appears 
next.



The Application Preferences is composed of two parts.

Towards the top of the dialog are the paths to several key folders in which Train Sim 
Modeler finds, stores and reads various files. These File Folders are:

●     Simulator the path to your copy of Microsoft Train Simulator
●     Texture Files the path to the folder which contains the textures that you can 

apply to any of your 3D objects. By default, this is set to your Train Sim Modeler 
\texture folder

●     Project Files the path to the folder which contains the project files for your 
designs. By default, this is set to your Train Sim Modeler \projects folder

To change any of these paths, simply click on the respective button and Browse to the 
appropriate folder.



Beneath the paths is a dialog indicating the colors used by Train Sim Modeler to 
display the various components and several other choices:

●     Part all parts except for the current part or selected part(s) are displayed in this 
color 

●     Current Part only the current part is displayed in this color 
●     Part Axis all of the axis are displayed in this color 
●     Selected only the selected item(s) are displayed in this color 
●     Current and Selected only the items which are both current and selected are 

displayed in this color 
●     Current Polygon only the current polygon is displayed in this color 
●     Cross Section only the cross section is displayed in this color 
●     Point all points except for the current point is displayed in this color 
●     Current Point only the current point is displayed in this color 
●     Grid all of the grid lines are displayed in this color 
●     Grid Axis all of the axis for the grid are displayed in this color 
●     Text all text is displayed in this color 

To change any of the Colors, click on the respective name and the following Select 
Color dialog appears. Simply click on the desired color and then click the OK button.

Notice the Units grouping towards the right of the Application Preferences dialog. This 



lets you change between English (feet) and metric measurements.

There are two additional checkboxes at bottom of the Application Preferences dialog:

  

❍     Opening Video - check or uncheck this box to enable or disable playing 
the video as FS Design Studio starts. 

❍     Wireframe Rotation - check or uncheck this box to enable or disable 
wireframe rotation. One of the key features of Train Sim Modeler is its 
ability to display your 3D scenery object or aircraft as a solid model in 
perspective - very similar to how it will appear in Microsoft Train 
Simulator. When rotating very complex objects, the solid model 
perspective view may take a few seconds to redraw. By unchecking this 
box, the perspective view is temporarily changed to a wireframe view 
until the rotation is complete at which time the drawing is changed back 
to the solid view. 

 

Continue with the Reference Section - Project Properties



Setting Project Properties
 

The Project Properties dialog contains global settings for your scenery or aircraft 
project. Many of these parameters are only used for some type of scenery object.

There are only a few items to be set for the project:

Project Name

This is the name of your project. The Project Name is added to the Train Simulator 
*.ref file description for a given route.

Complex Object

Check this box if this represents a complex object i.e. the parts have an hierarchical 
relationship

Last Animation Frame

Enter the number of the last animation frame used by this project

 

Continue with the Reference Section - Part Properties 



The 3D World
 

If you're already familiar with 3D concepts and Computer Aided Design (CAD) programs, you 
may want to skip over this section.

To use Train Sim Modeler, you'll have to understand a little about how the Train Simulator 3D 
world is represented.

On a piece of paper, it's very easy to represent two dimensional space. Up and down 
represents one axis and left and right represents the second axis.

However it's not as simple to represent three dimensional space unless you can draw in a 
perspective view. Look at the illustration below in which we've depicted a red building in 3D 
space.
 

      

The three dimensions are represented in three axes:

●     The X-axis runs horizontally from the left side to the right side. 
●     The Y-axis runs vertically from the bottom to the top. 
●     To represent the Z-axis, you have to revert to perspective view since the Z-axis actually 

runs from back to front.

In the Top, Front and Side views, each axis is identified and an arrow points in the direction of 
increasing value (positive). Notice that in the Front view, the value of X increases towards the 



left. This is a convention adopted by Train Sim Modeler to account for the fact that if you are 
looking at an object from the front, the right side of that object would actually be to your left.

Now go on to the next section that describes the layout of the Train Sim Modeler window The 
Screen 



The Screen
 

The Train Sim Modeler screen is divided into four panes or views: These views are named Top, Front, Side and 
Perspective.

Together, these four views create a powerful environment within which you create your objects. The perspective view 
can be rotated interactively with the mouse so you can examine your object from any angle you choose.

Only one of the four views is active at a time. To activate a view, click somewhere within one of the view windows. A 
yellow border indicates the active view. In the next illustration, the Side view is the active view.

 

The Top View (upper left pane) shows your project as if you are looking straight down at it. The front of your object is 
toward the top of the view, in the positive Z-direction.

The Front View (lower left pane) shows the project as if you are standing in front of it, looking at the front of the 
object. Because of this, the front view X-coordinates are reversed. This can be confusing at first. A part of the left side 
of the top view will appear in the right side of the front view, just like in real life.

The Side View (bottom right pane) shows your project as if you are looking at it from the right. The front of the object 
is to the right, in the positive Z-axis.



The Perspective View (top right pane) shows your project in 3 dimensions. You can change the viewing direction to 
any angle. In perspective view, holding the left mouse button down while dragging the mouse rotates the object. 
Left/right motion rotates the object around the Y-axis while up/down motion rotates it around the X-axis. Holding down 
the left button and right button lets you rotate the object around the Z-axis.

At any time, you can enlarge the size of any of the four views. To enlarge the size, place your mouse inside the 
desired view and right-click. The pop-up menu illustrated below is displayed. Simply check the Expanded View menu 
item.

The selected view is immediately enlarged and occupies the entire Train Sim Modeler window as below:

 

At times, you may prefer to use expanded view in order to edit or display your object in more detail.



To revert back to the default Train Sim Modeler window of four simultaneous views, right click and uncheck the 
Expanded View item in the popup menu.

As in most Windows programs, a menu of commands is available at the top of the Train Sim Modeler window.

Although the number of commands available to you may seem daunting at first, you can accomplish a great deal with 
a small number of these commands. See the Reference Section - Menus for the complete list of commands.

Various toolbars give you access to more commonly used commands. If you're not sure what a toolbar button does, 
hold your mouse pointer over it for a few seconds and a small help windows will appear with a brief description of the 
command. See Toolbars in the Reference Section for a complete description of the different commands.

A Status Bar at the bottom of the Train Sim Modeler window provides you with various items of information.

On the left is a text area that describes the currently selected menu items.The next field shoes the current coordinates 
(x and y) of the cursor. The next field has three sub-fields: the name of the object, the visibility range in meters and 
the current part name. You can specify the name of the object using menu item Object | Properties | Object 
Name and the visibility range using menu item Object | Properties | Visibility Range and the current 
part name using menu item Edit | Part Properties | Part Name

Before you get started making 3D scenery object and aircraft, you'll have to become familiar with some of Train Sim 
Modeler's terminology. In the next section, you'll read about the terms and phrases that are at the heart of the 
program. Please go on as we tell you about some of the "language" in Train Sim Modeler as we continue with The 
Jargon. 



Part Properties
The Part Properties dialog contains various settings that affect individual parts.

The Part Name may contain reserved names (see Train Names). When one of these 
reserved names is used, Train Sim Modeler handles this part in a special way. For 
example, the name Boogie1 identifies this part as a wheel assembly. Train Simulator 
automatically animates this part as if it were a boogie.

The Part Parent field identifies the name of the direct hierarchical parent part. In this 
example, the parent of WiperBlade4 is a part named MAIN.

Enter the X, Y and Z coordinates of the Axis Location to specify the location of the 
axis. This method is more precise than when you drop or drag the part on the 
drawing.

You can specify the application of a special effect for this part by clicking on the 
Material button and choosing one of the effects from the drop down list. If you select 
one of the special materials, the Set Material checkbox is checked.

You can specify the part color by clicking on the Color button and choosing the color 
from the dialog.



Check any of the checkboxes which indicate that this part should have Polygon 
Smoothing enabled, this part is considered a Reference Part Only (no visible code 
for this part generated).

Material List 
When a part has one of these Material names applied to it, they produce special 
effects with the corresponding texture. For more information see Reference - 
Materials.



Train Part Names
When a part is assigned one of these special Train Part Names, the Train Simulator 
automatically animates the part.





 

Continue the Reference Section - Merging Projects 



Terminology used by Train Sim Modeler
 

Train Sim Modeler is new. And along with a new program is a new set of terms and definitions 
with which you'll have to become familiar. Please read this now so that you'll have fewer 
questions later.

To design an object using Train Sim Modeler, you'll create a new project.

Your project will consist of a single object that is made of one or more separate parts.

A part is made up of individual points. A point defines a vertex, a location in three-dimensional 
space. The part is usually made of one or more polygons also made from those points or 
vertices.

A simple part, for example a building, may only have one part (for example, a box) that has 
been ‘painted’ by pasting a texture (a graphic image) on to the faces of the box.

A complex part, for example a locomotive, may have dozens or even hundred of parts, some of 
which may change position (pantograph) or rotate (wheel.)

A part is may be either structured or unstructured. A part is structured if it has one or more 
cross sections each with an identical number of points. The points in a cross section may be 
edited as a group. If a part does not contain cross sections, then it is considered unstructured.

You make parts by choosing one of the eight basic primitive parts from the menu or by using a 
template, a 2-dimensional outline, and either sweeping the template or extruding the template.

The basic hierarchy of an Train Sim Modeler object is as follows:



As with most design projects, you'll find that you have to work at varying levels of detail. For 
some design tasks, you'll want to edit an entire object made of several parts; for other design 
tasks you'll want to edit a single part; and for still others you may want to edit much more detail 
such as a single polygon or single point. To accommodate the different levels of detail, you'll 
change Train Sim Modeler's operating mode.

To perform an editing operation, you'll work with one or more item. An item may be a part, a 
polygon, a point or a cross section, a template depending on the operating mode. For some 
operations, you will edit only a single item, usually the current item. For other operations, you 
can edit multiple items. You specify which of these items you'll work with by choosing the 
selected items.

Here's a little more detailed description of some of the terminology that you'll want to become 
familiar with in order to use the design capabilities of this software:

Project

A collection of parts arranged to make an entire object.

Part

A part consists of a location (X, Y, and Z coordinates), a list of points (vertices), and a list of 
polygons. Additional information about the part is also retained and used during editing and 
when a Flight Simulator object is being created



Structured Parts

A part may be structured or unstructured. If a part is structured, it means it is made up of 
separate cross sections with equal point counts and connected by a polygon ‘skin.’ You would 
use a structured object to create anything manufactured in this way in real life, including wings 
and fuselages. In many cases, you will start by creating a structured object, then editing the 
individual points and polygons.

Some edit operations cause a structured object to become unstructured. For example, if you 
create a closed tanker car as a structured object and delete one or more points to create the 
opening at one end, Train Sim Modeler can no longer treat this as a structured object, since 
you’ve changed the number of points in one or more cross sections.

Vertex

A vertex is a point in three-dimensional space, represented in Cartesian coordinates as X, Y, 
and Z values. The coordinates are relative to the part’s axis. A part contains a vertex list with at 
least one point. Deleting a point from a structured object causes the part to become 
unstructured. While a part has at least one vertex, it's possible for a part to have no polygons.

Polygon

A part’s polygon list contains zero or more polygons. Each polygon is simply a list of indexes 
into the vertex list. While this may sound complicated, please keep in mind that Train Sim 
Modeler shields you from most of these technicalities. If you like to get down to the bare metal 
however, Train Sim Modeler allows you to manually enter point coordinates and hand-edit 
polygon lists.

Each polygon contains additional information that is used when Train Simulator draws this 
object. The color of the polygon, whether it should be drawn with smooth or faceted edges, and 
whether a texture is applied are stored as part of the polygon’s information.

Cross Section

As mentioned above, a part can be structured, meaning that it is made of separate cross 
sections consisting of an equal number of points. Train Sim Modeler includes a special Cross 
Section Edit mode that allows you to easily drag points around to create just the shape you 
want. You can activate symmetry modes that cause the point opposite the one you are 
dragging to mirror your movements. This makes it very easy to create symmetrical shapes 
such as fuselages.

Primitive Parts

Train Sim Modeler has eight native parts. These are shapes that may be changed by varying 



one or more of the characteristics. The native parts of the box, tube, disk, oval, polygon, 
conventional sphere, geodesic sphere and cone.

Templates

Train Sim Modeler uses the concepts of templates to aid in the creation of objects. A template 
is simply a two dimensional shape defined by a series of points. Templates are used during 
object creation or object cross section manipulation. A template can be open or closed. A 
closed template automatically connects the last and first points of a template.

For example, the profile of a water tower can be drawn using a template. You can then sweep 
the template around a circle to create a circular water tower (as if you used a lathe to carve one 
out of a chunk of wood.)

You can also extrude a template. If you create a template in the shape of a tanker car, you can 
extrude the shape into an object consisting of as many sections as needed by your tanker car 
design.

If you are editing a structured object whose number of points per cross section is the same as 
the number of points in your template, you can force the shape of the cross section to conform 
to the shape of the template. You can also create a template from a cross section. These two 
features combined allow you to copy the shape of one cross section and apply it to other cross 
sections in your object.

A template is associated with a view. Each view (except the Perspective View) can have an 
associated template.

Operation Modes

Train Sim Modeler operates in several different modes, depending on the level of detail you are 
working with.

Since Train Sim Modeler operates differently depending on the mode you’re in, it is important 
to always be aware of this. The left most toolbar buttons can be checked to verify the mode you 
are in. The various modes and their operational differences are described below:



Part Mode: In Part Mode, you can only manipulate entire parts. If you have 
multiple parts you can choose between them by pressing n (next 
part) or p (previous part.). The current part is shown in bright blue. 
Other parts are shown in a darker shade of blue. Note: All colors in 
the Train Sim Modeler display are configurable from the File | 
Preferences menu option.

Each part has an associated axis. That axis contains the position 
of the part in 3d space. All coordinates of vertices within the part 
are relative to this axis. 

Polygon Mode: In Polygon Mode, one polygon in the current part is shown in light 
gray. This ‘current’ polygon can be manipulated or deleted from the 
object. Deleting a polygon will not affect whether a part is 
structured or not. Individual polygons are selected with the n and p 
keys (next/previous.)

A polygon can only be viewed from one side. With Train Sim 
Modeler, you can ‘flip’ a polygon if the wrong side is visible, or 
‘mirror’ it to make it visible from both sides. 

Point mode: In Point Mode, you can move individual points around with the 
mouse, or edit the coordinates directly with a dialog box. The 
individual points of the current part are drawn on top of the normal 
view of the part. One point is the current point, which is shown in 
white. This point can be moved with the mouse, or deleted. 
Deleting a point from a structured object will cause the object to no 
longer be structured. Individual points are selected with the n and 
p keys (next/previous.)

Cross Section 
Mode:

In cross section mode (only available for structured parts,) the 
object is treated as a collection of cross sections with equal point 
counts. You edit the object by selecting a cross section with the n 
and p keys (next/previous.) The individual points can be dragged 
around with the mouse. Cross Section Mode supports symmetry. 
Experiment with the various symmetry modes to see how they 
affect editing points in a cross section.

Template Mode: In template mode, you define or edit a two dimensional template 
that can be used to create or manipulate three-dimensional 
objects. Each view (except Perspective) can have its own 
template.



Item

Depending on the operating mode, an item may be a part, polygon, point, cross section or 
template.

Current Item

In Train Sim Modeler, there is always a current item (unless a file has not been loaded or a 
part has not been added.) Generally, any command you issue affects only the currently 
selected item. For instance, if you press the ‘delete’ key, the current part, polygon, or vertex is 
deleted, depending on the operational mode (operational modes are described later in this 
section.). See the ‘File | Preferences’ option to see what colors are used for the current item.

Selected Items

In addition to the current item, items can be selected by navigating to the item with the n key 
or p key (next and previous) and choosing Select from the Edit menu. You can also press the 
space bar to toggle the selection status of the current item. In addition, you can use the drag 
selection tool from the toolbar to draw a box around the items you want to select. Many 
operations available for a single item are also available for multiply selected items. If the delete 
key is pressed, all selected items are deleted (but NOT the current item!) Note that an item can 
be both ‘current’ and ‘selected.’ Some operations use the ‘current item’ as a base for 
manipulating other items. For example, if you select three parts, then choose Part | Join 
Selected, all the selected parts will be merged with the current part, combining all parts into 
one. If the current part is also selected, its selection status is ignored for this operation. See the 
File | Preferences to see what colors are used for selected items.

Lets continue with the Basics.

  



The Basics
 

Adding a Part Primitive

You can’t do anything in Train Sim Modeler (nor any other 3D design program for that matter) 
until you have a part to manipulate. Train Sim Modeler provides you with several simple or 
‘primitive’ parts that you can easily add to your project. These parts can then be reshaped into 
the exact shape you want.

A project can be made of one or more objects. So Train Sim Modeler supports the concept of a 
current object. Each object is a different vrsion of the model for display at a different distance.

One of the toolbars contains pictures of solid gray geometric shapes. To add a part to your 
project, simply click one of these shapes (or select Part | Add | … from the menu.) You will be 
presented with a dialog box asking for various parameters such as size and color that will tell 
Train Sim Modeler how you want the part to look. Feel free to experiment with these 
parameters to see what results you get.

The part primitives included with Train Sim Modeler are:

Box A simple rectangular part where you can specify the width, height, depth 
and number of sections of the part you want. Perfect as a starting point for 
buildings, platforms, etc.

Tube Useful for towers, tanker cars, pipes, struts, and many other parts. You 
specify the length, radius, and direction of the tube, as well as whether or 
not the ends are closed. In addition, you specify how many points and 
sections are used to create the tube. The tube is a special type of part, 
called a ‘structured part.’ See Cross Section Mode for more information 
on structured parts.

Polygon A single flat surface made of 3 or more points. Useful for very simple 2D 
shapes and especially for adding detail to existing parts.

Disk A ‘round’ surface with a point in the middle. All polygons radiate from the 
center point.

Cone The same as a disk except you can specify a height for the center point.

Oval A stretched version of the disk that has two interior points. Useful for 
adding a peaked roof to a house structure.



Conventional Sphere A sphere constructed of lines of latitude and longitude, like a globe.

Geodesic Sphere A sphere constructed entirely of triangles. Perfect for doing R. Buckminster 
Fuller type domes.

Changing a Part's Size and/or Shape

Train Sim Modeler allows you to manipulate a part in many ways. You can stretch it in the X, Y, 
and/or Z axes. You can select a group of points in the part and shrink or expand them as a 
group, or drag the individual points and drag them to new locations. You can also enter precise 
numeric values for the location of all points that make up your part, allowing total control over 
the final geometry of the part. Structured parts can be manipulated in even more ways to make 
it easy to create a perfectly symmetrical fuselage or car body.

Moving a Part

As you add parts to your object, you will need to place them in relation to the other parts. You 
can use the mouse to drag parts into position (either singly or in groups.) You can numerically 
enter precise locations for parts when the mouse does not give the accuracy required for your 
project.

For precise movement, hold the Shift-key while pressing one of the arrow keys. For example, 
while in front view, you can precisely move the selected part upward by holding the Shift-key 
and pressing the up-arrow on the keyboard.

Changing a Part's Surface Appearance

You can select a color for your part to aid in identification in the 3D Perspective View.

In 3D graphics, objects are made of individual flat polygons. Unless you use so many polygons 
that Train Simulator slows to a crawl, you will be able to see the individual flat polygons on 
curved surfaces. Smoothing allows you to create a smooth looking part without using an 
excessive number of polygons.

Textures are applied to parts to give you the ultimate in control over the detail level of your 
part. A simple cube can be made to appear as complex as a Borg ship from Star Trek by 
simply ‘pasting’ pictures to the sides of the cube. This allows a tremendous amount of detail 
without overstressing the Train Simulator display functions.

Adding more parts

To complete your creation, you continue adding part primitives as described above, manipulate 
the position, size, shape, and surface appearance of each of these parts until you have a 



completed object. There is no need to ‘glue’ your parts together. Simply place them correctly in 
relation to each other, and the Train Simualator graphic engine treats them as a solid object.

Manipulating the 3D Perspective View

While you are building your model, it is very useful to see it in 3D as you work. The 3D 
perspective view allows you to view your object from any angle. The 3D display can be as a 
‘wire frame’ model or a solid object. I prefer to use the wire frame mode during most of my 
modeling because you can see ‘inside’ your object as you work, making it easier to see how 
parts relate to each other. As my project nears completion, I switch to the solid view so I can 
see the effects of my coloring, texturing, and smoothing operations. This allows you to get a 
pretty good idea of how your object will look in Train Simulator without actually creating the 
Train Simulator file shape files and running Train Simulator just to view your project.

Project Properties

The File | Project Properties command lets you specify important properties of your project. 
See Project Properties in the Reference Section for more information on these settings.

Viewing your object in Train Simulator

You turn your designs intoTrain Simulator models by using the File | Create TS Object File 
menu command. Doing this calls the Train Simulator utlities to convert the Train Sim Modeler 
files into files that are usable by Train Simualtor.

Train Sim Modeler makes scenery objects available to the Route Editor that comes with Train 
Simulator. See 'Using the Route Editor' for a brief tour of the Route Editor. Other types of 
projects such as creating a train or other special use items require you to create supporting 
files and/or folders with Train Simulator. Refer to the documentation in the Train Simulator 
'TechDocs' folder for information on working with the development utilities in Train Simulator

What's Next?

Its' time to get started with your first designs. Next on the agenda are a set of exercises and 
tutorial that will lead you through the beginning steps of using Train Sim Modeler. The 
exercises are graduated, so you'll want to approach them in order. When you've completed 
these exercises, you'll be well on your way to becoming an expert with Train Sim Modeler. 
Study hard, work hard and have fun.

Continue on to the first of the Beginner's Exercises. 



Using the Route Editor
 

In the first exercise, Making a Water Tower, you used a template and convert a 2D 
shape into a 3D solid object by sweeping the outline around its center. Next you saved 
the project to the hard drive and converted it into the files that are used by Train 
Simulator.

In this exercise, we'll become familiar with the Train Simulator's Route Editor. This is a 
necessary skill since you use the Route Editor to place objects in the scenery. We'll 
find out how to drop the your waterwater tower into the scenery and then run Train 
Simulator to see your first Train Sim Modeler project.

1.  Start the Editors & Tools. You can do from the Start button by selecting 
Programs | Microsoft Games | Train Simulator | Train Simulator Editors & 
Tools. From this menu screen, choose Route Editor.
 

  
2.  The Route Editor will start and will ask you to select one of the routes with which 

to work. Choose Marias Pass from the drop down list.



3.  The Route Editor displays the starting area for Marias Pass in its main window. 
By default, the Route Editor displays several smaller windows too. Look for the 
Mode window and click on the 'Place Object' icon. This tells the Route Editor 
that you'd like to be able to add new objects to the scenery in the Marias Pass 
route.

  
4.  In order to see the objects that are available, locate the Placement window and 

click on the button labeled 'More'. 

   
5.  The Object selector window appears. Looking at the Object class edit box, click 

on the down arrow key and select TSModeler. This is the name that you used 
when you created the train simulation object from Train Sim Modeler.

You'll see a list of the objects in this class. My list has two objects, a palmetto 
tree and the watertower. Select the watertower and then click the OK button.



 

 
 

6.  As you become familiar with the Route Editor you'll learn that the arrow keys are 
used to move the Camera. 

Move the camera a few feet back from the track by pressing the down-arrow on 
the keyboard. Then move the mouse over the scenery foreground until the white 
X is position as below:
 



 
To place the watertower at the X, press the left mouse button. Now save the 
route and exit the Route Editor.
 



  
7.  Immediately you'll notice that there's a problem. The watertower looks as if it is 

sunk into the ground! 

Don't dispair just yet. Let's save the route and see how it looks in Train 
Simulator. From the Route Editor menu select File | Save to save the changes 
that you've just made to the Marias Pass route. Then leave the Route Editor by 
selecting File | Exit . 
  

8.  Now start Train Simulator and choose Drive a Train. 
 
For Routes select the Marias Pass.
 
For Activity select Explore Route.
 
For Starting At select Shelby. This is the default location for the Marias Pass 
route and is the place where we added the watertower.
 
Finally click the Start button to go to the route at Shelby. From the engine cab 
you can see the watertower a few hundred yards to the left of the track. 
 



 
To see the watertower up closer, drive the train towards it.
 

Yes, the watertower has a problem. The base of the watertower is buried 
beneath the ground level. 
 
Let’s see how we can improve the appearance in the next exercise Refining the 
Water Tower. 



About the Exercises
 

From our experience, users are best able to learn to use Train Sim Modeler by 
completing projects.

We've put together a group of exercises and tutorial for making many different 
projects. Each exercise demonstrates one or more of Train Sim Modeler's many 
features. After you finish an exercise, you'll have completed a useful Train Simulator 
project and learned a little bit more of how to use Train Sim Modeler.

These exercises are progressive. Skills that you learn in one exercise will be called 
upon in later exercises. By building your skill levels gradually, we hope to show you 
several ways to perform a specific task using the myriad of features that are part of 
the powerful Train Sim Modeler software

As you might expect, the early exercises are simple and progress to complex. At 
times you'll find that some of the exercises "borrow" the projects from earlier 
exercises. Doing this keeps each exercise to a manageable size, yet demonstrates 
the techniques that you may later need when you're faced with a complex design 
project. Keep in mind that most large, complex projects are usually completed by 
breaking it into a series of smaller, simplified steps. As each step is completed, the 
next slightly more detailed step can be tackled.

If you'd like to learn to use Train Sim Modeler to the max, we recommend that you 
take the time and energy to work through all of the exercises that follow. We think 
you'll be rewarded by the results.

Throughout these exercises, we will show you how to select one of the many Train 
Sim Modeler operations from the menus. In many cases, you can select the same 
operation from one the three Train Sim Modeler toolbars. After you become 
accustomed to selecting an operation from the menu, you may prefer to select the 
same operation from the toolbar.

In addition, many of the commands you'll use the most often have a 'hot key' 
equivalent. As you use the menus, look for the hot key equivalents to the right of the 
menu description. Learning these shortcut keys can save a lot of mousing around.
 



OK, let's jump to the first exercise Making a Water Tower.

  



Making a Water Tower
 

This exercise introduces you to the concept of a template. A template is a two-dimensional outline that can be turned 
into a three-dimensional part. We'll first show you how to draw and edit a new template and then convert the template 
into a solid part by sweeping the outline of the template around its center. We'll also show you how to turn the project 
into a Train Sim object and finally save the project file.

 

1.  Start Train Sim Modeler and select File | New.
  

2.  Select Mode | Template.
  

3.  Select Template | Closed from the menu to remove the check.

  
4.  Select Edit | Add Points. 

  
5.  Click inside the Front view. Now draw a rough shape of the left half of a water tower starting at the top. To draw, 

you’ll insert a series of individual points within the Front view. 

In the pane labeled Front view (bottom left pane), move the mouse cursor to the place where you’d like to see 
the first point and left click. A small white square appears on the screen showing you the point. 

Move the mouse cursor to where you’d like to see the second point and click. A second square appears, this one 
orange, and a thin line automatically connects the two points. 

Move the mouse cursor to the place for the third point and click. A third square appears, also orange. If the line 
connecting the three points extends from the last point to the first, then you forgot to perform Step 4. You can 
uncheck the Template | Closed item now and the line connecting the last point and first point will disappear.



Continue this procedure until you’ve outlined the water tower. 

The template for this particular water tower is made of twelve individual points. Don’t worry if the shape doesn't 
look exactly as abpve. We’ll show you how to adjust them in the next step.
  

6.  You can now edit or fine-tune the template shape. When you edit the template you can either move existing 
points to a different place or remove existing points from the template. To edit the water tower template first 
select Edit | Add Points from the menu to remove the check. 

To move a point, click on it with the left mouse button and continue to depress the mouse button as you move 
the mouse within the Front view to the point's new location. Then release the mouse button. You may already be 
familiar with this operation which is called dragging.

To remove a point, right-click on the point and press the Delete key.

Here's the template that I made:

  
7.  Select Template | Sweep and the 'Sweep Parameters' dialog appears. Accept the default values for the sweep 

operation by clicking the OK button



  
8.  Instantly, the water tower will appear in all four views shown below 

 

Turning a 2D template of a water tower into a 3D "water tower part" demonstrates one of the powerful features 
built into Train Sim Modeler. You can experiment by changing the various settings for the Sweep Amount and 
Number of Points values in the 'Sweep Parameters' dialog. For example, you can sweep less than 360 
degrees by entering a lower value in the Sweep Amount edit box. Or you can make a more detailed water tower 
by increasing the number in the Number of Points edit box.
   

9.  Before we go on, let's save this project in case we want to use it later. Select File | Save and type a filename 
such as 'ts_watertower.dst'.
  

10.  Now we need to move the watertower to Train Simulator. Converting the watertower is very easy. Simply select 
File | Create TS Object File. The Create Train Simulator Object dialog box appears: 
 



First select a Route. Click on the down arrow to view the choices for the routes. These are any of the routes that 
are available to from within Train Simulator. For the watertower, we've chosen the Marias Pass route. 
 
Object Name is 'Watertower'.
 
Object Class is 'TSModeler' (this is the default) 
 
Object Filename is the name of the file that you chose in the previous step.

Check Convert Textures, Replace Existing Files and Update Ref File and finally click the Continue button.
   

11.  Train Sim Modeler will then convert this project toTrain Simulator compatible files. When it's done, you'll see a 
short report similar to this:
 

 
The important thing to remember is the Route and Object Name. In the next exercise, we're going to place the 
new watertower into your Train Simulator scenery. Click to continue with Using the Route Editor.
    



Refining the Water Tower
 

In the last exercise Using the Route Editor, we used the Route Editor to place the 
watertower into the route scenery. When we looked at the scenery from Train 
Simulator we saw that the water tower was partially submerged. Let’s see how we can 
solve this problem.
 

1.  Start Train Sim Modeler and select File | New.
   

2.  Select File | Open and locate the project tsm_watertower.dst that you 
made in Making A Water Tower. Click on its name and then click the Open 
button. In the Front view notice the position of the water tower in relation to the 
origin. This origin is indicated by the heavy white horizontal line. As you can 
see the axis is located in the center of the water tower at the ground level. 
 

   
3.  From the menu, select Transform | Move Mode and in the Front view drag the 

water tower so that its base is resting exactly on the origin as below: 
  



  
Notice that the axis has not changed. It is still located in the center of the water 
tower.
   

4.  To move the axis, from the menu select Part | Center Axis | To Origin
  

     
  
Now you'll see that the axis has indeed moved and is now located at the base 
of the water tower:
  



    
5.  Let's make one final improvement to the water tower. From the menu select 

Edit | Part Properties 
  

 
You’ll see a checkbox named 'Polygon Smoothing'. Click on this check box 
and finally click on the OK button.
  



6.  If you'd like to change the color of the water tower, click on the Color button
  

  
Click on any of the color squares or click RGB to further refine the color of the 
part. When you've selected a color (we choose the bright red color), click the 
OK button.
   

7.  Next you’ll want to preview your spruced up water tower. If you aren't already 
set to display the perspective view as a solid, select View | Perspective View | 
Display as Solid. Instantly Train Sim Modeler draws the object in the 
Perspective view:
 



  
NOTE: When you change the color of a part using the Part Properties dialog 
as above, the part takes on the selected color only when displayed in Train Sim 
Modeler. The part will not appear in Train Simulator in the selected color. For 
Train Simulator, you'll have to apply a texture to a part to change it's color. 
We'll see how to texture a part in a later exercise. 
   

8.  Now save the new project by selecting File | Save As and typing 
'tsm_watertower2.dst'.
   

9.  Finally convert the revised project to a Train Simulator object by selecting File | 
Convert TS Object File as you did in the earlier exercise. Do not change the 
Object Name (it should still be Watertower). 
 
Since you are replacing the Train Simulator converted files, you do not have to 
reposition the object using the Route Editor. 
 
Start Train Simulator and from Shelby in the Marias Pass route, look at the new 
watertower. 
  



  
There are two differences from the exercise "Making A Water Tower".
 
- the water tower is no longer "underground"
- the surface of the water tower is smoother owing to the Polygon Smoothing 
checkbox that we chose above
 
That's it for the water tower. Let's move on to a texturing example Texturing the 
Water Tower.



Materials
 

Train Simulator uses a special set of "Material" names to create special 
texturing effects when applied to a part. To specify a Material name, 
select the desired part and then choose the Edit | Part Properties 
dialog.

Normally the 'SolidNorm' material is used. This is for a normal, solid 
application of color.

Other names are available for special effects. The first part of the name 
is either 'Solid', 'Alph', or 'Tran'

'Alph' indicates that a .tga texture with a transparency map is being 
used.

'Tran' indicates that a 'cutout' effect is desired where the background 
color is fully transparent and all other colors are fully solid.

'Solid' is of course, opaque.

The rest of the name includes flags light 'bright', and 'hlfbrt' which are 
used for textures that should look illuminated in the dark. The order that 
transparent polygons are drawn is affected by the '+' and '-' flags on the 
'Alph' materials.

The way Train Sim Modeler orders polygons for display is as follows:

1. All 'Solid' polygons.
2. All 'Alph' materials with a '-' flag at the end.
3. All 'Alph' and 'Tran' materials without a flag at the end.
4. All 'Alph' materials with a '+' flag at the end.

When dealing with multiple layers of transparency, the +/- flags
let you tweak the drawing order to solve visbility problems. 

 

 



Continue Reference Section - Shortcut Keys

 

 

  



Merge Project
 

The File | Merge Project command lets you to load another project, part, or list of 
projects and parts, into your current project. Here are a few reasons you might want to 
do this:
 

1.  You can organize your project into logical sections that can be worked on 
separately. When you are ready to produce your object for Train Simulator, you 
can merge the various sections together.

2.  You can maintain a library of parts and assemblies that are used in more than 
one project. Wheels, boogies, cabs, seats, etc. could all be saved as sub-
projects or separate parts and used with multiple projects.

3.  Train Sim Modeler can automatically save a part file for each part in your 
project, and a text file containing a list of those filenames. This file can later be 
used as a merge control file. By manipulating the order of the files in this list, 
you can control the order that parts appear in your project. This is useful mainly 
to aircraft developers who want to override the default part sorting that Train 
Sim Modeler does when an aircraft is produced. For more information on 
creating this merge list, see ‘Reference - Menus. 

To merge a project into your current project, select the .dst file extension in the file 
type control. To merge a single part into your project, select the .dsp file extension. 
This is the same as using the Part | Load menu command. To merge a list of parts 
and/or projects, select the .txt file extension.

The merge file is simply a text file containing a list of filenames to merge. If the files 
are in the same folder as the merge text file, no path information is necessary. A 
complete file path can be specified if your project utilizes files from multiple folders.

 

Continue Reference Section - Animation Basics 



Texturing the Water Tower
 

In the last exercise Refining the Water Tower, we lifted the water tower from its submerged 
state by moving the project's axis. We also smoothed its surface. For more details about the 
smoothing techniques, please see Smooth Shading.

In Train Simulator, the water tower appears in the color blue as seen below:

Why does it appear as blue?

First a word about textures. A texture is a file that contains a 'paint scheme' that is applied to 
a part (or polygon). We often refer to a process of texturing a part. This means that we are 
specifying the filename of the texture file and the portion of the paint scheme (the x and y 
coordinates and area) that are to be painted onto the part.

When we make a Train Sim Modeler project, all parts of the project must be textured. If any 
portion of the project is is missing a texture, Train Simulator is unable to display that project. In 
other words, you must texture each and every part of a project. You apply textures to a part 
using the Part | Texture menu item. At a higher level of detail, you can apply a texture to a 
polygon (a portion of a part) using the Polygon | Texture menu item.

So back to the question as to why the water tower appears as blue? Here's the answer: Train 
Sim Modeler applies a default texture to any part or polygon to which a texture has not been 
applied. It just so happens that this default texture (its filename is blank.bmp) has this blue 
color.



In the exercise we'll see how to brighten up the water tower using a texture.

1.  Start Train Sim Modeler and select File | New.
   

2.  Select File | Open and locate the project tsm_watertower2.dst that you made in 
Refining a Water Tower. Click on its name and then click the Open button. You'll see 
that the water tower appears red. 
 

 
Recall that we assigned the part a red color using the Edit | Part Properties dialog. 
And recall also that the color is applied to this part only when it is displayed in Train Sim 
Modeler. Previously we did not assign a texture to this part which means that Train Sim 
Modeler assigned its default texture (blank.bmp) for us.
  

3.  Let's see how we can change the look of our water tower. From the menu select Part | 
Texture and you'll see this dialog:
 
 



 
Our water tower part has a front and back. To assign a texture to the front, click the 
Browse button opposite Front:
   

4.  From this dialog, you select the texture with which to paint the front surface of the water 
tower. If you're not already there, navigate to the TSModeler\Textures folder and select 
the texture whose filename is 'tsm_watertower.bmp'. You'll see a preview of this 
bright yellow texture. The dialog also tells us that the texture is BMP format, has a Bit 
Depth of 8 (256 colors) and a physical size of 256 x 256 pixels.
 
Click the Open button.
 



   
5.  Next the Texture Properties dialog appears. This dialog lets us select which portion of 

the paint to be applied to the front surface of the water tower. Since we'll be using the 
entire texture, click OK to apply the full 256 x 256 pixels.
 



  
6.  Repeat the previous two steps for the Back: of the water tower. When you've completed 

applying the textures, you'll see the results in the Train Sim Modeler Perspective view. 

   
7.  Save the textured water tower by selecting File | Save As and typing 

'tsm_watertower3.dst'.
   

8.  Again convert the revised project forTrain Simulator by selecting File | Convert TS 
Object File. Don't change the Object Name (it will specify Watertower).

Start Train Simulator and from the Marias Pass route starting at Shelby you'll see the a 
bright new watertower. 
  



  

 

In the previous exercises, the projects use a single part. In the next exercise, you'll get some 
experience using multiple parts. Continue with Assembling a Pre-Built Boxcar.
 

  



Using Smooth Shading
 

In Train Simulator, objects are made of individual flat polygons. Normally, the polygon 
edges are clearly visible. Sometimes this is desirable, other times it is not. For 
example, if you make a default sphere in Train Sim Modeler, you can see in the solid 
perspective view that it is supposed of individual ‘panels’ assembled into the shape of 
a sphere. Train Simulator gives you a way to simulate a smooth sphere without the 
edges between polygons. This technique is called Gouraud Shading. The Part | 
Properties dialog box a checkbox called ‘Polygon Smoothing’ that activates this 
feature.

Each polygon of an object has a ‘surface normal’ that is simply a line drawn from the 
face of the polygon outward from the side that the polygon is visible from. This surface 
normal usually makes a 90 degree angle with the face of polygon. Train Simulator 
uses the surface normal to determine what side the polygon is visible from and how to 
shade the polygon. The angle between the direction of the light hitting the object and 
the direction of the surface normal determines the shading of the polygon. The smaller 
the angle, the brighter the polygon will be drawn.

When smooth shading is applied, surface normals are applied to the polygon faces as 
well as to the vertices making up each polygon. The vertex normals point in the 
direction that a light beam would come from that would produce the brightest 
illumination on the polygon. Train Sim Modeler calculates this vertex normal by 
averaging the surface normals of all the polygons that share the vertex. Train 
Simulator then interpolates the values between the vertex normals and the surface 
normal at the center of the polygon to determine the shading at each screen pixel. 
This produces a smooth gradation of shades that simulates the effect of a rounded 
surface.

 

Display Problems Caused by Smooth Shading

Although smooth shading can do wonderful things for the realism of your models, it 
can cause unwanted side effects of its own. For example:

You’ve made a gorgeous tanker car and made it smooth. You then cut out a loading 



door, which is also smooth. When you look at the tanker in Train Simulator, the 
shading of the tanker at the edge by the loading door is vastly different than the 
shading of the door at the edge by the tanker. This is because the surface normal 
interpolation is trying to average drastically different values together. In this case, 
turning off smoothing on your loading door may improve this situation.

Sometimes the polygons that make up the edge of a part, such as the back of the 
tanker where the loading door has been cut out, should be separated from the part 
and made a part of its own. By doing this, the original part won’t try to average surface 
normals past the edge of the tanker, because there will be no polygon to average with 
on the back edge.

Sometimes you only want a portion of a part to appear smooth. For instance, you’ve 
made a water tank. The front of the water tank is rounded, but the back is flat. In this 
case, after the water tank geometry has been finalized and you know that all the 
points are in the right place, you can separate the water tank into a front section that 
is smooth, and a back section that is not.

Sometimes objects will look ‘wrinkled’ after applying smooth shading. This is usually 
because adjoining polygons that should be in the same plane are off by a little bit. 
This problem can be solved only by editing point locations until the wrinkles go away.

 Continue with Rail Reference 



Assembling a Pre-Built Boxcar
 

Up to now, the projects that you've been making consist of only a single part. You found that the Train 
Sim Modeler's template is a powerful way to create a part.

Most often, you'll create projects that are made of multiple parts. In this exercise, we'll demonstrate 
some of TSM's ability to handle multiple parts. We have already pre-fabricated a boxcar from the 
following parts:

1.  tsm_boxcar.dsp 
2.  tsm_bogie1.dsp 
3.  tsm_bogie2.dsp 
4.  tsm_wheel211.dsp 
5.  tsm_wheels12.dsp 
6.  tsm_wheels21.dsp 
7.  tsm_wheels22.dsp 

These parts are found in the TS Modeler\Projects folder. Note that all parts have a file extension of 
*.dsp (as differentiated from projects which have a file extension of *.dst).

If you start Train Sim Modeler and load each of the above parts, they will all fit together to make a 
boxcar.

 

1.  Start Train Sim Modeler and select File | New.
   

2.  Select Part | Load and navigate to the TS Modeler\Projects folder. Select the first of the seven 
parts from the list and click Open.
 



 
Here we chose the part tsm_boxcar.dsp which is displayed on in the four views:
 

  
3.  In turn, repeat the procedure above for the other six parts. Now the four views looks like this:

 



 

4.  Notice that in the above picture, one of the wheels is displayed as bright blue. This means that 
this part is the current part. Most TSM commands operate on the current part. You can change 
the current part by choosing 'next'. 

There are several ways to choose next:
 
* Press the 'n' key
* Press the right arrow key
* Select Edit | Next 

* Click the icon 

 
Choosing next changes from one wheel ...

 
to another wheel.

 
Choosing next seven times consecutively cycles through all of the parts. 
  

5.  You can also change the current part by choosing 'previous'.
 
* Press the 'p' key
* Press the left arrow key
* Select Edit | Previous 

* Click the icon 
  

6.  Another way to change the current part is to select Part | Select by Name or click the icon 
 



This displays a list of parts. Highlight the desired part and click the Make Current button.
  

 
 

7.  After you've chosen the desired part you can perform any of the operations on that part, for 
example:
  
* To move a part, make that part the current part and from Move Mode, drag the part to the 
desired location.
* To scale a part, make that part the current part and from Scale Mode, drag to enlarge or 
reduce
* To rotate a part, make that part the current part and from Rotate Mode, drag to rotate 
clockwise or counterclockwise within one of the three views.

You've completed the basic exercises. Let's cover a more advanced concept - cross sections - in 
Making a Tire Part 1.
 

  



Rail Reference
The Rail_Reference part may be used to help you achieve proper positioning of 
locomotives and rolling stock on the rails. It can also be used as a guide in scaling the 
model or adjusting wheel width spacing. Because it's flagged as a reference part in 
the Part Properties dialog you may leave it as part of the TS Modeler \Projects file. 
It'll be ignored when converting the model to Train Simulator.

To use this part in an existing project select Part | Load from the menu or press 
'Ctl+L'. In the file selection box find 'rail_reference.dsp', select it and click 'OK'. 
A section of track will appear under your model. If it seems too short you can load or 
copy and paste additional copies and move them forward or backward along the Z 
axis until you achieve the desired length. No adjustment along X or Y is needed.

Now that it's loaded you can adjust your model to the track. If you started building 
your model without Rail_Reference the wheels may appear to be embedded in the 
rails. If you were to convert your model to Train Simulator at this point it would appear 
the same way. To fix this, select all of the parts except the Rail_Reference part(s). 
Adjust the model along the Y axis until the wheels are sitting on top of the rails. After 
it's positioned, turn off move mode and deselect all parts. Make the main parent part 
the current part. From the menu select Part | Center Axis | To Origin. The axis will 
reposition to 0,0,0. If you forget to reposition the axis and convert the model the 
wheels will still appear to be imbedded in the rails.

If you'd like to continue with the Reference Section of the Help files turn to the Menus 



Making a Tire - Part 1
 

At first glance, you might look at the list of native parts that Train Sim Modeler can 
make and think that its capabilities are limited:
 

●     Box 
●     Tube 
●     Disk 
●     Oval 
●     Polygon 
●     Conventional Sphere 
●     Geodesic Sphere 
●     Cone 

As the title of this exercise suggests, you'll soon be making a tire. However, you can 
search high and low through the menus for a part name tire, and you won’t find it 
there. For this exercise, you’ll have to turn on the creative juices to find a way to make 
the tire.

It’s obvious that a tire is circular. One way to approach the tire design is to start by 
using one of Train Sim Modeler’s native parts and manipulate the part until it 
resembles a tire. Except for the two spheres in the above list, only two of the parts in 
the list are circular: the tube and the disk. If you were to add a disk to a project, you 
would see that it has no thickness and so it probably isn’t a good candidate for a 
starting point for the tire. On the other hand, the tube can serve as a good starting 
point for the tire.

Let’s see how you can turn a tube into a tire.

 

1.  Start Train Sim Modeler and select File | New.
    

2.  Select Mode | Part.
   

3.  Select Part | Add | Tube. Use the following settings to add the initial tube:



  
Make sure to check the ‘Closed Left/Bottom/Front’ and ‘Closed 
Right/Top/Back’ checkboxes and choose the X-axis radio button from the 
‘Structure Long Axis’ group. When all of the specification are set, click the OK 
button to make the tube. 
 

    
4.  Select Edit | Part Properties and check the ‘Polygon Smoothing’ checkbox. 

Next click the Color button. Click the dark gray color and click the OK button.
   

5.  Click Part | Save and in the File Name edit box type 'tsm_tire1.dsp'. Click 
Save to save the part.
  



 

 
That was easy. You’ve turned a tube into a gray tire. The key to making the tire was 
fabricating the tube with closed ends.

Instead of saving the tire as a project, you’ve saved it as a part. You can later use this 
part in other projects by selecting Part | Load from the menu and choosing the 
filename tsm_tire1.dsp.

As with some of the previous projects, this tire is the "plain Jane" variety. In the next 
exercise Making a Tire Part 2 you’ll customize it some more.
  



Menu Items
 

The following is a description of the Train Sim Modeler menu items arranged in order 
of appearance from left-to-right and top-top-bottom. An asterisk (*) following a menu 
item indicates that the command is also available on a toolbar.

 

FILE

New* Clears current project and starts a new project.

Open* Clears the current project and opens an existing 
project file.

Save* Saves a project file.

Save As Saves a project file with a new name

Import FSDS Project Opens a FS Design Studio project 
and converts it to the Train Sim Modeler format.

Merge Project Loads a project file without clearing 
the current project. You can merge a single file or 
specify a text file containing a list of files to 
merge. The file list may contain as many fsc and/or 
fsp files as desired. They are merged in the order 
they appear in the text file. This makes it easier to 
split a complex project into sub-projects to be merged 
before the final creation of your scenery or aircraft 
file.

Package Project Copies the project file and textures 
to folder in which you save the project.

Create TS Object File Creates Microsoft Train 



Simulator compatible files of the current project.

Project Properties Lets you set the project name and 
animation characteristics.

Project Statistics Displays several items on 
information regarding the makeup on the current 
project.

Program Preferences Lets you change any of the Train 
Sim Modeler application settings including default 
file paths, colors, and whether the measurements are 
represented as Metric or English.

Recent File List A list of the most recently edited 
projects.

Exit Exits Train Sim Modeler.

 

OBJECT

Properties Lets you set the object name and visibility 
of the current object

Add Object Lets you add an object to the project.

Remove Object Lets you remove the current object from 
the project

Next Object Selects the next object

Previous Object Selects the previous object

Main Object Selects the main object

 



EDIT

Undo Restores object to its state prior to the last edit. 

Cut Deletes the current item and stores a copy in Train 
Sim Modeler’s internal clipboard. 

Copy Copies the current item to Train Sim Modeler’s 
internal clipboard. 

Paste Inserts the item in Train Sim Modeler’s internal 
clipboard into the project. 

Delete Deletes parts, polygons, or points (depending on 
current mode.) Deleting a point from a structured part 
removes the structure information. 

Toggle Select Toggles the selection status of the current 
item. 

Select Selects the current item. You can select multiple 
items and manipulate them as a group. 

Unselect Clears the selection flag of the current item. 

Select All Selects all items. 

Unselect All Unselects all items. 

Invert Selection Unselects all items that were selected, 
and selects all items that weren’t selected. 

Hide Selected Hides all currently selected items to reduce 
display clutter. 

Unhide All Redisplays all items that have been previously 
hidden. 



Add Points Lets you add points to a template by clicking 
with the mouse. This operation is available only in 
Template mode. 

Snap To Neartest Vertex Move the current point to the 
location of the nearest vertex. This operation available 
only in Point mode. 

Next* Selects the next part, polygon, point, or cross 
section depending on the current operating mode. 

Previous* Selects the previous part, polygon, point, or 
cross section depending on the current operating mode. 

Part Properties Allows properties of the current part, 
polygon, point, or cross section to be edited in a dialog 
box. 

Check Part Geometry Checks all parts for geometric errors, 
especially non-planar polygons. 

Convert Texture Filename Use this command to change a long 
texture filename to an 8.3 filename. 

  

VIEW

Zoom In* Zooms closer to the workspace. 

Zoom Out* Zooms further from the workspace. 

Reset Restores default zoom and perspective view rotation 
settings. 

Backdrop 



---Load Lets you load a backdrop image into the current 
view. (*.bmp only) 

---Hide Hides the backdrop in the current view. 

---Clear Removes the backdrop from the current view. 

---Scale Adjusts the scaling factor of the backdrop. 

---Set Center Adjusts the position of the backdrop 
relative to the workspace. 

---Nudge Left Moves the backdrop in the current view to 
the left 

---Nudge Right Moves the backdrop in the current view to 
the right 

---Nudge Up Moves the backdrop in the current view upward 

---Nudge Down Moves the backdrop in the current view 
downward 

---Twain Acquire Lets you to acquire a backdrop image from 
a Twain device such as a scanner or digital camera. Saves 
the scanned image according to the name of the view that 
is active, ie: FrontView.bmp 

---Set Twain Device Lets you select the Twain device. 

Perspective View 

--- Display as Solid Check this menu item to display your 
project as a solid object in the Perspective view. Uncheck 
this menu item to display your project as a wireframe in 
the Perspective view. 



----Solid View Properties Lets you fine tune the 
appearance of the solid perspective view. The Solid View 
Properties toolbar can also be used to fine tune the 
appearance. 

---Solid Texturing On Check this menu item to display your 
the solid object with textures. Uncheck this menu item to 
display your solid object without textures. 

---Solid View Control Bar Check this menu item to display 
the control bar that varies the zoom level and lighting 
levels. Uncheck this menu item to hid this control bar. 

View Part Axis Displays a small version of the part axes 
so that is is easier to select a part with the mouse. 

View Surface Normals Check this menu item to view surface 
normals on all polygons while in polygon mode. Normally 
the surface normal is shown for the current polygon only. 
The surface normal is a line that extends from the polygon 
that shows the side the polygon is visible from. 

Show Current Part Only Hides all parts except the current 
part. Very useful when working with a small part that’s in 
the midst of many other parts. 

Hide Reference Parts Check this menu item to hide any 
reference. Uncheck this menu item to display any hidden 
reference parts. 

View Hierarchy Check this menu item to display the 
hierarchical relationships of the current project. 

Main Toolbar Check this menu item to display the Main 
Toolbar. Uncheck this menu item to hide the Main Toolbar. 

Action Toolbar Check this menu item to display the Action 
Toolbar. Uncheck this menu item to hide the Action Toolbar 



Parts Palette Check this menu item to display the Parts 
Palette. Uncheck this menu item to hide the Parts Palette 

Status Bar Check this menu item to display the Status bar. 
Uncheck this menu item to hide the Status bar. 

Grid On/Off* Check this menu item to display the Grid. 
Uncheck this menu item to hid the Grid. 

Grid Size Lets you change the scale of the Grid. 

  

  

MODE

Part* Set operations for editing entire parts. 

Poly* Set operations for editing individual polygons. 

Point* Set operations for editing individual points. 

Cross Section* Set operations for editing structured 
objects as a series of cross section ‘slices.’ 

Template* Sets operations for editing a template within 
the selected view. 

Select* Lets you select multiple parts or points with a 
drag box. 

Ruler* Lets you select measurement tool to find the length 
of a line segment. 

X Symmetry* Forces symmetry along the X axis when editing 
a cross section. 



Y Symmetry* Forces symmetry along the Y axis when editing 
a cross section. 

Z Symmetry* Forces symmetry along the Z axis when editing 
a cross section. 

  

  

PART

Add Lets you add any of the following objects to a 
project:
---Box
---Tube
---Disk
---Oval
---Polygon
---Conventional Sphere
---Geodesic Sphere
---Cone

Save Saves an individual part (*.dsp) 

Load Loads an individual part 

Create Part File Merge List Saves all the parts that make 
up your project into a single folder and creates a merge 
list of those parts. This let you manipulate the order of 
the parts in your project using a text editor. 

The command prompts you for the foldername to create the 
merge list to be used later with the 'File | Merge 
Project' command. Each part is saved in the same directory 
as the part list. The part list can be manipulated to 
control the order in which parts appear in your project 
(useful primarily for complex aircraft design.) After 



preparing the part order in the merge list, start with an 
empty FSDS session and use the 'File | Merge Project' 
command. Specify the merge list .txt file created with 
this 'Part | Create Part File Merge List' command and a 
project is built using the parts in the merge list. 

Select By Name* Lets you select any of the current 
project's parts by its name. 

Center Axis 

---To Object Moves the part's axis to the geometric center 
axis to the part. 

---To Origin Moves the part's axis to the project origin 
(0,0,0) 

Reset Axis Orientation Adjusts the rotation of the part's 
axis so it is aligned with the world axis without changing 
the actual rotation of the part. Note: it is important 
when applying rotation animation to a part that you ensure 
the axis is in its default non-animated state is aligned 
with the world axis. 

Animate* Lets you add animation to a part 

Snap to Grid Eliminates duplicate points in object and 
quantizes parts according to scale factor. 

Join Selected Combines two or more parts into one. Before 
selecting this command, use the selection mode to select 
all the parts that you want to merge. All selected parts 
will be merged into the current part. 

Split Part Splits a part in two by creating one part from 
all selected polygons, and another part from all 
unselected polygons. 



Add Point While in Point Mode, select two points. This 
command adds a new point between the two selected points. 
If the two selected points define the edge of any polygon, 
the new point is added to those polygons' point lists. 
This give you more control over adding complexity to a 
part when the Polygon/Subdivide command won't do what you 
want. 

Remove Orphaned Points 

---All Parts For all parts, removes any point that is not 
used in a polygon. 

---Current Part For the current part, removes any point 
that is not used in a polygon 

Textures Lets you apply textures to the current part. You 
can select polygons before texturing to limit texture 
application to selected polygons. If no polygons are 
selected, texturing is applied normally. If polygons are 
selected for texturing, textures on unselected polygons 
are undisturbed, allowing you to texture a part in 
'passes' to give better control over what polygons get 
painted with a particular texture application. 

Make Texture Template Draws a texture template - an 
outline of the part - which simplifies the creating of the 
texture to conform to the shape of the part. 

Display Texture List Shows a list of the textures used by 
the current project. 

  

  

POLYGON



Flip Changes the side the polygon is visible from. 

Flip All/Selected Changes the side all polygons are 
visible from. 

Subdivide Divides the current polygon into triangles, by 
locating the center and connecting the other points to the 
center. 

Subdivide All/Selected Divides all of the selected 
polygons into triangles. 

Smooth Subdivide Divides the current polygon into 
triangles. 

Smooth Subdivide All/Selected Divides all of the selected 
polygons into triangles. 

Make Poly from Selected Points Makes a new polygon from 
the selected points. Vertex selection order is remembered 
for use with the 'Create Polygon from Selected Points' 
command. This point order is used to define the polygon, 
making it possible to avoid the 'crossed' polygon edges 
that sometimes occurred before. The operation is available 
only in Point mode. 

Texture Lets you apply a texture to the current polygon. 
If a texture has been applied to the part of which this 
polygon is one of its elements, the polygon texture will 
take precedence over the part texture. 

Find Untextured Polygons Searches the project for polygons 
that do not have a texture assigned to them. 

  

TRANSFORM



Translate Moves a part a specified distance in three 
dimensions. 

Rotate Rotates a part a specified number of degrees in 
three dimensions. 

Scale Stretches or compresses an object in any of the 
three dimensions. 

Flip 

---Flip X Reverses a part’s orientation along the X axis. 

---Flip Y Reverses a part’s orientation along the Y axis. 

---Flip Z Reverses a part’s orientation along the Z axis. 

Move Mode* Lets you move a part, point, or cross section 
by dragging the mouse within a view. 

Rotate Mode* Lets you rotate a part, point, or cross 
section by dragging the mouse within a view. 

Scale Mode* Lets you scale (change the size) of a part or 
cross section by dragging the mouse within a view. 

Constrain X* Prevents movement/scaling along the X axis. 

Constrain Y* Prevents movement/scaling along the Y axis. 

Constrain Z* Prevents movement/scaling along the Z axis. 

  

  

CROSS SECTION



Copy to Template Copies the current cross section to the 
selected view’s template. 

Conform to Template Conforms the current cross section 
shape to the selected view’s template. Only works if the 
template has the same point count as the cross section. 

Make Polygon Creates a polygon from the current cross 
section. Useful for creating a bulkhead wall from a cross 
section. 

Insert Cross Section Creates a new cross section at the 
current location within the structure. 

Remove Cross Section Deletes the current cross section 
from the structure.

 

 

TEMPLATE

Display Check this menu item to show the template within 
the current view. Uncheck this menu item to hide the 
template within the current view. 

Closed Check this menu item to make the current template 
"closed" (first and last points connected). Uncheck this 
menu item to make the current template "open" (first and 
last points are not connected). 

Load Load a template into the currently selected view. 

Save Save the template from the currently selected view. 

Clear Remove the template from the currently selected 



view. 

Extrude Creates a part by copying the template as a series 
of cross sections, putting a polygon ‘skin’ between each 
cross section. 

Sweep Creates a part by sweeping a half-outline of an 
object into a circular shape, as if it were created with a 
lathe. 

  

HELP

Help Display the Train Sim Modeler Help File

About Display the Train Sim Modeler information screen

Upgrade Registration Lets you enter an upgrade 
registration key (unused at this time).

  

Continue with the Reference Section - Toolbars 



Making a Tire - Part 2
 

In the previous exercise, you turned a tube into a basic tire and saved it as a part. In this exercise, 
you'll be introduced to you several new, powerful features that will help you customize the tire. In 
particular, you’ll see how to edit cross sections. Finally, you’ll apply a texture to the side of the tire.

 

1.  Start Train Sim Modeler and select File | New. 
  

2.  Select Part | Load and open the tsm_tire1.dsp which you created in the previous exercise 
Making a Tire - Part 1. The tire appears in all four views.
  

3.  Select Mode | Cross Section and Transform | Scale Mode. The Front and Side views are 
displayed below:
 

 
You've just changed the operating mode from Part mode to Cross Section mode. This tells 
Train Sim Modeler that the current part is to be treated as a series of cross sections or slices. 
In this case, there are six cross sections. Each cross section has 15 points. To help illustrate, 
in the Front view we have labeled the cross sections 1 through 6 from left to right.
 
In the Side view, you can see all 15 red points that make up one of the cross sections. 
 
In the Front view, you can see some of the orange points in vertical slice that make up cross 
section 1.
  

4.  Now you’re going to see some of Train Sim Modeler’s magic in working with cross sections. 
The goal is to scale (resize) cross section 1. 
 



 
First a little preparation. Select Transform | Constrain X. This operation prevents you from 
resizing the cross section in the X-direction. The concept of constraining movement is not an 
easy one to grasp, but we’ll try to explain. 
 
If you scale (resize) a cross section, the points can normally move in all three directions X, Y 
and Z. If you look in the corner of each view, you can see a small diagram which indicates the 
orientation of the three axes. 
 
Look in bottom-left corner of the above Front view. You’ll see that it shows that the Y-axis 
runs from top to bottom and the X-axis runs from left to right. If you constrain the scaling in 
the X-direction, you are making sure that the points in the cross section do not move to the 
left or right in the Front view. The same holds true for the Top and Side view – depending on 
the orientation of their respective axes.
  

5.  Now scale (resize) the first cross section (1) to a smaller size making a "hub cap" shape on 
the left side of the tire. In the Side view, click and drag the mouse to the left. As you drag to 
the left, the cross section shrinks in size. As you drag to the right, the cross section grows in 
size. After you’ve scaled the cross section to the correct size, release the mouse button: 
 



 
This powerful cross section scaling operation, lets you move all 15 points simultaneously 
towards the tire’s center.
  

6.  Next you'll scale the opposite side of the tire to make a second "hub cap". Press the ‘p’ key 
(previous) on the keyboard to select the previous cross section. Doing this unselects cross 
section 1 and selects cross section 6. You can confirm this by observing that the orange 
points shift to the opposite end of the tube (far end) in Front view. 
 
Instead of pressing the ‘p’ key, you can press the ‘n’ key five times to select cross section 6.
 
In Side view, drag left to shrink the diameter of cross section 6 to match the size from Step 5. 
If needed, you can press ‘i’ one or more time to zoom in and see more detail.
  

7.  Now you’ll adjust the shape of the tire by "squeezing" sides of the tube. Do this by moving the 
cross sections on each end of the tube towards the middle of the tire. Change from scale 
mode to move mode by selecting Transform | Move Mode from the menu. 
  

8.  To allow movement only in the X-direction, contrain the movement in both the Y and Z 
directions. Do this by checking both Transform | Constrain Y and Transform | Constrain Z 
in the menu.
  

9.  In Front view, drag left to move the selected cross section 6 to the left until it is lined up with 
cross section 5 
 
Press the ‘n’ key to select cross-section 1. Drag right until cross section 1 is lined up with 
cross section 2. Your part should look like the one below.
 



 
Next you’ll want to give the tire a slightly rounded profile. Do this by scaling cross sections 2 
and 5 slightly smaller. Start by selecting Transform | Scale Mode. Press the ‘n’ or ‘p’ until 
cross-section 2 is selected. In Side view drag left to scale cross section 2 slightly smaller. 
 
Select cross-section 5 and scale it smaller to match cross-section 2. 
 
One way to think of this part is to consider the portion between cross sections 1 and 2 and the 
portion between cross sections 5 and 6 as the thickness of the tire. The portion between 
cross section 2 and 3 and between cross section 4 and 5 is the slope to the top flat part of the 
tire. The portion between cross section 3 and 4 is the flat side of the tire.
  

10.  The tire now looks like this: 
 

 
You can experiment and change the shape later if you wish. If the tire is too big or too small, 
you can scale the entire part by selecting the Part mode and Scale mode and dragging the 
mouse left or right. You can also make the tire fatter by selecting Cross Section mode and 
Move mode, highlight cross-section 3, drag it to the left, select cross-section 4 and drag it to 
the right in Front view.
     

11.  Now you’re ready to add some zest to the tire. You’re going to give it some color. Select 
Mode | Part from the menu. 
  

12.  Next select Part | Textures. Click the Browse button for "Left".
 



  
13.  Locate and open the filename tsm_tire.bmp. 

 



  
14.  You'll see the Texture Properties dialog. Click OK to accept the defaults which applies the 

entire texture to the left side of the tire.
 



  
15.  Repeat these above two steps to apply the same texture for ‘Right’ side of the tire.

 
16.  Finally click the OK button. The textured tire will look like this:

 

  
17.  Click Part | Save As and type the filename type tsm_tire2.dsp

 
Since the texture applied is black, it may be difficult to see in the Perspective view. We’ve 
adjusted the screen color so you can see the textured tire. To change the background color, 
click File | Preferences and click the word: Background. Select a new color for the 
background and click OK to close the color selection and OK to accept the change.
 
You'll also see that the texture did not completely cover the tire. To remove the gray stripe, 



you can choose Edit | Part Properties, click on the Color button and choose the black color 
from the palette.
 

This was a rather long exercise, but it demonstrates some very powerful techniques for working with 
parts, cross sections and constraints. Let's continue some advanced techniques with Making a 
Boxcar.

 
  



Making a Boxcar
 

In an earlier exercise Assembling a Pre-Built Boxcar, you used a set of perfabricated parts to create a 
box car.

In this exercise, you'll create the same boxcar from scratch using boxes and tubes to create a simple 
boxcar.You will be working with multiple parts.
 

1.  Start Train Sim Modeler and select File | New.
   

2.  Select Part | | Box and use the settings in the image below to make the main part of the boxcar. 
We clicked on the Color button and selected a bright red so it is easy to see while viewing with 
Train Sim Modeler.
 

  
3.  Now you'll add a second part - a bogie. To do this select Part | Add | Box and set these 

parameters:
  



4.  In the top view, this new part 'Bogie1' appears on top of the main boxcar. You'll have to move it 
so that it is aligned with bottom end of the boxcar. Select Transform | Move Mode and then drag 
Bogie1 until it is correctly positioned.
 

  

 
5.  While still in move mode, in the front view drag Bogie1 until it is positioned beneath the main 

boxcar.
 



  

  
6.  Fabricate and reposition Bogie2 by repeating step 3, step 4 and step 5, but position Bogie2 at 

the top of the main boxcar. In perspective view, the model looks similar to this:

     
7.  Now we'll add the wheels. Part | Add | Tube and set the following parameters for the Part Name 

Wheels11. Be sure to choose the X-axis checkbox for Structure Long Axis.
 

  
8.  While still in move mode, in the front view drag Wheels11 until it is positioned alongside bogie1.

 



 

 

     
9.  You'll want to repeat this three times for Wheels12, Wheels21 and Wheels22. You'll position 

Wheels12 to the opposite site of Bogie1. Then position Wheels21 and Wheels22 to either side 
of Bogie2. Here's what our model looks like with all wheels attached:
 

  
10.  Recall from our first water tower exercise, that we had to "lift" the water tower from it's sunken 

state. We'll have to do the same for this boxcar. 
 
This boxcar is made from multiple parts (six of them). To move the entire boxcar as a single unit 
select Edit | Select All. You'll see that the color of the parts change to a bright yellow (one is 
green) indicating that the part is selected. Now you can move all of the parts together by dragging 
them until the bottom of the wheels are sitting on the ground level in the front view.
 

Notice that the axis is still located in the center of the boxcar. Move it to the origin by selecting 
Part | Center Axis | To Origin.
  

11.  Save the project as 'tsm_boxcar2.dst' and convert it for Train Simulator for the Marias Pass 
route



  
12.  Using the Route Editor, position your new tsm_boxcar in the Shelby area and take a look at the 

result:

 

  

While the boxcar is complete, you can experiment by adding textures to the individual parts. In fact, 
that's what we'll do next in Texturing the Boxcar.

 

 

  



Texturing the Boxcar
 

Having made a plain blue boxcar, let's add some spice to the project.

1.  Start Train Sim Modeler and select File | New.
    

2.  Reload 'tsm_boxcar2.dst' from the exercise Making a Boxcar. 
  

3.  Select Part | Select by Name or click on the equivalent icon to display the Part List dialog. Choose 
Boxcar(0) and click on the Make Current button and finally OK. This makes the main boxcar the current part. 
 

    
4.  Now that the main boxcar is the current part, select Part | Texture to display the Part Texture Assignements 

dialog:
 



From here, you choose the texture or textures that you will paint onto the surfaces of the current part (main 
boxcar). Notice that there are places for you to specify the texture filenames for the Front, Back, Left, RIght, Top 
and Bottom surfaces of the current part. You can see that Train Sim Modeler is very flexible in its ability to texture 
a part.
  

5.  Before we go any further here's a picture of a special texture that we made demonstrate the texturing techniques:
 

When me made this texture, we divided into several 
sections.

As you might expect, we will show you how to apply the 
red portion (Side) to the sides of the main boxcar; the 
blue portion (Top) to the roof of the main boxcar; the 
green portion (Front & Back) to both ends of the main 
boxcar.

The circular portion in the center can be applied to the 
wheels.

Let's continue to see how we can paint the texture onto 
the boxcar. 

 

  
6.  Next to the Front: edit box, click the Browse button. If you aren't already viewing the TS Modeler \Textures 

folder, navigate there and select the filename 'tsm_boxcar.bmp'. Click Open to continue.
 



  
7.  The Texture Properties dialog displays the texture. 

 

Using this dialog box, you will select the 
portion of the texture to paint onto the Front 
surface of the current part.

If you press the OK button now, you are 
using the default, which selects the entire 
texture.

Otherwise, you can drag a selction box 
around the desired portion. In the example 
to the right, we have drawn a selction box 
around the green portion of the texture.

Press the OK button. 

 

   
8.  You return to the Part Texture Assignments dialog and can choose the same or different textures for the 

remaining sides of the part. 
 



 
9.  Continue to apply the several portions of this same texture to the Back, Left, Right, Front and Top of the boxcar. 

The fully textured boxcar will look like this:

  
10.  Save this as 'tsm_boxcar3.dst', convert it for Train Simulator and make a new TS object. Here's what it looks 

like in the Route Editor:
 
 

You now have some of the texturing techniques under your belt. Let's look at another way to texture parts in Wrapping a 
Tube.

 

  



Texturing a Tube - Wrapping
 

Train Sim Modeler has eight 'native' parts that are displayed on the Tool Palette. The complete 
list of primitives are:
 

●     Box 
●     Tube 
●     Disk 
●     Oval 
●     Polygon 
●     Conventional Sphere 
●     Geodesic Sphere 
●     Cone 

Although the list of primitives is short, the number of variations is almost unlimited since you 
can adjust the characteristics as you make the part.

In this exercise, you’ll fabricate a different part – a tube. Then you'll "wrap" a texture around 
the tube. By itself, the project isn’t very interesting until you realize that the same process can 
be used to texture cylindrical objects such as tank cars or steam engines.
  

1.  Start Train Sim Modeler and select File | New.
  

2.  Select Part | Add | Tube. Make sure the Close Left/Bottom/Front and Close 
Right/Top/Back checkboxes are checked. Use the default settings for the other fields 
and click the OK button.
 



   
3.  The tube immediately appears on the screen. Here’s the Front view of the new tube: 

 

  
4.  In the previous exercise Texturing a Water Tower, you applied a texture to two sides of 

the water tower. In this exercise, you’ll apply a different texture to this part. Select Part | 
Textures to display the 'Part Texture Assignments' dialog. Next to the ‘Wrapped’ edit 
box towards the bottom of the screen, click on the Browse button. 



       
5.  The ‘Texture Properties’ dialog opens. In your TS Modeler\Textures folder, locate 

and click the filename tsm_tubewrap.bmp and click the OK button. While the dialog 
lets you set a cropping rectangle to limit how much of the image is applied to your part, 
accept the entire image by clicking on the OK button. 
  
Below are two alternative examples, one with the texture wrapped along the x-axis and 
the other wrapped along the y-axis. 
   

 
Wrap Axis Y

 
Wrap Axis X

    
6.  Select Edit | Part Properties and choose the Polygon Smoothing checkbox and then 



click OK. Now when you view the tube, it is much more refined:
 

 
   

7.  Finally in the Front view, drag the tube so that it is sitting at ground level (Transform | 
Move Mode) and center the axis about the origin (Part | Center Axis | To Origin).
     

   
8.  Save the project as 'tsm_tubewrap.dst'. 

   
9.  Convert this project for Train Simulator by selecting File | Create TS Object File and 

set the following fields:
  



   
10.  Start the Route Editor place the new object tsm_tubewrap in the Shelby area using 

the steps as you followed in Using the Route Editor. 
 
After you save the route, start Train Simulator and go to the Marias Pass / Shelby area 
to view the new project.



 
The texture is perfectly wrapped around the tube. This can be extremely useful when 
texturing that tanker car!

In the next exercise, we'll show you a way to make a special effect for Train Simuator. 
Continue with Using Transparent Textures.

 

     



Transparent Textures
 

To represent an object that has fully or partially transparent sections, you use a 32 bit 
texture file in the Targa&REG; format with a .tga file extension. TGA files can contain 
an 'alpha channel' that is a layer with a transparency map of the image. Train 
Simulator uses the alpha channel to control the level of transparency for each part of 
the image. This makes it easy to create a wall with transparent windows. The windows 
can even be streaked or have colored 'glass' with various levels of transparency.

32 bit TGA files with alpha channels can be created in most paint programs. Paint 
Shop Pro&REG; and Photoshop&REG; both support this feature. The creation of an 
alpha channel texture varies from program to program, and is beyond the scope of the 
TrainSim Modeler Help files.
If you require your texture to have partially transparent areas, you must use one of the 
material names starting with 'Alph' on the part(s) that use the texture. The 'Alph' 
prefix activates the DirectX transparency mode.

If the parts of your texture will be either fully opaque or totally invisible, use one of the 
material names starting with 'Tran'. This causes your texture to be applied as a 
'stencil' rather than as a texture with varying transparency levels. Each pixel is either 
'on' or 'off'.

To see this in action, create a simple box in TrainSim Modeler. Apply the 
'tsm_Smoke.tga' texture from the TS Modeler \textures directory to one face of the 
cube. In Part Mode, use 'Edit | Part Properties' to assign the 'AlphNorm' material 
name to the part. The box will look totally white in the Train Sim Modeler preview 
window.

Generate a static scenery file and view this object in the Route Editor to see the 
affect.



You can load the 'tsm_SmokeBox.dst' which you'll find in the TS Modeler \projects 
folder, if you don't want to build the object yourself. You'll notice that the faces with the 
tsm_Smoke.tga texture on it is transparent to varying levels.

Note: the solid perspective view in TrainSim Modeler is unable to display 
transparencies. You have to create a Train Simulator object file and view it in the 
simulator to see this effect.

Display Priorities

When using multiple layers of alpha transparencies, display problems can result in the 
simulator. For instance, if you are creating a train car with partially transparent 
windows that should allow you to see not only inside the car, but also outside the car, 
the simulator can have problems displaying the car properly in context with the 
scenery. You may not be able to see scenery objects through windows, or the inside 
of the car may be invisible behind the windows.

For this reason, special material names are provided to give you some control over 
the order the parts are displayed. All the 'Alph' material names have variations with a 
plus (+) or minus (-) sign at the end. TrainSim Modeler uses these name variations to 
control the drawing order of the polygons that make up your model.



Solid materials are drawn first, followed by alpha materials with the '-' flag. Next come 
the 'Tran' and 'Alph' materials without a +/- flag. Finally, the 'Alpha' textures with the 
'+' flag are drawn. You may have to experiment with material names and the special 
flags to resolve drawing priority problems in Train Simulator.

In the next exercise you're going to do some "cutting". Turn now to Cutting a Door 
from the Boxcar.

 

  



Cutting Out a Boxcar Door

In earlier exercises, we built a basic boxcar by starting with the 'box' primitive found on 
the Parts Palette. In this exercise, we'll show you how to make a boxcar with a door.
 

1.  Start Train Sim Modeler and select File | New. 
  

2.  Select Part | Box or click on the box from the Parts Palette
 

:

Part Name: Boxcar

Notice that there 
are 4 sections for 
Depth.

Click OK to 
continue. 

 

  

3.  Select Mode | Poly or click the icon  to change to polygon mode. In this 
mode, the project components are displayed as their composite polygons.



 
In polygon mode, you'll see a line extending from the surface of the current 
polygon. Choose View | View Surface Normals to display the surface normals 
for all polygons in the project.

4.  While still in polygon mode, select Mode | Select or click the icon . In the 
top view, draw a selection box around the surface normal of the indicated 
polygon. When it is selected, the polygon will appear in the color yellow.



   
5.  When you view this in the side view, it looks similar to the picture below:

 

  
6.  Next we are going to cut this selected polygon from the main boxcar. Since the 

polygon is still selected (it appears yellow), this is the polygon that will be used 
for the operation. Select Part | Part Split. Now this project is composed of two 
separate parts: main boxcar and the new door. 

 

7.  Select Mode | Part or click the icon to return to part mode. Select Edit | 
Part Properties and type "Door" as the name for this new part and choose 
light blue after clicking the Color button.
 



  
8.  The perspective view shows the boxcar and door:

 

   

 

As you've seen, the Part Split command lets you 'cut' polygons from an existing part.



In the next exercise, we'll introduce you to some additional texturing techniques. 
Continue with Texturing Multiple Part.

  



Texturing Multiple Parts

For some project, you may have to apply a texture to more than one part so that the texture is perfectly lined up on each part. 
Look at the illustration below and you'll see that the boxcar is made of two parts: the main boxcar and the door. In this 
example, the door is the current part and appears in bright blue.

Below is the example texture to be painted onto the side of the boxcar. Note that location of the black door in relation to the 
red side corresponds to the location where the two parts meet on the TSM model. You can of course apply this texture to the 
two parts separately. To do so, you will have to precisely position the texture in the 'Texture Properties' dialog to define your 
cropping rectangles (selection box). If these are not perfectly defined, the textures on the two parts may not fit together 
properly, making an unsightly seam.

Train Sim Modeler lets you to select more than one part and apply a texture to this entire group. To apply a texture in this 
way, you'll have to select two or more parts. Train Sim Modeler will automatically apply a texture to multiple parts if any parts 
are selected. Note that wrapped textures cannot be applied to multiple parts at once.

When you select the Part | Texture command, you are defining textures for the current part. Note that the current part may or 
may not be one of the parts you selected for texturing. This is very important to understand. By default, the current part is 
shown in bright blue, selected parts are bright yellow. If a part is both the current part and selected, it is shown in bright 
green. Other parts are shown in a dull blue. (Note that these colors are the default used by Train Sim Modeler and can be 
changed with the File | Preferences command.)

The following exercise uses the boxcar from Cutting a Door from the Boxcar. The project is tsm_boxcar_door.dst and the 
texture filename is tsm_boxcar_door.bmp.

1.  Select File | Open and choose the filename tsm_boxcar_door.dst. 
  

2.  Select Part | Select by Name or click the icon .
 



For this step, select the 
Boxcar and unselect the 
Door.

When you have completed 
these operations, the Part 
List will appear as it does to 
the right.

 

  
3.  To set the texture parameters, select Part | Textures from the menu. Click the browse button for the Right texture, 

and open the tsm_boxcar_door.bmp texture. Draw a cropping rectangle for side of the boxcar. My crop settings for 
the side of the boxcar are shown below:

  
4.  Click OK to apply the textures.

Train Sim Modeler will show you this message 
box. It's just asking you if you want to paint the 
texture onto the selected part (main boxcar) or 
only the current part. Since the main boxcar is 
both the selected part and current part, you can 
answer either Yes or No with the same result

  The project is shown below with the texture 
applied:



Notice that the black door texture was not applied to the side of the project. Why not? 
 
The reason is that the texture was applied only the the selected part. Since we selected only the main boxcar and the 
door remain unselected, the door remains untextured.
   

5.  Now let's choose both parts and reapply the same texture. 
  

To select a part, you can press the ‘n’ 
key on the keyboard to cycle through the 
parts. Press the Space bar when the 
main boxcar and the door are highlighted 
to select them (the space bar toggles an 
items selection state). Alternatively, you 
can choose Edit | Select All to do the 
same.

 

Yellow color indicates that the part is 
selected; green color indicates that the 
part is both selected and current. 

  
6.  Set the texture parameters again by selecting Part | Textures from the menu. Click the browse button for the Right 

texture, and open the tsm_boxcar_door.bmp texture. Draw the same cropping rectangle, this time for side of the 
boxcar that includes the door.



  
7.  Click OK to apply the textures. 

 

You'll see this message again. For this case 
answer Yes.

The project is shown below with the texture applied 
and the black door overlays the door exactly with no 
overlap (otherwise you'd see the blue underneath).

  
8.  Save this project as 'tsm_boxcar_door2.dst'. 

 

Applying a texture to multiple parts at once is an advanced technique that requires some experimentation to understand fully 
how Train Sim Modeler treats multi-selected parts during texture calculation.

Developer Matt Peddlesden has written several tutorials. We'll now turn to these so that you can work through a few complete 
projects. Please continue with Building a Simple House.

 

  



Tutorial 1 - Building a Simple House
 

By M. Peddlesden, Copyright &COPY;2001

Introduction

You've just got Train Sim Modeler, it's installed and now you want to see what it can do - and 
more importantly what you can do with it.

This first tutorial is aimed at getting you your first model done from start to finish. It will take 
you through the whole life cycle from building the 3D model, texturing it, learning to export to 
MS Train Simulator and finall how you can test it in the Route Editor.

 

●     Section 2: Creating the 3D Model
●     Section 3: Texturing
●     Section 4: Exporting to MSTS
●     Section 5: Testing in the Route Editor 

 

Let's see how you can make the house. Click to continue. 



Section 2: Creating the 3D Model
In this first tutorial we're going to do a simple model of my house. I haven't measured my 
house so the dimensions are all mostly done so it looks right - though as you'll see when you 
import it, it's quite large :)

Let's get started.

 Click on the Cube Mode button so that you can add a cube as shown in the 
illustration on the left.

You should see a dialog box like this:



Set the Width to 6 meters, the Height to 6 meters and the Depth to 12 meters. Click OK.
You should now see a new shape on the perspective view (top right) and the other three should 
be showing you that shape in the front, side and top views, as follows:



Now we're going to put the roof on. To do this we'll use a simple template.
Templates are very useful when you don't want something that is shaped close to one of the 
prefabs. They work as follows: Trace out what you want the prefab to look like from the view 
you choose (in our case, we're going to be doing the template in the side view). Then you 
extrude the template in to the view (so since we're in the side view, you'll be extruding across 
the width of the cube). Let's see how that works in action.

Switch to Template Mode by clicking on the Template Mode icon in the Tool bar as shown 
here:

Now select 'Add Point' mode by clicking on this toolbar icon once so that it stays pressed:

You're all ready to go, so let's draw the roof. Remember you're doing it in the SIDE view, 
which is the one directly beneath the perspective view. Here's what you should end up with in 
the side view:

So far we haven't actually drawn anything in to the model, we've defined a template and 
nothing more. Now to extrude an object out of that template. Click on the Template menu and 
then select Extrude. Set the length to 6 (remember that's the width of the cube we placed) and 
click OK. You should now be seeing something like this:



That's the main part of the house done, now it's time to work on the kitchen and third 
bedroom!.

Before we go any further let's understand where things are going to go. It's always handy to 
know where front and back are, where left and right are and where top and bottom are. This 
might sound a bit too obvious but remember you are looking from all different views.

The snapshot above tells you where everything is so in the next section when we say we are 
going to move something towards the back of the model in the side view, we are now clear on 
exactly where we are going to move it.



Click back to Part mode by selecting the Part Mode icon in the tool bar as shown here:

Click on the Cube icon again and this time add a cube that has Width 3 meters, Height 6 
meters and Depth 6 meters.
You'll see that it's added it bang smack in the center of the main house cube so now we have to 
move it out so that it's joined on to the back of the house.

Now we are going to see about how you can move the objects around, since we just created the 
cube it will be the one selected so we don't have to worry about that. We need to switch to 
Movement mode though so do that now using the icon as shown here:

The buttons shown above are, from left to 
right:

 

●     Movement Mode
●     Rotate Mode
●     Scale Mode
●     Lock X Axis
●     Lock Y Axis
●     Lock Z Axis

Once you're in movement mode, lock the X and Z axis by clicking once on the appropriate 
buttons. All we want to do is move the cube up and down. Now move the cube to the ground 
(using the FRONT view).

Next, unlock Z and lock the Y axis. Using the SIDE view, move the cube so that it is at the 
back of the main house cube, but still joined to it. For both of these movements you might 
want to zoom in so that you can get it as accurate as possible - keyboard shortcuts 'i' and 'o' 
zoom in and out respectively. Alternatively, if you right click you will see numerous options 
including Zoom in, Zoom out, and Reset Views (puts them all back to how they started). If you 
want to center a view to move it around, right click and select 'Center' and the view will 



recenter so that where your mouse is currently will become the new center of that panel.

Note: Zooming acts on all windows.

Here's roughly what you should be seeing:

In the 3D view (top right) you can rotate the image around by simply 
clicking and dragging your mouse while in that panel. You can also use the 
panel directly above the 3D view to zoom in and out of that view as well as 
alter the lighting conditions.

That's the kitchen done, now for the bathroom. Create another cube, this time Width 3 meters, 
Height 3 meters and Depth 3 meters. It has once again placed it in the center so use the same 
coordinate locking that we used for the kitchen in order to move the bathroom so that it is 
behind the kitchen and on the ground.

It should now look like this:



My house has a bay window on the front downstairs - it would be quite tempting to add this 
extra bit of detail in and indeed it would look even better if you did - but it could be a bad idea 
to do so. Always consider how much detail people are actually going to see in general 
circumstances before you decide on what detail you want to add in the 3D model.

For example, this house is probably going to be away from the tracks and there's probably 
going to be lots of them in clumps too. What this means is that the per-model polygon count 
must be kept as low as possible. The fact that the house will be away from the tracks just 
means that we have even more reason not to put excessive detail in the 3D model.

Textures can help you out in a lot of ways, in this case when we come to texturing you'll see 
the bay window and indeed from the point of view of a train screaming past it'll look every bit 
as good as if you'd spend a while doing the 3D version, except that you'd need about another 7 
polygons atleast to do the bay window and this model is only going to be around 23 when its 
finished anyway. That's the reason we haven't done the bay window in 3D for this example, 
whether you decide that it is worth the extra 7 polygons is entirely up to you when you do your 
own models of course! :)

That's the 3D Model complete. Now we move on to applying textures. 



Section 3: Texturing
For those new to 3D Modelling it can be quite a surprise just how much difference it makes to 
your model when you apply a good set of textures to it. Suddenly it goes from some almost 
abstract shape that resembles the thing you're trying to make to actually looking like it!

If you haven't already, I'd suggest having a quick run through our Texturing tutorial as this will 
introduce you to some ideas about making the texture. This tutorial focuses on applying that 
texture to a new 3D Model so we won't cover all the ways in which you can make it in the first 
place.

Microsoft Train Simulator requires that all polygons are textured before it can be used, this is 
enforced by Train Sim Modeler Studio by simply not permitting you to export to Train 
Simulator until you have textured every polygon. Later on in this tutorial, we'll show how you 
find out if there are any untextured polygons on your model.

For the texturing of my house, i've decided to go with some photographs I took from when I 
moved in to the place. They're not brilliant and if I were going to be distributing the model for 
others to use I'd want to go outside and take some better ones - but they're more than adequate 
for this tutorial.

I simply cut and paste various bits out of various photographs into a 256x256 BMP file. I chose 
256x256 as this will have less memory strain on the system as compared to a 512x512 size file. 
You may decide to use a smaller texture file for your house - in the case of scenery such as this, 
the smaller the better.

Here's what I ended up with:

file:///C|/_PremierCollectionInstallations/_TSModeler/Help/tutorials/house/xxx


The front and the back should be obvious, on the bottom left we have a large section of wall 
area. On the bottom right is the bathroom window (though it's heavily edited as you can see!). 
The last three sections I put in because they might come in useful. The upper two are from the 
two kinds of fence in the garden, though in this example I've decided to use the grey-coloured 
one to form our roof texture. We're also not doing fences in this model. The bottom texture is 
just a bit of dark colouring.

Whenever I make a texture up I try to make sure that each individual area is 
sourced from its own section of the texture file - it might seem tempting to 
say that the colour inside the bathroom window is dark enough, just use 
that.... but what happens when you later decide you want to put a light on in 
the bathroom - suddenly everything that was dark coloured becomes light 
coloured, not what you expected or wanted! :)

Reusing bits of texture inappropriately is a bad habit to get in to unless it is 
absolutely necessary. For example, if a little reuse of textures meant you 
could use a 256x256 texture instead of a 512x512 texture then I'd say that it 
was a worthwhile trade-off.... just remember to warn anyone that might want 
to repaint your model.... 

Before we move on, let's touch the topic of using textures to reduce your polygon count - which 
we first covered in the modelling section. Notice how you can see the bay window, you can also 
see the inset porch on the left. This will be more than fine for our simple house model in the 
context for which it will be used.



On the flipside however it should be pointed out that you can go too far in the opposite direction - 
3D details look much better than 2D textured ones so be careful what you make 2D and 3D so 
that you have a trade-off between a 'cheap' (polygon count-wise) model and a good looking one.

Ok, let's get this house textured!

It's quite possible that you won't be currently selected to the main cube of the house so we need 
to select it somehow. This is one place that makes Train Sim Modeler different to some of the 
other 3D Modelling packages - whether it is better or not is purely a matter of personal 
preference, personally I find it much easier to do it the way Train Sim Modeler does it, 
particularly when you get to more complex models with miniscule elements that you need to 
select (and probably remove if they're that small! :) ).

Shown below are the selector arrows from the toolbar:

You can use these to select elements in your model. If you're in part mode (which you should be 
still) then this control will sequence through each of the parts in your model.

Incase you are unclear, here are all the parts in 
our house model:

●     Main House Cube
●     Main House Roof
●     Kitchen/3rd Bedroom Cube
●     Bathroom Cube

If you are in Polygon mode it will sequence through all of the polygons that are in the part you 
were selected to prior to going in to Polygon mode. If you are in Point mode then it will 
sequence through all of the points of the part you were selected to prior to going in to Point 
mode. In cross section mode it will go through each cross section in the part.

Use the arrow buttons until you have selected the main house cube (ie. the one beneath the roof).

There are two ways to texture in Train Sim Modeler. For the purpose of this example we're 
going to use the simplest one. This simple method may not always work quite how you expect, 
in later tutorials we will cover several techniques and alternative methods for texturing.



Click on the Part Menu and then on Textures option, you should see this dialog box:

Notice how there are numerous areas, Front, Back, Top, Bottom, Left and Right. We won't 
worry about 'wrapped' for the time being. Each area has three buttons:

 

●     Browse - Find a new texture BMP or TGA file on your hard drive to use.
●     Properties - Edit the existing texture for this area.
●     Clear - Clear the texture on this area 

Those areas essentially are quick-macro's for texturing all polygons that are facing roughly in 
that direction. So we're about to texture the front - this will choose all polygons in the model that 
are facing towards the front. Sometimes this is great and can save you some time but you might 
find that on more complex models it selects polygons you wish it hadn't, there are ways around 
this and you'll see them as we progress to more complex tutorials, as well as in the other 
descriptions of texturing in the Help files.



Click on the Browse button for the Front texture.

You can find a copy of the texture map for the house (housetex.bmp) in the Train Sim Modeler 
\Textures folder. Highlight it and you should see it in the preview window, click OK to accept.

You will now see the texture properties window (this is where you go straight to when you click 
on the 'Properties' button instead of the Browse button a little while ago).

Mark the area on the texture that has the front of the house in it. Just click and drag as if you 
were drawing a rectangle in a simple paint program. Train Sim Modeler will show your 
bounding box as you draw it and when you are happy its in the right area you can release the 
mouse button. If you need to make any minor adjustments then you can use the adjusters on the 
right (X-Crop, Y-Crop etc).

When you are happy that you've got the right area (remember you can come back and edit it later 
if it doesn't look quite how you expect on the model) click OK.

This is what you should now be able to see:



There you are, that's the first texture placed and already the model is looking more like a house! 
Let's carry on and get the rest textured.

The next section to do is the back of the main house. There's a window from the second 
bedroom and the door at the back of the lounge/dining room - this is the bit of the texture that is 
to the right of the front of the house.

Click on the Parts menu and then on the Textures option again, this time click Browse on the 
back texture area and choose the same texture file as you used for the front. Notice how all I 
have included is the bit that's visible? When you mark this bit of texture you should include an 
amount of white to the right of it (about 50/50). You may well need to re-edit this texture a few 
times to make it so that the window and door fill the area correctly and you can see no white. 
Remember that this is because you're texturing something that is the same size as the front 
texture - but some of it is hidden behind the kitchen cube.

If you do need to edit the texture just go in to the Parts menu, click Textures and then choose 
Properties instead of Browse.

Here's the house with the back texture applied to the main cube:



Use the flat texture in the bottom left for all other areas. One important thing to remember with 
this model is that you still need to texture the top, even though it's invisible!

In the optimisation tutorial you'll learn about 
how to optimise your models by getting rid of 
invisible polygons, for now, just remember to 
texture it!

Now we've got this in the 3D solid view window:

Notice how the roof still needs to be done, we'll do that one last as it's a little different.

Repeat the process we've just done for all the other parts. Just use the flat yellowish texture for 
all faces, and don't forget to do all of them - even hidden ones. So, for example, the front area of 



the kitchen cube is hidden because it's against the main house cube - it still must be textured.

When you come to the bathroom part, texture the back area of it so that it has the bathroom 
window part of the texture file in it for some added effect.

My house has a door in the kitchen and numerous other bits and pieces that aren't shown in this 
simple model, simply because I didn't have the photographs to generate the texture from. In this 
example that's not so important - you might want to go the extra mile for your own models 
however.

Now for the roof. Use the selector arrows to select the appropriate part.

Before we apply any textures, let's understand what is going to happen first - look at this 
diagram:

I have shown the three textures that we need to apply. You will recall earlier that I described the 
'front', 'back' and all the other areas in the Part/Textures menu as being textured according to 
those facing roughly in the chosen direction. This is the reason that when we texture the front of 



the roof, the front half of the slanted roof will be the one that receives the texture.

I used the grey texture from the texture image to do the roof. Texture the front and back in the 
grey, and then the bottom (remember, hidden polygons need textures too!) in whatever you 
choose.

Ok - in theory that's everything textured!

Let's verify that assertion before we move on to the next section and try to export it to Train 
Simulator...

Train Sim Modeler provides a useful tool for determining how you're doing while you texture. 
Click on the Polygon menu and then select Find Untextured Polygons. You will see a dialog box 
come up telling you how many untextured polygons are in your model. If everything has gone to 
plan then you should see this:



This dialog is telling you that there are zero poly's that are untextured, which means we're ready 
to export.

Let's say that you had forgotten to texture the top of the main cube, the underside of the roof and 
the front of the kitchen, all hidden faces. When you run this command it would have replied that 
you had 3 poly's in 3 parts untextured. This is telling you that there are 3 parts containing 
untextured polys, and in total there are 3 poly's that are untextured. It will automatically select 
all of the parts containing untextured polygons and then if you select one of those parts and 
switch to polygon mode it will show you which of those polygons are untextured, allowing you 
to quickly and easily zoom in on the remaining bits that need texturing!

Still, if you have zero untextured poly's then that means you are ready to proceed with exporting 
to Train Simulator - which is the next section! Click to continue. 



Section 4: Exporting to MSTS
This is one bit where Train Sim Modeler makes your life extremely simple and one of the key 
benefits of the application having been designed specifically with MS Train Simulator in mind.

First up, let's get some house keeping done...

Go in to the File menu and click Project Properties. Set the copyright and the name of the 
object. Whatever you put here in 'name' will be what you see in the Route Editor.

Next up, let's take a quick look at the project statistics - when you're building a more complex 
model I'd recommend keeping an eye on the project statistics at all times just so that you don't 
spend five hours making a wonderfully details model only to find that it has an unusable 
polygon count!

If we run it in our house we get something like this:

There are two blocks of information - the first tells you about how Train Sim Modeler see's 
your model and the second tells you how MS Train Simulator will see it.

The difference is very important. While a pentagon is only one polygon in Train Sim Modeler 
it's going to be three polygons in MS Train Simulator! The reason for this is that Train 
Simulator works only in triangles whereas Train Sim Modeler can handle polygons with more 
than three points. Why is this? A triangle is guaranteed to exist on a single 'plane'. That is, it's 
always flat, you can't have a bumpy three point triangle. If you envision a square and then 
move one of the points up in the third dimension, suddenly your square becomes bent at that 
corner, and this presents problems for rendering enginges. Here's how that pentagon would 
have worked:



  

Moving on, let's get this thing exported.

Click on the File menu and then select Create TS Object.

Choose the route that you want this model to be available on.
Enter a name for it, this is the same name that you would have entered in Project Properties.
Enter a filename for it, this should be filled in for you as well.
The 'Class' is the kind of object and determines the grouping when you go to select an object in 
the Route Editor, set it to "Housing".
Ensure that Convert to Binary and Convert Textures are ticked.

The 'shape' file format is either in Unicode 
ASCII (which in plain english means that it's a 
human readable file), or it can be in a binary 
file format. When the "Convert to Binary" 
checkbox is ticked, Train Sim Modeler will 
automatically convert the file from its ASCII 
format in to the much much smaller binary 
format.

Your textures have been in either the TGA or 
the BMP file formats - however MS Train 
Simulator requires them to be in a proprietary 
'ACE' file format. With the 'Convert Textures' 
checkbox ticked, Train Sim Modeler will 
automatically convert your textures into the 
right format. 

When you click OK the model will be exported to MS Train Simulator and you should see a 
'Conversion Successful' report. This has actually done quite a lot behind the scenes including 
copying files in to the right locations, creating support and definition files, editing MS Train 
Simulator configuration files and much more.

The next step is to test it by adding the model to a route. If you've tried making your own 



models in other packages then you'll no doubt recognise the amount of work that Train Sim 
Modeler has just saved you. Click to continue. 



Section 5: Testing in the Route Editor
Now it's time to actually see how this model looks inside MS Train Simulator.

Go in to the Train Simulator Editors and Tools (on your Start Bar) and select the Route Editor.

If you don't have an option for Train 
Simulator Editors and Tools, that probably 
means you haven't done a full installation of 
Train Simulator - you'll need to do that before 
you can proceed.

When you enter the Route Editor it will ask you for a route. Choose the route that you told 
Train Sim Modeler to save your design to.

In the 'Modes' window, select Object Placement Mode. This is shown here:

Next, find the Placement window and click the 'More' button as shown here:



Select the Housing class (or whatever you chose to put the model in to) from the Drop Down 
list and then you should be able to see your model, select it.

Click on the terrain to place the model, you'll need to go back to Selection mode as follows, in 
order to see the object in anything but wireframe though:

Once the object is deselected (click anywhere else other than on your new object) it will 
become fully textured instead of being a wireframe.

That's all folks!

  



You can of course place multiple of your model down to build up a street, though a more 
efficient way to do this would be to make a multi-house version of the 3D model with as many 
hidden polygons removed (eg. all the ones that are common on the insides of joined houses). 
In this example I've just placed three of the houses next to each other in the route editor as an 
example.

  



That's the end of this tutorial, we've covered quite a bit of ground and hopefully you now have 
a much better understanding of the basics of how Train Sim Modeler operates.

Where you proceed to from here is entirely up to you, you could either proceed on to do more 
worked examples or alternatively read some of the techniques tutorials.

Now you can continue with the next tutorial Making a Wagon. 



Tutorial 2: A Two Axle Wagon
 

By M. Peddlesden, Copyright &COPY;2001

Introduction

Building scenery is all very well but the area most people want to get in to is the rolling stock 
itself.

This tutorial will be easier if you've gone through the "Building a Simple House" tutorial but it 
will stand on its own and you should still be able to complete this one even if you haven't done 
the simple tutorial yet.

The aim of this example is to produce a freight wagon, it'll have wheels that go round and at 
the end we'll make up a small train of them just to prove it all works. The wagon itself is 
loosely based on a Wrenn Banana Truck OO-Gauge model, we'll be using textures scanned in 
from the model and the basic shape will be similar but it won't be a strictly scale model.

Here's the contents of this tutorial

●     Section 2: Creating the 3D Model
●     Section 3: Texturing
●     Section 4: Exporting to MSTS
●     Section 5: Testing in Train Simulator 

 

Here's a picture of the real-life OO guage model:



Photo Courtesy of Onehouse Model Railway

And here is a quick mock up drawing that gives us the scaled dimensions to help make it look 
a bit more realistic within Train Simulator:

http://www.onehouse.co.uk/railindex.html


Click when you're ready to Create the 3D Model. 



Section 2: Creating the 3D Model

To start off let's make sure that TSM is set up to use the right units of measurement. Since a 
OO guage model is measured at a scale of 4mm to 1 foot our life will be much simpler if we 
set TSM to use feet instead of meters. Go to the File menu, select Program Prefs and from 
there select Feet as the units of measurement.

Next up, on a smaller and less detailed model like this it's going to be helpful if the grid size 
was just at a simple 1ft size, change this by going to the View menu, select Grid Size and then 
set it to 1 and click OK.

There are two ways to draw a scale model - the best results are probably achieved through a 
combination of the two but let's look at each one briefly, the reasons for and against choosing 
each method will be quite apparent.

Scale Drawings
If you can get hold of Front, Side and Top scale drawings then you can scan them in and your 
model building will be the 3D equivalent of tracing. It's not quite as easy as it sounds - that 
extra dimension really adds to the 'fun' :)

Measurements
If you have a scale model of the loco or wagon to hand then pull out that ruler and start making 
your own scale drawings, even if they're just notes as you proceed modeling.

We are going to use approximate measurements for this model. The measurements that have 
been kindly provided to us by the Onehouse Model Railway are shown in Section 1. As the 
purpose of this tutorial is to teach how to make 3D Models we aren't going to labour on fine 
details - though we're going to atleast try and get things roughly in the right shape.

Let's get to work!



Click on the cube mode button and a dialog will pop up asking for the dimensions 
for the new cube. Enter the following:

Width: 8
Depth: 17.5
Height: 7

Leave the number of sections to 1 in each case and don't worry about naming just 
yet, we'll fix that up as one of our last jobs.

Before we move on to doing the roof, let's move the cube so that it's sitting on the "floor". This 
is the thicker horizontal line. First put yourself in Movement mode and lock the X and Z axis 
so they cannot move, allowing you to only move the cube in the Y direction.

Now move the cube so it sits on the thicker line, as shown below:



Since our model will have the highest point of the roof at 1 foot above the top of the cube this 
will now make the roof easier - as the grid marks that point out helpfully for us. Note that the 
real model is a 5mm height, so if you want to make yours hyper accurate then you want to aim 
for 1.25ft as the highest point.

The Roof

Switch to Template Mode...

Click on the Add button to allow us to begin adding points to our template...

Zoom in a little (you can either right click and select Zoom-in, or you can simply press the 'i' 
key - the 'o' key will zoom you out). I would zoom so that you can comfortably see the area 
you're going to draw in and make it as big as possible - in the front view.

If you need to move the FRONT view down to zoom in closer, RIGHT click above the blue 
rectangle and in the pop up menu click on CENTER. This will move the point you clicked to 
the center of the front view.



The order in which you create the points is important. Polygons in 
Train Simulator are unidirectional, that is to say you can only see a 
polygon from one side - it is completely invisible on the other side.

Do this roof segment in clockwise order and you will be fine, the 
polygons will all face outwards. If you do the roof in anticlockwise 
order you will find that you can only see inside the roof!

There is a way to flip polygons around and we'll discuss it in another 
tutorial. 

I usually aim to get the points in roughly the right place, but not accurately, the first time as 
follows:

Now we unclick the add button (simply click it again and it will pop out), now you can drag 
the points of the template around until you are satisfied. This is roughly what you're aiming 
for:

Note how we've added the template to the top of the wagon.

Click on the Template Menu and then choose the Extrude option. Enter a length of 17.5ft 
(remember that's the length of the wagon) and make sure "close ends" is ticked. Click OK and 
you'll see your roof magically appear!



That's the main body of the wagon done - it's time for the wheels.

The Wheels This part of the model is going to take some planning. We have to get the wheels 
in the right place so that they are on the rails and centered front to back or else it's going to 
look very odd indeed!

The wheels are going to be made up of a tube. The details of the tube are as follows:

Radius: 1.5
Length: 0.3
Points per section: 8
Sections: 1
Close Left/Front/Bottom: Yes
Close Right/Top/Back: Yes
Structure along X Axis

Click on the tube button (below the cube one you used earlier) and enter those details. Again, 
don't worry about the naming of the object yet.



We have used an eight sided tube for the wheels to save on polygons. 
If you are feeling brave and don't mind it slowing your machine down 
then by all means you can add more - it makes your wheels more 
round but at the cost of performance.

Always keep in mind, especially in the case of wagons, how many of 
these models you expect to see in a consist. In the case of this wagon 
it could be quite a few so a 1000 polygon model is going to quickly 
consume resources where a 300 polygon model will be just fine. As 
always, it's a trade off between quality and performance and it's 
entirely up to you. 

This will create a wheel in the very center of your wagon so using the movement controls 
move it so that it's somewhere under the wagon - it doesn't matter exactly where at the point in 
time, just make it visible.

Now we're going to use a pair of helper objects. The first one is going to be a tube with the 
following details:

Radius: 0.5
Length: 10
Points per section: 4
Sections: 1
Close Left/Front/Bottom: Yes
Close Right/Top/Back: Yes
Structure along Z Axis

Move this ONLY on the Y axis (lock X and Z to make sure you dont move it accidentally) so 
that it is just below the main body of the wagon. This will tell us where the centerpoints of the 
axles on the wheels are going to go!



As shown in the above diagram, we'll be putting the wheel centers around where the points 
indicated by A and B are. I've also marked where the front and back of the wagon are on the 
diagram for clarity as the screenshot may have made it hard to see on your monitor.

Using Movement Mode, move your wheel so that the gap between the top of the wheel and the 
bottom of the wagon looks reasonable to you, and then in the side view move it to the left end 
of the helper. If you had access to the model then you could measure it for added accuracy but 
since you don't just do it on a best guess.

Leave the helper where it is for now, we'll do the other wheels in a moment. Let's get the other 
helper object in.

This object is going to help us to place the wheels the right distance apart and make sure they 
are centered correctly underneath the main body. Create a new tube with the following details:

Radius: 0.3
Length: 5.0
Parts per Section: 4
Sections: 1
Close Left/Front/Bottom: Yes
Close Right/Top/Back: Yes
Structure along X Axis

Now you can gently move the wheel along the X axis (lock the Y and Z axis) so that it's inner 
edge is touching the outer edge of the new tube.



Now it's time to add in the remaining wheels. We're going to do it the cut and paste way rather 
than manually making a bunch of new ones however!

Whichever side you have made your wheel at the moment doesn't matter, just read these 
instructions in the correct way to place in the remaining wheels. My screenshots will be shown 
from the point of view of the first wheel being in the Rear Left See the Perspective View 
screenshot above.

To highlight the different parts you can either press the 'n' key (for next) or the 'p' key (for 

previous). Alternatively you can use the  buttons for the same purpose.

With the wheel highlighted go to the Edit menu and select Copy. Now go back to the edit 
menu and select Paste. It's pasted a new wheel directly into the same place as the original one - 
hence why you can't see anything new. Now go in to Movement mode with Y and Z locked:



Move the new wheel to the other side of the guide object, as shown:

That's two wheels in. Before we do the other two let's put an axle in between these two. We 
have the perfect object for this already in the model so let's just re-use that.

Highlight the helper object that is helping to space the two wheels part and go in to Movement 
mode. I'd recommend locking the X axis but leave Y and Z free. Move the part so that it is 
exactly centered on the two wheels and indeed looks like it might be an axle, as shown:

Note: While a four sided tube isn't going to 
look quite right for a round axle, remember 
that it isn't going to be seen very much 
anyway so don't waste polygons on it!



Now we're going to make one new part out of those three. To select an object in TSM you 
should press the SPACE bar. So, using the next/previous object buttons or the n/p keys and the 
space bar highlight and select the two wheels and their axle. You should see something like 
this when they are all selected:

Go to the Part menu and choose Join Selected (for future reference, the 'j' key will do this too), 
this will turn those three parts in to one single part - amongst other things this means that the 
wheels and the axle will turn together in Train Simulator.

WIth the wheel assembly highlighted go to the Edit menu and choose Copy. Now return to the 
Edit Menu and choose Paste.

Once again the new assembly has been place in the same space as the original one. Lock the X 
and Y axis and using movement mode:

Move the new assembly so that it lines up the center point with the first guide tube that we 
placed in, you should now have something like this:



Highlight the spacing part and press the DEL key to remove it as we no longer need it.

We're almost done with the 3D Model now! The last step to do are the Axle Boxes...

Axle Boxes

On our tutorial wagon we'll just make these a fairly simple shape, later on you can always 
return and make them into a more complex shape.

On the side view, zoom in so that you are focused on one wheel - you'll need to be able to see 
the bottom of the main body and the axle centerpoint for the wheel.

Go to template mode  and click on the Add button . When you add 
points, if you find that there is an existing template causing problems just simply use the 
Template menu and its "Clear" option to start the template entirely from scratch.

Draw this shape, once again use a clockwise motion to lay the points down as indicated by the 
numbers:



Now go to the Template menu and choose the Extrude option. Enter a length of 0.2 and make 
sure close ends is ticked. Press OK.

It's been made in the center of the model so locking the Y and Z axis move the axle box out so 
that it is touching the outside of the wheel, as shown:



Now use the Copy/Paste functions in the Edit menu and the movement mode (remember to 
lock the axis that you are not moving along so that everything stays neatly lined up) and put 
the Axle box on all four wheels.

Before we proceed we're going to join the main cube and the roof together in to one part. This 
will allow the front and back textures to neatly go across both objects. Using the next/previous 
object or 'n' and 'p' keys, and the SPACE bar, highlight and select the main cube and the roof. 
Press the J key to turn them in to one object.

Next we need to move the whole model up to ground level. At present the cube of the wagon is 
above ground and the wheels are below ground - ie. below the thicker horizontal line. Here's 
what I mean:



To move the wagon so that it is above ground when we export to Train Sim we must get the 
wheels to sit on the horizontal line.

Go to the Edit Menu and choose Select All. This will highlight all the parts in your model. 
Now click on the movement icon and lock the X and Z axis so that you can only move in the Y 
axis, as shown here:

Using your mouse in either the side or front view drag the whole wagon up until the wheels are 
just sitting on the horizontal line.

The next step in getting the wagon above ground is to set the ground level of the main wagon 
body up. Use the 'n' and 'p' keys to highlight the main body that you just created by joining the 
cube and the roof together. Notice how each part has an axis in it?



It's the bit that has the X, Y and Z labels on it. We need to move this to the ground now. You 
move it by holding the SHIFT key down and then dragging with your mouse. Make sure you're 
still in movement mode and only able to move in the Y axis and hold the SHIFT key and the 
left mouse button down and then move your mouse slowly down until you have placed the axis 
on to the floor. You only need to move the axis for the MAIN part down to the floor, the others 
should be left at their centers.

Now the wagon will appear correctly above ground in MSTS, instead of being half 
underground!

The 3D model is now completed as far as we are going to go in this tutorial. Later on of course 
you can always come back and add more details such as the all-important Buffers.



The final step that we must consider with the 3D model is naming the parts and setting up the 
correct object hierarchy. It's not quite as daunting as it sounds thanks to some simple dialog 
boxes in TS Modeler!

Highlight the main body of the cab and press F2 to get the Part Properties. Set the Part Name 
to MAIN and leave the Part Parent blank. Press OK.

Now Highlight one of the axle boxes. Press F2 and set the Part Name to AB1 and the Part 
Parent to MAIN. Repeat this for the other four axle boxes naming them AB2, AB3 and AB4. 
Exactly what you call these four parts isn't important as long as they are all unique and their 
parent is set to MAIN. You could also just simply join the four axle boxes to the main body 
and then you wouldn't even need to name them.

Next, highlight one of the wheel assemblies. Press F2 and set the Part Name to WHEELS11 
(you can click on Train Names and look this one up directly), set its Part Parent to MAIN as 
well. Repeat this for the other Wheel Assembly but name that one WHEELS21.

That's all the hierarchy done.... Simply by selecting the names of the wheels objects to those 
special ones (WHEELS11 and WHEELS21) is all it takes to make them turn when the wagon 



moves!

Next we're going to look at putting some textures on the model. Click to continue. 



Section 3: Texturing

Here's the texture file that we're going to use in this example. You'll find the file wagontut.bmp 
in your Train Sim Molder \Textures folder ready to apply to your 3D Model.

There are more texture areas in this file than we are going to use in this tutorial - for example 
you can see the ends of the buffers fairly clearly in the center.

With the main body of the wagon selected (as it should be after the join we did in the previous 
section) go to the Part menu and choose the Texture option. For each of the areas in the table 
below, click on the Browse button, find the wagontut.bmp file that you downloaded earlier and 
then enter in the coordinates shown on the table to mark out the appropriate area in the texture. 
You can of course manually drag select areas on the texture if you so wish.

Front X Crop: 0 Y Crop: 232 X Size: 265 Y Size: 280
Back X Crop: 0 Y Crop: 232 X Size: 265 Y Size: 280
Left Leave blank
Right Leave blank
Top X Crop: 381 Y Crop: 234 X Size: 124 Y Size: 268
Bottom X Crop: 274 Y Crop: 429 X size: 17 Y Size: 13

Here's what you should see in the 3D view now:



Now we'll need to use polygon mode in order to texture the two sides. The reason for this is 
because if you texture "left" or "right" of this object then some of the texture will be applied to 
the roof as well - remember some of those polygons are actually pointing towards the left or 
the right too.

In order to see in the 3D view which polygon is selected we'll need to switch out of solid view 
and in to wireframe view. Go to the View menu, from there in to its Perspective View 
submenu and finally untick the Display as Solid option.

Use the next/previous object or 'n' and 'p' keys to select one of the sides, as shown:



Note the small line in the center of the polygon. This is called a 
"Normal". It tells you in which direction the polygon is facing. If you 
remember earlier while creating the 3D model we discussed how a 
polygon is only one sided and that you can flip them around so that 
the right side is visible. You do that in polygon mode, and the normal 
is how you tell which way the polygon is facing. Try it now, press the 
'f' key to flip the polygon and you'll see the normal change to point 
inwards. If you now go and switch Solid View back on you'll see what 
I mean about the polygon turning invisible.

Before you proceed, make sure that you have returned the polygon so 
that it is facing the correct way and that you're back in wireframe 
mode. 

Go to the Polygon menu and choose Texture.



Select the Custom Texture option and then click on the Texture Properties button, choose the 
wagontut.bmp file that you downloaded and used earlier.

Now move the four points so that they are around the side panel part of the texture (basically 
the top half).

If you double click on a point, or click on the 
Edit button, you will be able to type in 
coordinates for that point manually - this can 
make fiddly operations a lot easier.

Before you proceed, make sure all the lines 
are straight or the texture will appear twisted 
or warped. 

Now go back to Solid view by going to the View Menu, its Perspective View submenu and 
ticking the Display As Solid option.



Already things are looking good! Now we have to repeat the process in order to get the other 
side done as well.

Here's a quick bullet point list of instructions - if you need more detail just reread the last few 
paragraphs:

 

●     View Menu / Perspective Mode Submenu / Display as Solid -> to return it to wireframe 
mode. 

●     Navigate to the right polygon using the 'n' and 'p' keys or the next/previous object 
arrows.

●     

●     Polygon Menu / Texture option 



●     Custom Texure 
●     Texture Properties 
●     Choose the wagontut.bmp texture file 
●     Mark the area for the texture by moving the points 
●     Click OK 
●     View Menu / Perspective Mode Submenu / Display as Solid -> to return it to solid view 

mode. 

Navigate around the object and you will be able to confirm that you have correctly textured the 
entire of the main body now, congratulations - it's time to move on to the wheels!

Make sure that you are in Part mode as follows:

Select each Axle box using the 'n' and 'p' keys or the next/previous object buttons and apply the 
following:

 

●     Part Menu / Textures option 
●     For each of the following use the wagontut.bmp you downloaded earlier. 

Front X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Back X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Left X Crop: 272 Y Crop: 388 X Size: 91 Y Size: 59
Right X Crop: 272 Y Crop: 388 X Size: 91 Y Size: 59
Top X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Bottom X Crop: 274 Y Crop: 429 X size: 17 Y Size: 13

Now you have something like:



Repat this process for all four axle boxes. Alternatively you could simply delete the other three 
and use the same Copy/Paste process you did before to replace them all with the new textured 
version.

Finally, it's time for the wheels!

Highlight one of the wheel assemblies using the 'n' and 'p' or next/previous object buttons.

Go to the Part menu and choose Textures. Using wagontut.bmp for each case, apply the 
following:

Front X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Back X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Left X Crop: 296 Y Crop: 455 X Size: 56 Y Size: 56
Right X Crop: 296 Y Crop: 455 X Size: 56 Y Size: 56
Top X Crop: 274 Y Crop: 429 X Size: 17 Y Size: 13
Bottom X Crop: 274 Y Crop: 429 X size: 17 Y Size: 13



Repeat this procedure for the other wheel and you end up with the final model:

Let's just prove we haven't missed anything by going to the Polygon menu and choosing "Find 
Untextured Polygons". This should tell you that there are 0 polygons in 0 parts untextured - 
that is a requirement before export to MS Train Simulator can happen so if anything is 
claiming to be untextured then recheck this tutorial and your work and see if you can correct 
the problem.

In the next section, we're going to see how to export this in to MS Train Simulator, including 
how you actually create all the necessary support files for a Wagon. Click to continue. 



Section 4: Export to MS Train Simulator

In this section we're going to create a new wagon in Microsoft Train Simulator. There are 
numerous files that go to make up a wagon for MSTS, and many of these will be automatically 
created for us by TS Modeler, some of the work, not much however, is still for us to do.

Find your TRAINSET directory - it'll be directly under where ever you installed your copy of 
MS Train Simulator. If you let it go in to the default place then you will find it under 
C:\PROGRAM FILES\MICROSOFT GAMES\TRAIN SIMULATOR\TRAINS.

In the TRAINSET directory you will see many other directories - this is where all of your 
other stock is contained, wagons and locomotives alike. We are going to add the wagon in to 
here so create a new directory in the TRAINSET directory called "UKTSWagon".

The first file you need for any wagon or coach is a .WAG file. This is the definition file for the 
wagon or coach. The easiest way to get one is to copy an existing one and edit the contents to 
suit your wagon or coach. That's what we'll do now.

Copy the file "US2FREIGHTCAR1.WAG" from the US2FREIGHTCAR1 directory into your 
new directory UKTSWagon, this will serve as a suitable starting point for our wagon.
Rename the file US2FREIGHTCAR1.WAG you copied to UKTSWagon.wag .

If you have ever looked at a .ENG file then you'll recognise a .WAG 
file, they are structured identically.

They are in a UNICODE ASCII format. In order to edit them you will 
need a text editor that is capable of understanding UNICODE. In 
Windows 2000 or Windows XP you can use Notepad for this, 
however in Windows 98 you'll need to use Wordpad. 

Where you see the following:



Wagon ( US2Freightcar1  
        comment( Autorack Car ) 
        Type ( Freight )
        WagonShape ( US2Freightcar1.s )
        Size ( 3m 6m 29.0m )
        comment( 39.19t empty, 66.81t full )
        Mass ( 66.81t ) 
        WheelRadius ( 28in/2 )
        InertiaTensor ( Box (3m 6m 29.0m) )

Change it to read as follows (changed bits highlighted in bold):

Wagon ( UKTSWagon
        comment( Tutorial Wagon )
        Type ( Freight )
        WagonShape ( uktswagon.s )
        Size ( 2.43m 3.41m 5.4m )
        comment( 39.19t empty, 66.81t full )
        Mass ( 66.81t ) 
        WheelRadius ( 28in/2 )
        InertiaTensor ( Box (2.4m 3.4m 5.4m) )

If you wish to change the weight of the wagon at this point then feel free to do so by editing 
the area that I have marked in italics.

That's all we have to do manually, TS Modeler can create the remainder of the files for us. 
Return to TS Modeler, go to the File Menu and select Project Properties. Tick the box marked 
"Complex Project", this will ensure that the wheel animation works properly.

Now go back to the File menu and select Create TS Object.

Route should be set to "None - Specify Path".
Object Name should be "UKTSWagon".
Object Class is irrelevant for a wagon.
Object Filename should be set by clicking Specify Path, pointing to your new UKTSWagon 
directory and setting the filename to be "uktswagon.s" and then clicking OK.



You'll know the filename is on the right tracks (no pun intended) if you see something like:

C:\Program Files\Microsoft Games\Train 
Simulator\TRAINS\TRAINSET\UKTSWagon\uktswagon.s

Make sure "simple crash detection" is switched on and tick the "Convert Textures" and 
"Convert to Binary" boxes that are on the right.

When you click Continue, TS Modeler will automatically create and convert the shape file to 
binary. Then it will copy and convert the wagontut.bmp into a wagontut.ace file suitable for 
Train Simulator and it will place all of this in to your new wagon directory. It also creates a 
supplemental Shape Definition file that is required by Train Simulator.

Go in to your UKTSWagon directory using Explorer and verify that you now have:

uktswagon.s The wagon SHAPE file

uktswagon.sd
The supplemental SHAPE 
DEFINITION file

wagontut.ace The TEXTURE file

uktswagon.wag
The WAG file you 
created/edited earlier

That's the export procedure finished - now it's time to create a consist and actually get this 
baby moving! Click to continue. 



Section 5: Testing in Train Simulator

In this final section we are going to create a consist in the Activity Editor and then finally load 
consist (containing our new wagon) in to Train Simulator and give it a go.

What is a Consist?
For those that don't know the term, a Consist is the correct term for a 
complete train. It will generally consist of one or more powered units and 
zero or more unpowered units. Depending on the nature of the train there 
may be other requirements such as the Intercity 125 requiring a Class 43 
Power car at either end of a number of unpowered coaches, or a GWR 
Steam freight that has an 0-6-0 Pannier tank engine at the front, numerous 
coal trucks in the middle and a Guards/Brake van at the end.

There is nothing to stop you creating a consist containing just one unit, be 
that powered or not (though, ofcourse, only powered units are driveable 
within the simulator).

If you are distributing a consist with your unit (a recommended practice as 
it makes it easier for people who use your unit) then try to create realistic 
and "sensible" consists that would have (or could have) existed for that unit 
- it all adds to the realism, which is after all what we're trying to get to 
here! 

In order to use the built-in Consist Editor you will need to have the Train Simulator Editors 
and Tools installed on your system. You must have performed a FULL install when you 
installed Train Simulator to get the Editors and Tools so if you don't have these, update your 
installation before you proceed any further and get those tools installed.

The Consist Editor is hidden away in the depths of the Activity Editor so let's fire up the 
Editors and Tools screen and select the Activity Editor.

From the Activity Editor you should click on the File menu and select Open. At this point it 
doesn't matter what you load so just select EUROPE1, then ACTIVITIES and finally 
aftstorm.act. We're not editing the activity so it doesn't matter what you load nor what route it's 
from.

Now that you have an activity loaded a few of the other options will have become enabled for 
you to select. The one you need is on the right hand side in the middle of the three groups of 



options, called 'Player'. Click on the 'New' button as highlighted in this snapshot:

This brings up the Service Editor. In the section marked 'Consist' you should click on the 
'New' button as, once again, highlighted in this snapshot:



Finally we've made it. Welcome to the Consist Editor.

First, put a name for the consist into the 'Name' and 'Display Name' field - the former shouldnt 
have any special characters in it like colon's (:), the latter can contain anything and is the one 
that will be displayed to the user.

There is a drop-down box on the top that allows you to choose the type of Rolling Stock 
shown in the list below it so pick a locomotive of your choice (if you have any small steam 
locomotives such as an 0-6-0 they would be about right for these wagons, though for the 
purposes of this tutorial you could always go silly and use a DASH9!).

●     Drag and Drop the loco you chose to the larger blue area at the bottom of the Consist 
Editor.

●     Go to Cars (Freight) and drag and drop 'UKTSWagon' after the loco - do this 10 times 
so you have a plenty of wagons.

That's built the train up.

●     If at any time you want to flip the direction of a unit then right-click on it in the blue 
area where the train is being built.

●     If you want to move the cars or loco's around to other places in the consist just drag and 
drop them to the right place.

●     If you want to delete one you should drag and drop it on to the symbol just above the 
left hand side of the blue area underneath the word 'Couplings'. 

  



That's the consist built, click Save & Exit.

You can exit all the way out of the Activity Editor now, don't save any further changes and just 
abort your way out - other than saving the Consist you just made any other changes it reports 
you have made are incorrect so just keep saying no until you finally get out of the Editors and 
Tools.

Now it's time to load it in to Microsoft Train Simulator and see how she looks.

Fire up MSTS and select the Loco that is heading up your train and you should see the consist 
you just created available as one of the options to use within the simulator.



Note 1: If the sizings look odd, you have to keep in mind two things... Firstly, it's an old 
British wagon from the Steam era and secondly that's a rather large American loco we have up 
front - put a British 0-6-0 in front of them and they'll look just fine :)

Note 2: This might seem obvious, but don't be surprised if a loco like the Acela doesn't appear 
on the Settle and Carlisle route. There's a very logical reason for it - power :) The Acela is an 
overhead electric locomotive and the Settle and Carlisle route has no overhead cabling, 
therefore the Acela won't even appear as an available choice. It might seem obvious, but when 
you're this close to seeing your work in action you will often forget the most simple principles 
:) (so says the voice of experience, trust me <grin>).

That's it! You're now ready to make your own wagons now and build up a nice bit of variety!

Now you're probably feeling quite proficient. The next tutorial shows you how to make a 
working locomotive. Now turn to Making a Diesel Engine.

   



Tutorial 3 - Building a Diesel Engine
 

By M. Peddlesden, Copyright &COPY;2001

Introduction

You've done freight, houses and now it's time to get something to pull your freight.

Due to the fact that most diesels have a fair amount of detail we're not going to do a scale 
model, instead we're going to just create something that looks like a diesel (atleast to me at any 
rate!).

The basic shape is loosely based on something like a British Class 37, but only very very 
loosely - for one thing, the class 37 is a triple axle loco and this is a double axle loco!.

The textures are going to be hand drawn in this one and this will provide you with a good 
opportunity to investigate ways in which you can texture up a 3D model when you don't have 
access to photographs that are suitable for the texturing. We'll also go in to quite a lot of detail 
about what cross sections are and how you can use them to make much more advanced shapes.

Tutorial Contents:

●     Section 2: Creating the 3D Model
●     Section 3: Texturing
●     Section 4: Exporting to MSTS
●     Section 5: Testing



Section 2: Creating the 3D Model
 

Before we begin I feel the need to reiterate the single most important instruction that anybody 
using a computer must have drilled in to them. Save Often. Save Regularly. Save, save and 
save again. I won't be saying "right, now save" in this tutorial - I'll leave that up to you, so 
always remember to save regularly!

To start off let's make sure that TSM is set up to use the right units of measurement. Since a 
OO guage model is measured at a scale of 4mm to 1 foot our life will be much simpler if we 
set TSM to use feet instead of meters. Go to the File menu, select Program Prefs and from 
there select Feet as the units of measurement.

Next up, on a smaller and less detailed model like this it's going to be helpful if the grid size 
was just at a simple 1ft size, change this by going to the View menu, select Grid Size and then 
set it to 1 and click OK.

Switch to template mode, and click on Add Points.

We're going to start off by drawing the main body of the loco, it's got flat left and right sides, 
flat bottom and a rounded roof. Remember that you should place the points in a clockwise 
order.

Using the FRONT view, the sides are six feet six inches high, the apex of the roof is eight feet 
and the loco is seven feet wide.

Here's roughly what you should end up with:



Now let's extrude that template by going to the Template Menu and clicking on Extrude. 
Extrude it by 51.6ft and with 10 sections.

Let's have a look at the side view a bit more closely, notice how we now have the extra 
sections that we asked for:



Notice how there are 10 sections but 11 cross sections. It's the cross sections that we will be 
manipulating next.

Put TSM in to Cross Section mode by clicking on the shown icon:

Use the 'n' and 'p' keys or the  arrows to choose each cross section in the same way 
that you would use them to choose a part in Part mode. We want the cross section i've shown 
above as number 1 (the left most).

Looking back at the Front view (bottom left), making sure you are not in Movement mode (all 
three mode buttons should be raised) and lock the X and Z axis as follows:

Note: With Movement Mode NOT selected, 
you can manipulate individual points on the 
cross section.
With Movement Mode selected you move the 
entire cross section at once - hence why we do 
not want movement mode selected, even 
though we are actually moving things.

Drag each point that represents the roof down a little. Note that we're only dragging the points 
for one of the cross sections when we do this. We're aiming to make a nose for our loco.

In the FRONT view, the sides are now four feet six inches high and the apex is six feet high.

Here's what I ended up with:



Here's where some of the magic dust gets sprinkled... Here's the problem we now face. There 
are actually going to be four cross sections that need to look exactly like this one so how do we 
do this? One option might be to choose each cross section and then move the points for each 
one manually. You could do this but then you could also try and race a Trabant in the Indy 500 
too :) TSM provides you with a proper race car so let's use that instead :)

Go to the Cross Section menu and click on "Copy to Template". Now use the 'n' and 'p' keys, 
or the arrow buttons on the toolbar, to move to Cross Section number 2. Go back to the Cross 
Section menu and click on the "Conform to Template" option. Was that easy or what? :)

Repeat this process on the right most two cross sections (numbers 10 and 11) and you should 



end up with something looking a bit like this:

Note: If the Conform to Template option grays 
out, it means that it no longer has the template. 
There are a couple of reasons this can occur 
but to get it back simply navigate back to one 
of the cross sections that is correct, re-do the 
"Copy to Template" and go back to the one 
you want to change.

Let's go back to the left hand side now, switch to Movement Mode and lock X and Y so that 
we can only move in the Z axis.

Select Cross Section number 2. Move it so that it is about 2 ft behind Cross Section 1, as 
shown:

Now move Cross Section number 3 so that it is about 1 ft behind Cross Section number 2, as 
shown:



Repeat this process on the right hand side, moving Cross Sections 9 and 10 and you should end 
up with something like this:



Before we finish the main body off (still the Fuel Tanks to add yet) we're going to get the two 
bogies in. This is because once the bogies are in we can then put the fuel tanks snuggly in 
between them.

We're just going to use a hideously simple method for a bogie, just a simple cube primitive.

Go back to Part mode if you aren't there already:

Create a cube by clicking on the cube icon and entering the following details:



Width: 6.8
Height: 1.54
Length: 13.6

Move it so that it is neatly under the left hand side (ie. Cross Sections 1, 2, 3 and 4). You 
should end up with something like this:

Now go to the Edit menu and select Copy, then go back to the Edit menu and select Paste. 
Switch to Movement mode if you aren't already and lock the X and Y axis so that you can only 
move the part along the length of the loco. Move it so that it's on the other side and you end up 
with this:



Now that the bogies are in we can return to the main body and finish that bit off. Use the 'n' 
and 'p' keys, or the arrow buttons on the toolbar, to re-highlight the main body.

There are a couple of ways we can add these fuel tanks on, one method would be to just add 
one or two cubes suitably shaped underneath the body but an alternative would be to just drop 
the center of the body down - since that would be a new idea to try we'll do it that way!

Return to Cross Section mode.

Move to Cross Section number 4, put TSM in Movement mode and lock X and Y. This will 
allow us to move the Cross Section along the length of the loco. Move it so that it is closer to 



the right hand side of the bogie - but leave room for the bogie to turn a bit.

Now go to Cross Section 5, move it so that it is exactly overlapping Cross Section 4.

Come out of Movement mode so that we can move individual points in the Cross Section and 
then lock just X and Z so that we can move points in the Y axis.

Move the lower two points in the cross section down so that they are level with the base of the 
bogie.

Remember that in Side View there will only 
be one point visible as the other one is directly 
behind it, if you aren't sure, just use the front 
view to move the points down instead

Here's roughly what you should be seeing now:

Select Cross Section 6, bang in the middle, we don't actually need it so let's get rid of this 
Cross Section by pressing the DEL key.

Here's what we are left with:



Notice how i've just labeled the last two as Cross Sections A and B - this is to avoid confusion 
with the numbering now that we've removed a Cross Section.

Select Cross Section B, move it so it's about the same distance from the bogie as you made 
Cross Section 4 on the left hand side. Remember, Movement mode and Lock X and Y axis.

Now move Cross Section A so it overlaps Cross Section B.

Come out of Movement Mode, notice the Locks are cleared. Relock X and Z. In the Front 
view, because it's easier to see both points, move the two bottom points down to be level with 
the base of the bogie - just as we did on the other end of the loco. Here's what it now looks 
like.

DO NOT PANIC if it now looks like this:



The problem (a missing polygon) will be resolved further on in the tutorial.

Now for the wheels. We're going to use one of the helper parts that is supplied with TSM as an 
alternative means of placing the wheels in the right place, called "Rail_Reference.dsp".

Go to the Part Menu and select Load. In the C:\PROGRAM FILES\ABACUS\TS 
MODELER\PROJECTS directory you should find RAIL_REFERENCE.DSP, load it. Move it 
under the loco and to one end under a bogie. The wheels will be 3ft in diameter so leave about 
3.5ft gap between the top of the rail and the bottom of the main body.

If you aren't already in Part mode then click on the appropriate button to get back in to Part 
mode.

Create a Tube with the following parameters:



Radius: 1.5
Length: 0.2
Points per section: 16
Sections: 1
Close Left/Front/Bottom: Yes
Close Right/Top/Back: Yes
Structure along X Axis

Move it in to position elevent feet from the end of the loco and place it on the rails:



Now copy and paste that wheel so you have all four wheels on the first bogie, the second set of 
wheels are three feet in from the end of the loco.
Remember to use Movement Mode and lock axis so that the wheels are all squarely lined up.

Move the rails to the other side of the loco and put the four wheels on there, again 
remembering to lock axis so that everything remains squarely lined up.

Now the wheels are done you can go ahead and delete the RAILS.DSP part that we loaded, we 
don't need it any more. Simply use 'n' and 'p' or the arrow buttons on the toolbar to highlight it 
and press the DEL key to remove it. If you choose not to remove it now then please make sure 
you remove it before you export the loco to MSTS!



Now is as good a time as any to get the model moved up so that it's on the floor properly - 
remember that the "floor" is actually the thicker horizontal line that you can see in the front 
and side views.

Go to the Edit menu and choose Select All. Switch to Movement Mode and lock X and Z, now 
carefully raise the model up until the wheels are sitting on that thick horizontal line 
representing the ground, finally go back to the Edit Menu and choose Unselect All.

Ensuring you are still in Part Mode, use the 'n' and 'p' keys or the arrow buttons to select the 
Main Body. We need to move the axis to ground level - simply go in to movement mode, lock 
the X and Z axis, now hold the shift key down and then act as if you were going to move the 
main body - with the shift key held down you will actually move the axis instead. Move this so 
that it too is on the thick horizontal line representing the ground.

If you rotate the model around a bit you might find that one end is actually open, looking like 
this:

Notice how you can see the inside of the loco because there is a polygon missing!

If you don't have this problem then just read through it as the ideas of making a new polygon 
from a set of points will be useful to know - and this problem might itself show up to you in 
the future.

Here's how we fix it. First, make sure that the nose with the missing polygon is the one that's 



facing you and then go to the View window, then in to the Perspective View sub menu and 
finally deselect Display as Solid.

Go in to Point mode as follows:

In Point mode the 'n' and 'p' keys, or the arrow 
buttons on the toolbar, will iterate through 
each and every point on the part you were 
selected to before entering Point mode, 
irrespective of which cross section they might 
belong to.

This bit is going to get a little bit tricky, atleast until you've done it once or twice and become 
familiar with how it all works. Use the 'n' and 'p' keys (or the arrow buttons) to find the bottom 
left point on the bit of the nose that is missing (if necessary return to Solid mode to refresh 
your memory about where that is).

Here's the point selected as a white dot in the Perspective View (top right):

Press SPACE to select that point, it should go green. Do this for all of the points around the 
nose section:



Note: Select the points in clockwise order and 
make sure you select them in order otherwise 
the polygon will be created in a slightly odd 
manner. Don't worry, if it turns out wrong you 
can delete the polygon and try again.

Now go to the Polygon menu and choose "Make Polygon from Selected Points". This will 
create a polygon and then put you in Polygon mode. Here's what it did for my model:



In my case you can see that the normal is inwards - the polygon is facing inwards. Press the 'f' 
key to flip the polygon and then you can see the normal is now facing the correct way, ie. 
outwards:



The direction in which you place the points is what determines the final direction of the 
polygon. So in my case if I'd done them in Anti-Clockwise order then the polygon would have 
come out with the Normal facing in the right direction in the first place.

Finally go back to the View Menu, the Perspective View sub menu and then select Display as 
Solid and verify that your model is now fully solid with no missing polygons:

The last thing we're going to add to our model will be some buffers. According to the Project 
Statistics we are only at around 720 polygons in MSTS so we have plenty of polygon budget 
for adding some nice buffers in.

We are going to use a cube and three tubes to create our buffers. I'm going to give you the 
specifications of each of the primitives first and then a screenshot showing you how they 
should be lined up - and let you actually do it for yourself.

Cube
Width = 0.8
Height = 0.6
Depth = 0.2



Tube 1
Radius = 0.28
Length = 0.6
Parts per Section = 6
Sections = 1
Along Z Axis
Close Both Ends

Tube 2
Radius = 0.2
Length = 0.6
Parts per Section = 6
Sections = 1
Along Z Axis
Close Both Ends

Tube 3
Radius = 0.35
Length = 0.2
Parts per Section = 8
Sections = 3
Along Z Axis
Close Both Ends

Here's what you should line them up to look like:



It may not be too obvious from these screenshots, but Tube1 butts up to the Cube, Tube2 is 
embedded in to Tube 1 by about 35% of its length and Tube3 butts up to Tube1. Zoom in 
closer to make sure that they are as close as possible to each other.

Select Tube 3 using the 'n' and 'p' keys (or the arrow buttons), put TSM in to Scale mode and 
lock X and Z as follows:

Slowly move the mouse with the button pressed (much like if you were going to move in 
movement mode) to squash the tube. As we have X locked it won't move - only Y will move 
and hence it becomes more squashed as you move it. Here's what I ended up with after a slight 
amount of scaling:



Now we get to do the last bit, shaping the buffer stop (Tube 3) so it's a bit more rounded.

Remember how we made Tube 3 so that it had 3 sections? Select Tube 3 if it isn't already, 
select Cross Section Mode, Scale Mode and lock only the Z axis. We want the scale operation 
to affect both the X and Y axis so that we evenly scale it down. The effect we're trying to 
achieve is to round the end off a bit like a drawing pin.

We need to scale down Sections 2, 3 and 4 progressively smaller to achieve the desired effect.

Use the 'n' and 'p' keys (or the arrow buttons) to select each one and then scale it down in size 
so that you achieve something like this:



Next we have to join all the buffer parts together to make a single part so that we can place it 
in the three other corners. Go back to Part mode and then use the 'n' and 'p' keys (or the arrow 
buttons) to select each part out of the Cube and three Tubes, press SPACE on each one to 
select it until you have something like this - notice how Tube2 is embedded in Tube1 as we 
mentioned earlier in the tutorial.

Press the 'j' key to Join the selected parts together.



Now go to the Edit Menu and choose copy. Return to the Edit Menu and choose Paste.

Go to Movement Mode and lock the Y and Z axis, carefully move the new buffer to the other 
side so it's balanced with the first one you made, you should have something like this now:

One again, Copy/Paste the buffer part, go to Movement Mode if you aren't already and lock X 
and Y this time. Move it to the other side of the loco and spot the obvious problem:

The answer my friend is blowing in the, uhm, menu's! Go to the Transform menu and select 



Rotate. Set Y to 180 degrees and click OK - now carefully move the buffer back so it joins 
neatly up with the end of the loco. Repeat the process for duplicating the buffer on to the other 
side (Copy/Paste, lock Y and Z and move the new buffer part) and you should finally end up 
with something like this:

That's it for the 3D model, now we're going to investigate ways of texturing it. The trick is, we 
don't have any photographic sources from which to work so we're going to use some more 
facilities in TSM to help us create an entirely fictional one!

Now let's go to the texturing. 



Section 3: Texturing
 

Before we begin I should let you know that this isn't going to be a walk in the park. We're 
going to learn how to use a lot of the more powerful features in TS Modeler in order to help us 
get our model textured. With that warning in mind, you can be happy in the knowledge that the 
skills you learn here will be basically all you need to do more complex scale models of loco's 
that actually exist.

Again I must re-iterate that you should save everything regularly, in fact before you proceed to 
some of the more radical steps in this document I would recommend making a backup copy 
somewhere safe just incase you get unstuck and want to go back to where you were last 
comfortable.

Remember that our loco is completely fictional. This means that we have no models to 
photograph, no real loco's to photograph and no scale drawings on which to base our textures. 
Thankfully TSM can come to the rescue and give us a bit of a head start here!

I use JASC Paintshop Pro 7 for my texturing, though in theory any fairly simple drawing 
application that copes with BMP files will do just fine for this tutorial.

In Part mode, use the 'n' and 'p' keys (or the arrow buttons) to highlight the main body part. Go 
to the Part menu and select Make Texture Template. Choose 512x512 as the size and then 
choose Front. Save the file out as front.bmp and you get a kick start for the front of the loco:

Repeat this process for the Left (into left.bmp) and top (into top.bmp) templates, remembering 



to check and set the size to 512x512 for each one if necessary. We won't necessarily be using 
them at the size that we create here but it's always better to reduce images than to try and 
enlarge them. You should have three BMP files now, the one above and these two new ones:

 

Now that we have something to start from, let's get the actual texture file made. Create a new 
blank, white image that is 512x512 pixels in size and 32 bit colour depth. Remember to save 
this file regularly as we proceed through the tutorial - it should be saved as a BMP file. Copy 
and Paste the left texture into the new texture map twice (one below the other), these will form 
the two sides. Here's how it should look:

Now, do the same for the top - but before you paste it in, rotate it 90 degrees to the right first. 
Remember that we rotated this texture as we'll need to tell TS Modeler about that later on. For 



now though, you should end up with something like this:

Next, measure how much space (height) there is between the bottom of the "top" texture you 
just put in and the bottom of the image. On my texture there is about 220 pixels, so let's resize 
the cut out portion of the front texture so that it is 220 pixels high. In PSP 7 you can set a 
"Maintain Aspect Ratio" option and this will force the width to the correct value so that 
everything is reduced properly.



That's the main body textures in place. Let's do some adjustments to them next. The windows 
are going to be in the "top" texture (which is the third one down if you recall, the one you 
rotated) so we don't need them to be in the "front" texture. Carefully remove the window area 
from the "front" texture.

Note: While putting the windows in the top 
texture doesn't give as much flexibility or 
control as putting them on the front texture, it 
does make the job a bit simpler and you'll be 
glad we went with the more simple option in 
just a few minutes :)

Also, the bottom bit of the front texture that actually represents the front of the fuel tanks can 
go as well, they'll be done separately. Remove the window area and this bottom bit and you 
should end up with something like this:

Now we need to clean up the side textures. The top view is going to provide all of the texturing 
for the roof, if you look at the side textures you can see clearly they are trying to provide 
texturing for the roof as well so we need to put a stop to that. Remove the roof segments from 
both side views and you should end up with something like this:



Finally we need to remove all the extraneous lines and add the horizontal bar across the top of 
the fuel tanks. Also, don't forget to leave the window area lines in, they'll help you later on :)

As well as the main body we must of course consider all the other parts of the loco, including:

 

●     Wheels (we'll just use a circle) 



●     Front/Back of Fuel Tanks (we'll use a darkish grey colour) 
●     Underside (we'll use a darkish grey colour) 
●     Bogies (Sides will be drawn, the rest will be a darkish grey colour) 
●     Buffers (Simply a grey colour) 

Here's what I ended up with after adding a bunch of new colour areas to the texture map:

We are now ready to try a test texturing of the loco to see how we're doing.

 

1.  All Poly's should be textured and lined up neatly when we're done, with no warping. 
2.  Make sure we have all the necessary bits in the texture map. 

We'll do the text texturing before we expend any serious artistic effort on the textures - it's 
much better to find template errors now than after five hours of hard graft on the textures. All 
we need to do is verify that everything gets covered correctly within TSM.

Return to TS Modeler and if necessary reload in your model. I'd suggest now is a good time to 
make a backup copy of your model to return to - but you did that anyway, right? :)

Go to the View Menu, select Perspective View and then turn Display as Solid off.



What we have to do next is make sure that ALL of the polygons in our model are outward 
facing.

We do this in the following order:
Click on the PART Mode icon

Select the part you want to check using the 'n' key or 'p' key Now click on the POLYGON 
Mode icon

Using the 'n' key, cycle through ALL the polygons for that part checking that the NORMAL 
(The little white line) is OUTWARD pointing. If it isn't then press the 'f' key to flip it the right 
way round.

Once you have completed a part, repeat the sequence for each part until ALL parts have been 
checked.

Items to particularly watch for reversed polygons are the buffers and the wheels (remember 
you copied and pasted these round the model) and where the cross sections of the main body 
were joined.

Go to the View Menu, select Perspective View and re-select Display as Solid.

Ensure you are in Part Mode and have the Main Body part selected. Remember that when we 
put the TOP texture in to the texture map, we had to rotate it 90 degrees to the right? In order 
to correctly place the top texture on to the model we must do the same to the model. We are 
going to rotate the main body, apply the texture and then rotate it back to where it should be.

Go to the Transform menu, select Rotate. Set Y to be 90 degrees and click OK.

Now go to the Part menu, select Textures and where it says "Top" click on Browse. Find our 
texture on your hard drive and mark out the top area on it in the next screen. Remember that 
the top is the third big horizontal section in the texture map.

Now rotate it back to where it should be (Transform menu, click Rotate and set Y to -90 



degrees).

Notice that you can see the thicker black lines from the texture on the roof, given that it all 
lines up pretty much perfectly we know that the top texture atleast is correct.

For the front and back we just have a single polygon to texture. If we were the use the 
Part/Textures menu then we would also re-texture the window of the cab, so we won't do that. 
You may want to go back to wireframe (non-solid) mode to do this next step, i'll leave that 
decision to you.

Ensuring that the main body is still highlighted, go to Polygon mode and use 'n' and 'p' or the 
arrow buttons to find one of the end polygons.

Go to the Polygon menu, choose Texture, set it to Custom Texture and then click on Texture 
Properties. Find your texture and you will see a screen that looks like this:



I've highlighted all of the original positions with Red Arrows and numbers, and where they 
need to be moved to by Blue Arrows and letters. Move point 1 to point A, point 2 to point B 
and so forth until the polygon is properly covering the area we set aside for the front. Try and 
keep things as straight and accurate as possible as this will help make sure there are no 
warping or bending effects in the texture when we actually put something sensible on it.

Repeat this process for the other end. I haven't put a screenshot of what this looks like in the 
3D view because as you will soon see - it doesn't look very different at all, we just put a white 
texture on to a white 3D object :) No matter though, we'll soon put something sensible on the 
end texture and you'll see it then.

Left and Right sides get to be considerably more involved than anything we've covered before 
due to overlapping areas - ie. if you part/texture the left you will also over-write the left hand 
side of the roof as well.

This gives us a prime opportunity to investigate some other commands in TSM. The Split 
operation is the key to our dilemma. You select a bunch of polygons within a part, issue the 
split command and TSM will turn that part in to two parts - one with all the polygons you 
selected and the other with what was left.



Now is a very good point to make sure we're all saved up and an even better point to make 
another backup of our work just incase you get unstuck and want to return back here to try 
again.

Go to the View Menu, select Perspective View and then turn Display as Solid off.

Select PART Mode

Using the 'n' key or 'p' key, cycle through the parts until you have the main body selected

Select POLYGON Mode

Cycle through all the polygons and select ALL the parts for ONE side using the space bar.

Go to the Part Menu and select Split Part. Notice how the rest of the part has gone to the darker 
blue colour indicating that the part isn't even highlighted anymore - yet your side polygons are 
still highlighted. That's because they are in their own part now.

Whilst we have the NEW part selected, make sure the MORMAL is outward pointing, if not 
use the 'f' key to flip it so it is outward pointing.



Go back to Part Mode and use 'n' and 'p' or the arrow buttons to go through the various parts in 
the project and satisfy yourself that we have indeed created a new Part out of polygons from 
the main one.

Repeat the same procedure for the polygons on the other side, splitting them off in to their own 
part.

We could have textured each polygon in each side individually but it would have made our 
lives very much more complex than this. We can now use the Part/Texture fuction to texture 
the sides without damaging any of the other areas of the loco - and of course this means that 
the texture we choose will automatically be spread across all of the polygons. If we did the 
polygon texturing manually then we'd have to make sure that all the polygons "knitted" 
correctly along the length of the texture and that would just be a very labour intensive job.

Now it's time to texture the sides!

Choose one of the new side parts using Part Mode and the 'n' and 'p' keys or the arrow buttons. 
Go to the Part Menu, Textures and see the diagram below for some help on what to texture:



What this is telling you is that when the leftmost side is selected on the Front view you should 
texture the Right hand side of it. When the rightmost side is selected, texture the Leftmost side 
of it.

So, depending on which side you selected you can now just texture the correct side.

It's going to be hard to see for sure that this texture is correctly placed but here are some areas 
to look for on the side of your 3D model:



If you can see the horizontal line across the fuel tanks then your height is all correct.
If you can see the window markings fairly neatly across the edges of the side then the widths 
are correct as well.

If you don't see anything then chances are your model is different to mine - reverse the above 
instructions and texture the left side of the left texture, and see if that gets them visible.

We have only got one bit of the main body left to texture before we can say goodbye to all this 
hard work!

With the Main Body selected, go to Polygon mode. It will help us a great deal to be in 
Wireframe mode so go to the View menu, select Perspective View and then switch Display as 
Solid off.

Use the 'n' and 'p' keys or the arrow buttons to iterate through all the polygons (notice how the 
side ones don't get highlighted anymore? Remember, they are in a different part!). As you 
highlight the polygons, you're looking for any polygon that's on the underside, when you get to 
one, press SPACE to select it.

Go to the Part Menu and choose Split. Now go back to the Part Menu, go to Textures, we're 
texturing the bottom of this texture - just choose a darker area of the texture. I used the 
following area:



Once again, we could have textured it polygon by polygon. Indeed, given that there is no 
pattern to worry about it would be more practical to do so than it was on the sides. It would 
still have been a fairly lengthy process however - much more so than splitting the part out and 
using the more automated method for texturing. I also found that when I textured the bottom 
just on the main part, there were some hard to spot undesirable bleed effects - if in any doubt, 
always split the polys out to their own part and texture them. It's very much like using Masking 
Tape to protect all the other areas of the part when you spray paint something.

That's the main body finished!

The rest should be very trivial by comparison. Let's start with the bogies.

Go to Part Mode and navigate to a bogie part with the 'n' and 'p' keys or the arrow buttons. Go 
back to the Part Menu and select Textures. In the texture map shown below, i've highlighted 
what areas I used where on the bogie texturing - the exact coordinates are of course going to 



differ for your own version.

Repeat this for the other bogie.

The area that we textured left/right is seperate because it means we can later on add more 



detail to the side of the bogies. They are quite visible and look a bit odd if there is no detail to 
be seen. We won't be adding this detail in this tutorial however, that is left as an exercise for 
your texturing skills later on.

Now for the wheels.

Here's the texture map again, this time showing what I used to texture the wheels:

once you've done one wheel, you can then texture the rest either by just repeating this process 
or by deleting the remaining wheels and then referring back to Section 1 (building the 3D 
model) and copy/paste the rest of the wheels back in. It's entirely up to you and what you feel 
is the easiest method.

So with all the wheels textured we now have this:



We only have the buffers left to do now. We're going to do these very simply as well - you 
could split the front of the buffer out to put a more detailed texture on it but for our purposes 
let's just keep it simple for now.

Here are is texture map once again showing which areas I used for the buffers:



Just as with the wheels, once you've done one buffer you can then either go through and 
texture each buffer just the same or you can delete the other buffers and copy/paste them back 
in again as you did originally.

Let's see how the model is looking.

Go to the Polygon menu and select Find Untextured Polygons.

If it says 0 untextured polygons in 0 parts then you have finished texturing successfully.

When I did it in my model however it didn't say this, I had errored in one of the above 
procedures and it now declared something like 8 of my polygons weren't textured:



Since it forms a useful exercise to understand what to do when this happens it would be worth 
a read of this section even if your loco is now fully textured.

You can see exactly why polygons are untextured as follows:

When you do the "Find Untextured Polygons" command, if any parts have untextured 
polygons it will select them (the parts). In Part Mode, navigate to one of the selected Parts and 
then switch to Polygon mode. This will now switch to showing you the selected polygons 
inside that part - and in this case, they're all the untextured ones.

What you must do is decide how to fix the problem for each polygon in each part. Perhaps you 
can see a Normal that is the wrong way so you can then re-texture the top of the part again or 
manually retexture the polygons individually if that's more appropriate. The last option is the 
more appropriate for my particular condition because it has the knock-on benefit of lowering 
the polygon count. They're insanely small polygons, so small that, well, nobody is going to 
miss them. I press the DEL key and they're history.

A quick recheck of the untextured count and sure enough, 0 untextured polygons in 0 parts.

We're finally all textured up! Now is a good time to go and spend a little time on that texture 
map now, put some colour in it and start to make this thing look a bit more like a loco.



Back up your existing texture map to a different filename so that you have a place to return to 
(you could even give this original map out to other people that want to retexture your loco as it 
gives them a nice clean place from which to start).

Using the original copy of the texture file, add some colour.

My first cut of the texture looked like this:



You'll probably notice that i've actually 
"coloured outside the lines". This is to prevent 
a problem when you get the loco in to 
TrainSim. What sometimes happens in 
TrainSim is that when the loco is at a distance 
you can see lots of white bleeding on to your 
textures. This is due to a process called MIP 
MAPPING, used by TrainSim to blur the 
textures when they are further away (this 
improves performance).

The problem is that this blurring is done as an 
average of surrounding pixels - and on the 
edges this will take in to account ones outside 
of the boundary you selected in TSM, if they 
happen to be white then you're going to see 
things get very white at a distance.

The fix is simply to take the colour at the 
edges of each area in your texture map and 
extend it out a few pixels, it doesn't have to be 
accurate, and then when it averages across 
surrounding pixels it will still find pixels of 
the right colour. 

In TS Modeler the loco now looks like this:



Once again now is a great time to make sure we're all saved and make a backup. We're going 
to recombine all the parts down to a simple collection of parts ready for export to TrainSim 
and you can't go back once you join parts together.

In Part Mode, highlight and select (press SPACE) each of the buffers, the two side parts, the 
underside part and the main part and press the 'j' key to join them. Now press F2 and set this 
parts name to "MAIN" and leave its parent empty.

Go to each bogie and press F2, use the Train Names button to name each bogie. One of them 
should be BOGIE1 and the other should be BOGIE2. Each of them should have MAIN set as 
its parent part. This configuration will ensure that the bogies turn on the track - no further 
action is required from you to get this effect.

Now we are going to go to each wheel - they need to be joined in pairs. Once you have joined 
them together, name the pairs using Train Names. Here's how they should be named and 
joined together:



Remember, use F2 for each Part (which should consist of two wheels each) and use Train 
Names to set the name. Set the parent to point to the bogie they are part of (WHEELS11 
parented by BOGIE1, WHEELS21 parented by BOGIE2 etc).

The act of naming the parts WHEELS11, WHEELS12 and so forth is what will make them go 
round automatically in TrainSim - they will also follow the bogie they are parented by as it 
turns. No further effort is required from you to do this animation.

With everything named and parented correctly you're now ready to bring the loco in to MSTS 
and see how it looks - that's next!

For reference purposes, I have included two textures - the template and the coloured in one that 
I used.

Both of these are in your mian TSModeler \Textures folder:

●     dieseltesttex1.bmp - Blank Template Texture (512x512 BMP) 
●     dieseltesttex2.bmp - Coloured Template Texture (512x512 BMP) 



Continue now with Exporting to MSTS



Section 4: Exporting to MSTS
 

We're going to make our loco drive like the stock Dash 9 that came with your TrainSim. If you wish to go and tweak some of 
the settings such as weight, power and so forth to make a truly unique locomotive please feel free to do so. We will only be 
covering the minimum to get the loco in to TrainSim and working however.

We're also going to cover a topic called Aliasing. This allows you to create a locomotive that uses the cab and sounds from an 
existing loco but means you won't have to waste disk space copying them.

Find your TRAINSET directory - it'll be directly under where ever you installed your copy of MS Train Simulator. If you let it 
go in to the default place then you will find it under C:\PROGRAM FILES\MICROSOFT GAMES\TRAIN 
SIMULATOR\TRAINS.

In the TRAINSET directory you will see many other directories - this is where all of your other stock is contained, wagons and 
locomotives alike. We are going to add the loco in to here so create a new directory in the TRAINSET directory called 
"UKTSLoco".

The first file you need for any loco is a .ENG file. This is the definition file for the loco that contains all its physical parameters 
(mass, power, fuel capacity etc).

The easiest way to get one is to copy an existing one and edit the contents to suit your new loco. That's what we'll do now.

Copy the file "DASH9.ENG" from the DASH9 directory into your new directory UKTSLoco, this will serve as a suitable 
starting point for our loco.
Rename the file that you copied (DASH9.ENG) to UKTSLOCO.ENG .

If you have ever looked at a .WAG file then you'll recognise a .ENG file, they are structured 
identically.

They are in a UNICODE ASCII format. In order to edit them you will need a text editor that is 
capable of understanding UNICODE. In Windows 2000 or Windows XP you can use Notepad 
for this, however in Windows 98 you'll need to use Wordpad. 

Where you see the following:

Wagon ( Dash9  
        comment(Dash 9-44CW)
        Type ( Engine )
        WagonShape ( dash9.s )
        
        comment( real: 10ft+3in 15ft+5in 73ft+2in )
        Size ( 3.594m 4.431m 21.8m )  
        comment( 420k lb is the maximum )
        Mass ( 155t )
        WheelRadius ( 42in/2 )
        InertiaTensor ( Box ( 3.594m 4.431m 21.8m ) )

Change it to read as follows (changed bits highlighted in bold):



Wagon ( UKTSLoco  
        comment(UKTS Test Loco)
        Type ( Engine )
        WagonShape ( uktsloco.s )
        
        Size ( 2.133m 3.505m 16.7m )  
        comment( 420k lb is the maximum )
        Mass ( 155t )
        WheelRadius ( 42in/2 )
        InertiaTensor ( Box ( 2.2m 3.6m 16.8m ) )

Next, find this bit:

Engine ( Dash9

        Effects
        (

Change it to read as follows (changed bits highlighted in bold):

Engine ( UKTSLoco

        Effects
        (

Still going through the file, look for this block:

        Wagon ( Dash9 )
        Type ( Diesel )
        MaxPower ( 3263kW )
        MaxForce ( 650.65kN )
        MaxContinuousForce ( 550kN )
        RunUpTimeToMaxForce ( 30.0 )
        comment( thats the usable one, full capacity is 5300gal )
        MaxDieselLevel( 4720gal ) 
        MaxVelocity ( 74mph )
        MaxCurrent ( 1800A )
        comment( )
        comment( air gauge graph: 40-120psi)
        WheelRadius ( 21in )
        comment( sanding system is switched off when faster than given velocity )
        Sanding ( 6mph )
        NumWheels ( 1 )
        MaxTemperature ( 120 )
        MaxOilPressure ( 90 )

Change it to read as follows (changed bits highlighted in bold):



        Wagon ( UKTSLoco )
        Type ( Diesel )
        MaxPower ( 3263kW )
        MaxForce ( 650.65kN )
        MaxContinuousForce ( 550kN )
        RunUpTimeToMaxForce ( 30.0 )
        comment( thats the usable one, full capacity is 5300gal )
        MaxDieselLevel( 4720gal ) 
        MaxVelocity ( 74mph )
        MaxCurrent ( 1800A )
        comment( )
        comment( air gauge graph: 40-120psi)
        WheelRadius ( 21in )
        comment( sanding system is switched off when faster than given velocity )
        Sanding ( 6mph )
        NumWheels ( 1 )
        MaxTemperature ( 120 )
        MaxOilPressure ( 90 )

I've also highlighted in Italics where you might want to change some of the more obvious physical parameters of the loco.

Next up, we need to tell it where to find the cab view and sounds. Find the following three lines (they aren't in the same place) 
and change them to what is shown - and yes, there are indeed two dots followed by two backslashes in each case!):

Sound ( "D9Eng.sms" ) Sound ( "..\\..\\DASH9\\SOUND\\D9Eng.sms" )
Sound ( "d9cab.sms" ) Sound ( "..\\..\\DASH9\\SOUND\\d9cab.sms" )
CabView ( dash9.cvf ) CabView ( uktsloco.cvf )

Now we need to make a CABVIEW directory. Create it under your new UKTSLoco directory. In to it we need to copy the 
Dash 9 cab so we can make a couple of alterations. Go to the DASH9 directory (underneath TRAINSET), go in to the 
CABVIEW directory and just copy the DASH9.CVF file over to your new CABVIEW directory.

Rename your copy of the file to UKTSLOCO.CVF (we just referenced it in the ENG file if you recall....) .

Load it in to your favourite editor, again just like ENG files your editor must be capable of dealing with Unicode files - but if 
you can edit the ENG file then you can edit this one.

Everywhere in this file that it refers to an ACE file you need to tell it to get it from the DASH9 CABVIEW directory. Here is 
the before and after for the first few lines of the file and then you can repeat this process throughout the whole of the file:

Tr_CabViewFile (
        CabViewType ( 2 )
        CabViewFile ( Dash9Frnt.ace )
        CabViewWindow ( 0 0 631 221 )
        CabViewWindowFile ( AcWndFrn.ace )

Change it to read as follows (changed bits highlighted in bold):



Tr_CabViewFile (
        CabViewType ( 2 )
        CabViewFile ( ..\\..\\dash9\\cabview\\Dash9Frnt.ace )
        CabViewWindow ( 0 0 631 221 )
        CabViewWindowFile ( ..\\..\\dash9\\cabview\\AcWndFrn.ace )

Go the rest of the CVF file adding in the extra paths (as shown in bold above) to all of the texture references, this saves us from 
having to copy all of the textures in to our cabview directory!

Finally let's name our loco and give it a very brief description. Back in the ENG file...

        Name ( "Dash 9" )
        Description (
        "The GE-9-44CW (commonly called 'the Dash 9'), a modern diesel-electric 
locomotive, most effective "+
        "pulling loads over long stretches at moderate speeds.\n\n"+
        "Locomotive type: Diesel-Electric\n\n"+
        "Power: 4,400 hp\n\n"+
        "Max. speed: 74 mph (119 km/h)\n\n"+
        "Gear ratio: 83:20\n\n"+
        "Power source: Diesel engine\n\n"+
        "Alternator: GMG 197\n\n"+
        "Traction motors: Six GE752AH DC electric motors\n\n"+
        "Max. starting tractive effort: 142,000 lb (64,410 kg)\n\n"+
        "Max. continuous tractive effort: 105,640 lb (47,917 kg)\n\n"+
        "Wheel configuration: Twelve 42-inch (16.5 cm) diameter in C-C configuration 
(two sets of three "+
        "driven axles)\n\n"+
        "Height: 15 ft. 5 in. (4.70 m)\n\n"+
        "Width: 10 ft. 3 in. (3.12 m)\n\n"+
        "Length: 73 ft. 2 in. (22.25 m)\n\n"+
        "Weight: 210 U.S. tons (190.5 metric tons)"     
        )

Change it to read as follows (changed bits highlighted in bold):

        Name ( "UKTSLoco - TSMFreight 257001" )
        Description (
        "This is an fictional locomotive that is very loosely based on the British 
Rail (UK) Class 37" +
        "or Class 40 locomotives.  It was completed as a tutorial exercise and should 
not be taken" +
        "too seriously!\n\n" )
        )



IMPORTANT NOTE: You MUST have a space before the '+' 
in the description. As pedantic as this sounds, if you do not put 
the space in there it doesn't work. Eg:

"fred"+ (This is wrong)
"fred" + (This is right) 

That's all we have to do manually, TS Modeler can create the remainder of the files for us. Return to TS Modeler, go to the File 
Menu and select Project Properties. Tick the box marked "Complex Project", this will ensure that the wheel animation works 
properly.

Now go back to the File menu and select Create TS Object.

Route should be set to "None - Specify Path".
Object Name should be "UKTSLoco".
Object Class is irrelevant for a loco.
Object Filename should be set by clicking Specify Path, pointing to your new UKTSLoco directory and setting the filename to 
be "uktsloco.s" and then clicking OK.

You'll know the filename is on the right tracks (no pun intended) if you see something like:

C:\Program Files\Microsoft Games\Train Simulator\TRAINS\TRAINSET\UKTSLoco\uktsloco.s

Make sure "simple crash detection" is switched on and tick the "Convert Textures" and "Convert to Binary" boxes that are on 
the right.

When you click Continue, TS Modeler will automatically create and convert the shape file to binary. Then it will copy and 
convert the wagontut.bmp into a wagontut.ace file suitable for Train Simulator and it will place all of this in to your new wagon 
directory. It also creates a supplemental Shape Definition file that is required by Train Simulator.

Go in to your UKTSWagon directory using Explorer and verify that you now have:

uktsloco.s The wagon SHAPE file

uktsloco.sd
The supplemental SHAPE 
DEFINITION file

texture.ace
The TEXTURE file - this will be 
whatever you called it

uktsloco.eng
The ENG file you created/edited 
earlier

cabview directory
Just contains the uktsloco.cvf 
file

That's the export procedure finished - now it's time to create a consist and actually get this baby moving!

OK. We're ready for Testing



Section 5: Testing
 

In this final section we are going to create a consist in the Activity Editor and then finally load 
consist (containing our new wagon) in to Train Simulator and give it a go.

What is a Consist?
For those that don't know the term, a Consist is the correct term for a 
complete train. It will generally consist of one or more powered units and 
zero or more unpowered units. Depending on the nature of the train there 
may be other requirements such as the Intercity 125 requiring a Class 43 
Power car at either end of a number of unpowered coaches, or a GWR 
Steam freight that has an 0-6-0 Pannier tank engine at the front, numerous 
coal trucks in the middle and a Guards/Brake van at the end.

There is nothing to stop you creating a consist containing just one unit, be 
that powered or not (though, ofcourse, only powered units are driveable 
within the simulator).

If you are distributing a consist with your unit (a recommended practice as 
it makes it easier for people who use your unit) then try to create realistic 
and "sensible" consists that would have (or could have) existed for that unit 
- it all adds to the realism, which is after all what we're trying to get to 
here! 

In order to use the built-in Consist Editor you will need to have the Train Simulator Editors 
and Tools installed on your system. You must have performed a FULL install when you 
installed Train Simulator to get the Editors and Tools so if you don't have these, update your 
installation before you proceed any further and get those tools installed.

The Consist Editor is hidden away in the depths of the Activity Editor so let's fire up the 
Editors and Tools screen and select the Activity Editor.

From the Activity Editor you should click on the File menu and select Open. At this point it 
doesn't matter what you load so just select EUROPE1, then ACTIVITIES and finally 
aftstorm.act. We're not editing the activity so it doesn't matter what you load nor what route it's 
from.



Now that you have an activity loaded a few of the other options will have become enabled for 
you to select. The one you need is on the right hand side in the middle of the three groups of 
options, called 'Player'. Click on the 'New' button as highlighted in this snapshot:

This brings up the Service Editor. In the section marked 'Consist' you should click on the 
'New' button as, once again, highlighted in this snapshot:



Finally we've made it. Welcome to the Consist Editor.

First, put a name for the consist into the 'Name' and 'Display Name' field - the former shouldnt 
have any special characters in it like colon's (:), the latter can contain anything and is the one 
that will be displayed to the user.

There is a drop-down box on the top that allows you to choose the type of Rolling Stock 
shown in the list below it so go to the Diesel Locomotives section and scroll until you find 
your new UKTSLoco.

●     Drag and Drop the loco to the larger blue area at the bottom of the Consist Editor.
●     Go to Cars (Freight) and drag and drop about ten wagons behind it

That's built the train up.

●     If at any time you want to flip the direction of a unit then right-click on it in the blue 
area where the train is being built.

●     If you want to move the cars or loco's around to other places in the consist just drag and 
drop them to the right place.

●     If you want to delete one you should drag and drop it on to the symbol just above the 
left hand side of the blue area underneath the word 'Couplings'. 

  



Here i've used the wagons from a previous tutorial to go behind our new loco.

That's the consist built, click Save & Exit.

You can exit all the way out of the Activity Editor now, don't save any further changes and just 
abort your way out - other than saving the Consist you just made any other changes it reports 
you have made are incorrect so just keep saying no until you finally get out of the Editors and 
Tools.

Now it's time to load it in to Microsoft Train Simulator and see how she looks.

Fire up MSTS and select your UKTSLoco from the drop down list and you should see the 
consist you just created available as one of the options to use within the simulator.



That's it! Try making your own locos now, perhaps spend some time on the textures for this 
one or go for a model of a real loco and see how you get on.

This concludes the exercises. If you'd like to go on to the Design Workshop that explains 
various features of Train Sim Modeler, turn to Hiding Selected Items. 



Hiding Items in a Complex Project
 

Many of the object that you create will be simple ones with a only a few parts. 
However, when you start to make a complex object you may find that working can 
become difficult, especially if you are trying to edit a small part that in is the middle of 
a group of other parts that obscure what the one you'd like to edit.

Train Sim Modeler provides the following features within the Edit and View menus to 
help manage this problem.

●     View | Show Current Part Only
Hides all parts except for the current part.

●     View | Hide Reference Parts
Hides all parts specified as a reference part.

A reference part is one that is often used as a placeholder. For example, you 
can make a "ground platform" reference on which to position an aircraft tire. 
The reference part is not part of the visible model, but is a design aid for 
precise placement. To make any part into a reference part Edit | Part Property 
dialog and check the 'Reference Part only' checkbox.

●     Edit | Hide Selected
Hides all items that are currently selected. This is extremely useful for 
narrowing down the number of parts or points you have to deal with when you 
are trying to select a certain point from all the rest.

●     Edit | Unhide All
Unhides (redisplays) all items that are hidden. 

Hiding selected items applies to part and vertices. This can be extremely useful when 
you need to select a few isolated points on a complex object. Suppose you want to 
select for points in the front of a sphere. This can be difficult to do with the select drag 
box, because you get the points in front, as well as the points in front if you drag a box 
in the front view. However, if you first drag a selection box that encompasses all the 
points in the back of the sphere, then select the Edit | Hide Selected command, the 
entire back of the sphere is temporarily removed from view. You can now safely drag 
your selection box in the front view without worrying whether or not you’ll accidentally 
pick points in the back of the part.



Continue with Selecting Items   



Selecting Items
 

Selecting and Unselecting Items

Most of the Train Sim Modeler commands operate on a current item. The item may be 
a part, a polygon, a point, a cross section or a template.

In addition to a current item, some commands operate on one or more selected items.

For example, assume that while you have selected part mode (Mode | Part) that your 
project has more than exactly three parts. The current part is appears in bright blue 
and the other two parts in dull blue. You can change the current item (displayed in 
bright blue) by pressing the 'p' key to move to the previous item or pressing the 'n' 
key to move to the next item. Pressing the 'n' key three times will cycle you back to 
the original item. Similarly, pressing the 'p' key three times will cycle you back to the 
original item.

There are two other methods to move between items.

 

 The first method is to click on either the 
previous or next buttons on the Action 
Toolbar

 

The second method is to right-click on the 
mouse button to display the pop-up menu 
and choose either Next or Previous.



For some operations, you may want to select more than one item. For example, if you 
have a three part project and want to all three parts as a single unit, you would want to 
select all three parts before you use the Transform | Move Mode operation.

To select all of the items (while in Part mode the items to be selected are all of the 
parts in the project), you can use the Select All features by pressing the 'a' key. This 
is an easy way to move, scale, or rotate your entire project.

To select only the current item for an operation, use the Select the Current Item by 
pressing Shift+'S' key.

Conversely to unselect only the current item, use the Unselect the Current Item by 
pressing the 'u' key.

To unselect all of the items, use Unselect All by pressing Shift+'u' key.

To reverse the selection status of the current item, use Toggle the Selection Status 
of Current Item by pressing the spacebar. Pressing the spacebar alternately selects 
and unselects the current item.

To reverse the selection status of all items, use Edit | Invert the Selections from the 
menu. This command simultaneously selects all the unselected items, and unselects 
all of the selected items.

Uses for Multiple Selection of Items

●     Move, Scale, and Rotate An Entire Project 
●     Move, Scale and Rotate Groups of Parts 
●     Move, Scale and Rotate Groups of Points 
●     Texture multiple parts at once 
●     Create polygons out of selected points 
●     Fix a polygon’s point order 

If Train Sim Modeler is not in Move, Rotate, nor Move modes, you can also make a 
part the current part by clicking with the mouse. To help you select the part, you can 
use View | View Part Axes from the menu to display a small version of the part axes. 
Click near the part's center to make that part the current one.

 



Selecting Polygons

If you're operating in Polygon Mode, you can use the mouse to select a polygon.

To select a polygon, click on its center. If more than one polygon is "stacked", you can 
click again to select the polygon on the next "layter". This method of selecting works 
only if you are not in Move, Rotate or Scale mode.

Here's a tip: To find the center of the polygon, turn on the surface normals. You can 
do this by selecting View | View Surface Normals from the menu as you can see 
below

 

 Continue with Basic Texturing 



Texturing Basics

Textures and Texturing with Train Sim 
Modeler
 

One of the most powerful techniques for adding realism to objects in Train Simulator without 
the difficulty of intricate modeling, or the risk of dragging performance down is to use of bitmap 
images as textures. A simple scanned photograph of the front of a building can provide far 
more detail and realism than hours of detailed modeling can achieve.

Creating a texture file and applying it to your model precisely is sometimes difficult. Luckily 
Train Sim Modeler provides several tools to make this process as flexible, accurate, and easy 
as possible.

Train Sim Modeler gives you the ability to define any portion of a texture image file to apply to 
the side of an entire part. For ultimate flexibility, Train Sim Modeler lets you apply a texture to 
an individual polygon in your model. Textures applied to an individual polygon take 
precedence over textures applied to the entire part. This makes it easy to apply a brick texture 
to a wall, then select one polygon in the middle of the wall and apply a separate texture with a 
picture of a window on it, for example.

In Perspective view, you can preview your model with textures applied. You can zoom in and 
rotate the model to ensure that your textures are placed correctly. This speeds up your 
designs since you can see how the design will look without having to run the Route Editor or 
Train Simulator so often.

You can apply textures to parts in two ways. The simplest method is the normal mapping, a 
straightforward ‘projection’ of the image to one side of the part, almost as if a slide projector is 
pointing at your model. You can apply the same or different textures to the front, back, left, 
right, top, and bottom of any part. The other method performs a cylindrical mapping operation 
that is best thought of as wrapping the image into a tube, then shrinking it onto your model. 
This is extremely affective for roundish items such as tanker cars, water towers, smoke 
stacks, etc.

There’s really no way to fully understand how texturing works without digging in and trying it 
out. Fortunately, Train Sim Modeler lets you easily experiment with different texturing 
techniques.

 

Simple Texture Mapping
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For this example, you'll use a simple sphere. Start a new project and create a default 
conventional sphere. Select Part | Add | Sphere | Conventional from the menu and then turn 
on solid display mode by selecting the View | Perspective View | Display as Solid Adjust the 
zoom level in the three design views and the perspective view so you can see the sphere in all 
the views. Apply a texture to this (or any) object with these steps:

1.  Select Part | Texture from the menu. Alternatively you can press the ‘F4’ key or right-
click with the mouse and select Textures. The Part Texture Assignments dialog 
appears.

   
2.  Click the Browse button to the right of the ‘Back’ edit box as shown above. Naviate to 

the TS Modeler \Textures folder and select the file tsm_sphere.bmp texture from the 
file open dialog box as below:
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Click on the Open button to continue
   

3.  The Texture Properties dialog appears. Here you can specify which portion of the 
texture that you want to apply to the Back of the sphere. You can specify a portion of 
the texture by dragging a selection box around part of the image with the mouse, or by 
entering values in the Crop and Size fields in the dialog box. For now, accept the 
default which maps the entire texture to the back of the sphere. Click the OK button to 
proceed.
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4.  Click the OK button once more in the Part Texture Assignments dialog to close it. 

You'll see a sphere similar to the one below. 

Note how the texture was applied to the sphere as if it were a flat object. If you rotate the 
sphere in the perspective view, you’ll see distortion at the edge of the texture because of this. 
In the next example, you'll see how a texture can be wrapped around an object to reduce or 
eliminate the distortion.

 

Cylindrical Texture Mapping

This example, uses the same sphere as the previous one except that instead of applying a 
texture the the back of the sphere, you'll apply a wrapped texture.

Again, start a new project and create a default conventional sphere. Select Part | Add | 
Sphere | Conventional from the menu or choose the Conventional Sphere from the Part 

file:///C|/_PremierCollectionInstallations/_TSModeler/Help/Design-Texturing%20Basics.htm (4 of 6) [1/12/02 3:19:04 PM]



Texturing Basics

Palette. Apply the texture to the sphere with these steps:

1.  Select Part | Texture from the menu or press the ‘F4’ key.
2.  Click the Browse button to the right of the ‘Wrapped’ edit box, and chose the same 

texture filename tsm_sphere.bmp. 
 

Click the OK button on the Texture Properties dialog box to accept the default (which 
maps the entire texture onto the sphere). Be sure that the Y radio button in the Wrap 
Axis group and click the OK button. 
  

3.  You'll see the new sphere. If you rotate the sphere in the perspective view you’ll notice 
that the texture is cleanly wrapped around the sphere, eliminating almost all of the 
distortion experienced in the previous tutorial. Only the extreme top and bottom areas of 
the sphere display significant distortion.
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Continue with Basic Animation
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Basic Animation
 

To animate a Train Simulator object, certain information must be added to the object's shape file. 
Train Sim Modeler provides three methods to specify animation parameters. Some parts can be 
animated by simply using the proper part name and setting up your part hierarchy properly. You 
can also either enter position and/or rotation numeric values into a dialog box, or you can visually 
move/rotate parts with the mouse to specify the key frame data.

Important Concepts:

Part Hierarchy: A way of linking parts together using the ‘parent’ field in the 
part/properties dialog box. One part has to be the ‘Main’ part. This part can be called 
whatever you like, but it must not have a parent part. Leave the ‘parent’ field blank, or 
select ‘NONE’ from the drop down list. All other parts must have a ‘parent’ part. If a part is 
animated, all children of that part (also grandchildren, great-grandchildren, etc.) inherit the 
motion and rotation settings of their ‘ancestors.’ More explanation will follow in the 
examples below. 
  
Pivot Point: The point in space around which a part rotates. The main part must have its 
pivot point set to the world origin, or the 0, 0, 0 point in space. All other parts should have 
the pivot point located at the point the part should rotate around. 
  
Orientation: A representation of the rotational state of a part. Train Sim Modeler uses 
‘Euler Rotations’ which are simply pitch, bank, and heading angles. 
  
Part Axis: The position of each part’s axis is used to specify the part’s position in space, 
as well as its ‘pivot point’ and ‘orientation’ (see above.) The position and pivot point are 
simply the location of the point where the x, y, and z axis lines meet. The orientation is 
shown by the angles of the x, y, and z axis lines. 
  
Key Frame: A specific time entry that specifies a position and/or orientation of a part. Train 
Simulator interpolates the ‘in between’ values of a part’s position and orientation to 
produce a smooth animation. 
  
Last Frame: This value is specified in the File | Project Properties dialog. It contains the 
last key frame number contained in the project. Note that frames are numbered from zero, 
so a ‘last frame’ of eight indicates that nine key frames exist in the project. 
  
Complex Project: This is also a setting in File | Project Properties. This is a simple 
checkbox that must be checked in order for Train Sim Modeler to include animation when 
creating your Train Simulator files. 
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Method 1: Automatic Animation:

Create a simple project with the following hierarchy:

· Main
            · ------Bogie1
                                     · ------Wheels11 
                                     · ------Wheels12

Make sure the model is placed so that the wheels sit on the ‘y = 0’ world axis line (the horizontal 
light gray grid line in the front and side views.) Also, make sure the ‘Main’ part’s axis is at the 
world origin. You can use the Part | Center Axis | To Origin command to easily place the axis 
exactly at the origin. All other parts should have their axes placed at the geometric center of the 
part to ensure rotation occurs properly. Use the Part | Center Axis | To Object command to 
easily place the axis in the proper location. When this project is generated as a locomotive, the 
bogie should pivot properly when going around curves, and the wheels should pivot with the 
bogie while rotating properly as the locomotive moves along the track.

Method 2: Numeric Entry:

This is the most difficult, but most accurate method to enter animation parameters. To animate a 
part, go to the Edit | Part Properties dialog and click the Animation button. A list of motion and 
rotation key frames will appear. You can add, edit, or delete entries for each frame. Simply add 
the keyframe entries using the Add button and enter the frame number, and the position or 
rotation values for the part at the frame number you specify.

This dialog also includes Load and Save buttons. This allows you to easily copy an animation 
sequence from one part to another, or to archive frequently used animation sequences.

The Numeric Entry method is also useful for troubleshooting and editing animations created with 
the visual method, described below.

As an example, try setting up a real simple project with the following hierarchy:

· Main
· ------Wheels1 
· ------Wheels2 
· ------Wheels3
· ------Rod01 
· ------Rod02

In the example above, part Main has no parent. All other parts are children of Main. In other 
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words, their parent part is Main. The file tsm_Anim_060.dst in the \projects folder can also be 
used to illustrate the points in this tutorial.

In the File | Project Properties dialog, set the last frame # to 8, and make sure the checkbox 
Complex Object is checked.

In the \projects folder find the file wheels.rot. Make Wheels1 the current part, select Edit | 
Part Properties and click the Animation button.

Click the Load button for the Rotation Keys section of the dialog (the bottom half) and choose 
the file wheels.rot.
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Repeat this for Wheels2 and Wheels3.

If you now create this engine, the wheels will rotate properly in Train Simulator.

 

Method 3: Visual Method Using the Mouse:

Animating the rods is slightly more complex. You'll use motion animation for them, but not 
rotation.

To animate Rod01, make it the current part and make sure it's in the proper place for the start of 
the animation loop. You'll want to make sure it 'connects' to the proper positions on the wheels. 
Use the Part | Reset axis orientation command to make sure the axis isn't rotated at all (this 
should really be done on all animated parts.)
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Fist click the Ani button on the toolbar  . Then click the Set Motion button. This sets the initial 
position for frame 0.

Slide the frame slider to frame 1. Although the display won't show it, in frame 1 the wheel will 
have rotated 1/8 of a rotation, or 45 degrees. Move the rod to the correct place on the wheels to 
account for the 45 degrees of rotation. Click the Set Motion button again to associate this 
position for frame 1. Continue advancing the frame slider, positioning the part, and clicking Set 
Motion until you have competed the eight frames.
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Make sure the position in frame 8 is exactly the same as in frame 0 to ensure there are no 

‘glitches’ when the animation loops. When you're all done, click the  toolbar button again.

You can test your animation on the current part by dragging the frame slider bar. For each frame, 
the part will be shown in the position/orientation you have set. This is an easy way to verify that 
you have set all the key frames properly.

You should now have rotating wheels with rods that move appropriately. It usually takes a 
considerable amount of trial and error to get things to match up just right, so don't get 
discouraged if things don't seem to act the way you expect.

 

Train Sim Modeler Limitations:

At this early stage in the life of Train Sim Modeler we are still learning the various parameters that 
Train Simulator expects. We anticipate that we can improve the way in which Train Sim Modeler 
handles animation in the near future. Until then, you can use Train Sim Modeler to add basic 
animation to an object.

As we release updates to Train Sim Modeler, we expect to add features that make animations for 
Train Simulator easier. For instance, the visual mode of setting a part’s animation current only 
shows the animation of the part you are working on. This makes animating hierarchical items 
such as wiper arms and their attached blades more difficult. We expect that Train Sim Modeler 
will address this issue by graphically representing all animated parts in their correct position and 
orientation, making complex animations much easier to create. In addition, sometimes parts with 
complex rotations are not shown properly when using the visual method described above. At 
times you will have to use the Edit | Part Properties | Animation dialog to check the rotational 
parameters applied to a part.

 

Continue with Using Backdrops
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Make sure the position in frame 8 is exactly the same as in frame 0 to ensure there are no 

‘glitches’ when the animation loops. When you're all done, click the  toolbar button again.

You can test your animation on the current part by dragging the frame slider bar. For each frame, 
the part will be shown in the position/orientation you have set. This is an easy way to verify that 
you have set all the key frames properly.

You should now have rotating wheels with rods that move appropriately. It usually takes a 
considerable amount of trial and error to get things to match up just right, so don't get 
discouraged if things don't seem to act the way you expect.
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Train Sim Modeler Limitations:

At this early stage in the life of Train Sim Modeler we are still learning the various parameters that 
Train Simulator expects. We anticipate that we can improve the way in which Train Sim Modeler 
handles animation in the near future. Until then, you can use Train Sim Modeler to add basic 
animation to an object.

As we release updates to Train Sim Modeler, we expect to add features that make animations for 
Train Simulator easier. For instance, the visual mode of setting a part’s animation current only 
shows the animation of the part you are working on. This makes animating hierarchical items 
such as wiper arms and their attached blades more difficult. We expect that Train Sim Modeler 
will address this issue by graphically representing all animated parts in their correct position and 
orientation, making complex animations much easier to create. In addition, sometimes parts with 
complex rotations are not shown properly when using the visual method described above. At 
times you will have to use the Edit | Part Properties | Animation dialog to check the rotational 
parameters applied to a part.

 

Continue with Using Backdrops
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Adding a backdrop to Train Sim 
Modeler
 

Sometimes it's easier to trace the outline of an object rather than try to draw it 
freehand. Tracing lets you mold your design to the shape of a drawing..

For tracing, you can use the backdrop feature. A backdrop is an image of an object 
such as a water tower or a locomotive. The image is a single view, the top, front or 
side. Using a backdrop can save you valuable design time and allow you to add 
amazing level of detail and accuracy to your projects.

Basically a backdrop is a computer image. The image must be a bitmap in the *.bmp 
file format. You can scan photos, pictures and diagrams or convert other computer 
images to the bitmap format using any of the popular paint programs.

This article shows you how to use backdrops for your design projects. Train Sim 
Modeler allows up to three backdrops, one for each of the Top, Front and Side views. 
If you use separate bitmaps for the Top, Front and Side views, each can have it's own 
scale, but each must be set separately.

1.  Start Train Sim Modeler and select File | New 
2.  Click on the Top view to make it the active one and then select View | 

Backdrop | Load. The Open dialog appears. Locate the desired backdrop and 
click the OK button. If you're using multiple backdrops (for other view), repeat 
the procedure for each backdrop. Note: Don't forget to click on the desired view 
prior to loading the next backdrop.



3.  Select View | Backdrop | Scale. The Backdrop Scale dialog is displayed 
There are two methods of setting the scale
:
a. Type Distance and Backdrop Image Pixels that represents this value (very 
difficult method) 
b. Click on two points a known distance apart and type this value in the 
Distance edit box. (easiest method)

Use the second method. Click again in Top view. You'll now click two times on 
the boxcar image to set the number of pixels. First click on the leftmost side of 
the boxcar. Next click on the rightmost side of the boxcar. A value appears in 
the Distance edit box. Erase this value and type the know length of the 
wingspan.The boxcar has a length of 35.8 feet. Type this value and click the 
Apply button. 



4.  If you have other backdrops for the Front and/or Side views, repeat Steps 2 and 
3 again and be sure to set the scale if it is different from the Top view.

Here's the front panel view with a backdrop image:



For some operations, fine tuning a project may be difficult if the backdrop image is 
displayed. For these operations, you can hide and unhide the backdrop using this 
command to hide and unhide the backdrop in the active view.

View | Backdrop | Hide 

  

Using the Train Sim Modeler backdrop feature will help you easily shape parts to 
resemble the images.

Continue with Smooth Shading
    



Toolbars
 

Main Toolbar

At the top of the screen are two detachable toolbars. The Main Toolbar 
has all the normal buttons you’d expect in a Windows application:

Standard Toolbar Buttons

From left to right the buttons are New, Open, Save, Cut, Copy, Paste, 
Print (non-functional) and Help.

Zoom Buttons

The large magnifying glass zooms in. The small one zooms out.

Grid Button

Turns the grid on and off. When the button is depressed (shown) the grid 
is on. 

Symmetry Buttons

Turns Cross Section symmetry on and off. Each axis is controlled 
separately. 

  

Action Toolbar

Operational Mode Buttons

The modes are: Part, Polygon, Point, Cross Section, and Template 



Mouse Select

Groups of Parts and Points can be selected by clicking the Mouse Select 
button then dragging a mouse box around the items you want to 
manipulate. The selected items can then be dragged, scaled, deleted, 
and rotated as a group. To deselect selected items, choose 
‘Edit/Unselect All’ from the menu. 

Add Points

When in Template Mode, if the Add Points button is depressed you can 
add points to the current template by clicking in the views. 

Animate Part

Click on this button to apply animation frames to the current part. 

Transform Buttons

These buttons are: Move, Rotate, and Scale. 

When the Move button is depressed, you can drag items around the 
views depending on the mode you’re in. If any of the Constraint buttons 
described below are depressed, movement will be restricted along those 
axes. If you are in Cross Section mode and any of the Symmetry buttons 
are depressed, the dragging a cross section point will result in the 
opposite point mirroring the movement of the point you are dragging. 

When the Rotate button is depressed, you can rotate the current part, 
cross section, or selection group around its axis by dragging to the right 
and left in the various views. The axis of rotation depends on which view 
your mouse is in. The Top View rotates around the Y axis. The Front 
View rotates around the Z axis, and the Side View rotates around the X 
axis. 

When the Scale button is depressed, you can make a part, cross section, 
or selection group larger or smaller by dragging with the mouse. Drag left 



to make it smaller, and right to make it larger. If any of the Constraint 
buttons described below are depressed, scaling will be restricted along 
those axes. 

Constraint Buttons

When these buttons are depressed, any scale or move operations will be 
limited to the axis represented by the buttons that are NOT depressed. In 
other words, to stretch an object along the Y axis (make it taller) depress 
the X and Z axes before selecting the Transform Scale button described 
above. 

Previous-Next Buttons

These buttons are Previous and Next 

Press the Previous button to move to the previous item. Press the Next 
button to move to the next item. The Previous-Next buttons perform the 
same action as the "p" and "n" keys. 

Select by Name Button

This button displays the Part List from which you can select any of the 
project parts by name. 

  

Parts Toolbar

The Parts Toolbar is also detachable and may be placed anywhere on your 
desktop. 



 

 Press any of these buttons to enter Parts mode and add 
the respective style of part to the project.

These buttons have the same function as selecting Parts | 
Add Part from the menu.

From top to bottom, the parts are:

■     Box 
■     Tube 
■     Disk 
■     Oval 
■     Polygon 
■     Conventional Sphere 
■     Geodesic Sphere 
■     Cone 

Solid View Controlbar

The Solid View Controlbar lets you change the zoom magnification and 
lighting for the solid perspective view. This controlbar appears only when 
you've selected View | Perspective View | Display as Solid. Adjust the 
sliders by dragging to the left and right. 

 

    

Continue with the Reference Section - Glossary 



Glossary
 

Backdrop A background image loaded into the top, side, or front view in FS Design Studio. 
Often used as a reference for designing objects.

CDT File extension used by Train Sim Modeler for saving a template. (*.cdt)

Constrain A technique to prevent the selected axis from being altered. To move an item 
upward in the front view, only the Y-axis should be free. The X and Z-axis should 
be constrained to prevent them from being altered.

Copy Command for duplicating a part with out re-drawing it. It places the selected part 
on the "clipboard" and is usually followed with the Paste command.

Crash Detection A setting assigned to a scenery object that tells Train Simulator to crash when an 
object comes in contact with it.

Cross-section A collection of points that define the shape of an object at a particular point along 
its length. An object such as a tube is defined by creating several cross sections. 
Each cross section’s shape is edited so that it matches the shape of the fuselage 
at that point along its length. A very accurate depiction of a complex shape can be 
achieved in this manner.

Cut Command for removing the highlighted or selected items in the project and 
transferring them to the "clipboard". Objects that have been Cut, can be then be 
Pasted back into the project as long as no other items have been placed on the 
clipboard.

Delete Command for removing the highlighted or selected items like parts, polygons, 
cross-section or points.

Select Command for highlighting the current item. Multiple items can be selected. Used 
for editing multiple parts the same at one time.

Extrude Process of making a template into a structured part.

Flip Command for inverting the selected polygon. Polygons have one visible surface 
unless specified. The Flip command allows the user to place the visible surface 
polygon on either the inside of the object or the outside.

Front View Used to represent a view of the project when looking from the front.

DST File extension used by Train Sim Modeler for saving a project. (*.dst)

DSP File extension used by Train Sim Modeler for saving a part. (*.dsp)



Grid A layout of squares in the top, side and front views used to help scale projects.

Merge Project Process where individual Train Sim Modeler projects are combined into one. To 
use this, one project must be open then Merge Project is chosen from the File 
menu. A new project is then chosen and opened.

Mirror Command for making a polygon two-sided. Typically a polygon has one side 
visible and one side clear. Using the Mirror command in the Polygon menu will 
make the polygon have two sides

Next Command for highlighting the next item. The Next command is implemented by 
pressing the ‘N’ key on the keyboard or clicking the next button on the toolbar, or 
pressing the right arrow key.

Non-planar Polygons A polygon whose points do not lie in any one given plain. When Check Parts from 
the Edit menu is chosen, Train Sim Modeler checks all polygons and will ask you if 
you want to correct any non-planar polygons.

Part A collection of one or more points that may be created and editing with Train Sim 
Modeler. A Train Sim Modeler project consists of a single object which is made of 
one or more ‘Parts’. Parts are created using the Part | Add menu, or by drawing a 
template and using the Extrude or Sweep commands.

Paste Command that copies the contents of the clipboard and into the current project.

Perspective View A view of the project that can be rotated for viewing from any angle. Parts in the 
distance appear smaller, while closer objects appear larger.

Poly See Polygon

Polygon A surface defined by three or more vertices in a part. A Polygon has one visible 
side. The other side is invisible (see ‘Surface Normal’).

Polygon Smoothing A setting in part Properties menu that causes the part to be rendered using 
'Gouraud Shading.' This simulates curved surfaces by smoothing out the edges 
between polygons.

Properties A set of specific parameters that apply to a part or polygon. The Edit menu will 
show Part Properties when in part mode and Polygon Properties when in Polygon 
Mode.

Presets Option in the Part Properties menu that allows the setting of a specific display 
condition. (i.e. to tell FS2000or Aircraft Animator a rudder is actually a rudder)

Previous Command for highlighting an item on the screen by pressing the ‘P’ key on the 
keyboard, the left arrow key, or the Previous icon on the toolbar. When in Part 
mode, the ‘P’ key will highlight the previous part in the part list. Available in all 
modes except Template mode.



Reference Part Used in a project to give the designer an invisible placeholder and does not 
become part of the design as seen in Train Simulator.

Side View Used to represent a view of the project when looking from the right side.

Structured A part that is constructed of cross-sections that can be edited. Each cross section 
can be treated as a group of points, making it much easier to manipulate the shape 
of some types of part. Once a point has been deleted from the part, the part is no 
longer structured. Unstructured parts can still be edited, but you must deal with 
individual vertices rather than cross section shapes.

Subdivide Command for dividing polygons into multiple triangles by adding a point in the 
polygon’s center, and making new triangles, each of which uses the new center 
point and .two of the original points.

Surface Normal A line drawn from the center of a polygon toward the visible side. Some polygons 
may have the visible side facing in toward the center of the object. Using the 
Polygon | Flip will switch the surface normal. Polygon | Mirror will make the 
polygon have two visible sides.

Sweep Command used with Templates for createing a rounded surface. See Checklists | 
Making a Watertower.

Symmetry Command used for editing cross-sections. When symmetry is on, dragging a cross 
section point causes the opposite point to drag in an opposite direction to the one 
you are dragging, forcing the part to be symmetrical in one or more axes. Using 
symmetry on one axis will move two points in a cross-section. Using Symmetry on 
two axis’s will move four points.

Tagged Parts See also Presets. Parameters that are assigned to a specific part so they are 
recognized by FS2000 or Aircraft Animator. Tags are assigned in the Part Mode in 
the Edit | Part Properties menu by clicking the Presets button.

Template A two-dimensional outline from which a three-dimensional part is created. A 
template is not actually part of your project. It is not saved with the project, and it is 
not cleared when File/New is executed. To clear a template from a view, use the 
‘Template/Clear’ command on the menu.

Texture Template A ‘wire-frame’ snapshot of a part from a selected view that is placed on the 
Windows clipboard to be pasted into a graphic editing or painting program. This 
image can be painted on directly to create a texture that maps perfectly onto a 
part.

Texture A graphic image that is ‘projected’ onto a part used to add detail to an object.

Translate Move an object, part, or vertex in space.



Transparent Partially see-through parts, such as the tinted glass in a passenger car window. 
Train Sim Modeler supports polygon transparency, texture alpha transparency, 
and a ‘stencil’ texture transparency mode.

Undo Command for restoring the project to the state prior to the last edit. Affects only 
parts in the project. Template editing is not affected by the ‘Undo’ command.

Vertex The fundamental building block of a part. A part consists of one or more vertices. If 
the part is to be displayed as a solid, polygons are defined from the vertices in the 
part.

Vertices Plural form of ‘vertex’.

Wrap Texture A texture that has been applied to a part as if the texture were wrapped into a tube, 
placed around the part, then shrunk to fit the part. Useful especially for cylindrical 
and spherical objects.
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Shortcut Keys
Main Modes

F5 - Part Mode

F7 - Poly Mode

F8 - Point Mode

F9 - Cross Section Mode

F10 - Template Mode

Sub-Modes

F2 - Part Properties

F11 - Select Mode

F12 - Ruler Mode

m - Move Mode

r - Rotate Mode

s - Scale Mode

Commands

spacebar - toggle select

S - Select

a - Select All

u - unselect



U - unselect all

x - constrain x

y - constrain y

z - constrain z

h - hide selected

H - unhide all

n - next item

p - previous item

N - next object

P - previous object

Ctrl-Home - main object

f - flip polygon

i - zoom in

o - zoom out

A - animate

C - create TS object file

v - snap current vertex to nearext vertex on another part

F - flip all, or selected polygons

Ctrl-p - make poly from selected points



right arrow - next item

left arrow - previous item

shift left arrow - nudge left

shift right arrow - nudge right

shift up arrow - nudge up

shift down arrow - nudge down

Ctrl-left arrow - nudge backdrop left

Ctrl-right arrow - nudge backdrop right

Ctrl-up arrow - nudge backdrop up

Ctrl-down arrow - nudge backdrop down

F2 - properties

F3 - part list

F4 - part textures

Ctrl Z - undo

Ctrl C - copy

Ctrl X - cut

Ctrl V - paste

Ctrl N - File/New

Ctrl O - File/Open



Ctrl S - File/Save

Delete - delete
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Basics of Animation
 

Hierarchical Scheme

To make an animated model, your Train Sim Modeler project must be organized in a hierarchical scheme.

Thus a Train Simulator animated model has two or more objects. To illustrate the technique, we'll use part of 
the example that is presented in the Train Simulator technical document "Creation of a Complex Shape".

 Engine 
      |__________Bogie1
                                   |___________Wheels11
                                  |___________Wheels12

Engine is the parent of Bogie1. Conversely, Bogie1 is the child of Engine. Similarly, Wheels11 and 
Wheels12 are children of Bogie1.

Train Simulator can animate this model correctly only if the wheels, bogies and engine are separate objects. 
The wheels are linked to the bogies. And the bogies are linked to the engine. The wheels can rotate around 
their axis separately from the bogies that can spin around its axis.

 

Special Names

To facilitate animation, Train Simulator maintains a fixed 
set of special object names which we call Standard Train 
Part Names. Fro wheels and bogies, Train Simulator 
performs the corresponding animation for that part.

At this time we are unsure as to the use of these reserved 
names, but we believe that they are used by Train 
Simulator to control the timing of parts like pantographs 
and wipers. 

To identify a Train Sim Modeler part with one of these 
Standard Train Part Names first ensure that you have 
selected the desired part in one of the Train Sim Modeler 
views.

Having selected the desired part, choose Edit | Part 
Properties from the menu.

Next click on the Train Names button to display the 
complete list of special names. This is the same list that 
appears to the right.

Standard Train Part Names

Bogie1
Bogie2
Bogie3
PantographTop1
PantographBottom1
PantographTop2
PantographBottom2
PantographTop1A
PantographMiddle1A
PantographBottom1A
PantographTop1B
PantographMiddle1B
PantographBottom1B
PantographTop2A
PantographMiddle2A
PantographBottom2A
PantographTop2B
PantographMiddle2B
PantographBottom2B
MirrorArmLeft1
MirrorLeft1
MirrorArmLeft2
MirrorLeft2
MirrorArmRight1
MirrorRight1

Rod01
Rod02
Rod03
Rod04
Rod05
Rod06
WiperArmLeft1
WiperBlade1
WiperArmLeft2
WiperBlade2
WiperArmRight1
WiperBlade3
WiperArmRight
WiperBlade4
Wheels1
Wheels2
Wheels3
Wheels4
Wheels11
Wheels12
Wheels13
Wheels21
Wheels22
Wheels23
Wheels31



Click on that name. This part is now identified with the 
special name for Train Simulator. 

MirrorArmRight2
MirrorRight2

Wheels32
Wheels33

Specify the Parent

From this dialog, you can also identify the name of the direct parent for this part. In the example below, we are 
defining a part as a Bogie1 that is linked to a part named Engine which is the parent of Bogie1.

Finally click the OK button.

In practice, you'd also link the wheels to this bogie, etc.

Continue Reference Section - Materials 



Technical considerations
 

System Requirements
In general, if you can run Microsoft Train Simulator on your computer, you'll be able to 
run Train Sim Modeler. However, Train Sim Modeler projects can become rather large 
in memory requirements, and complex 3D objects take time to manipulate. Therefore, 
the faster your PC, and the more RAM you have, the happier you'll be.

In addition, Train Sim Modeler uses DirectX to display your models in a solid 
perspective view. It relies on DirectX 7 and hardware acceleration for solid rendering. 
We have had good luck with hardware accelerated video cards with 16MB or more 
RAM. If you have 8MB of video RAM or less, you may experience problems with the 
3D perspective view. In addition, users with Voodoo graphics cards experience 
display problems under some circumstances.

Limitations in TrainSim Modeler

3D Solid Display
TrainSim Modeler allows you to display your project in full color as a solid three 
dimensional object. There are some limitations to this display. Transparent textures 
don't look transparent in the TrainSim Modeler display, but they work properly in the 
simulator. In general, use the 3D solid display to help you accurately place textures 
and get a general idea of how your model is looking. Always check your results in the 
simulator because of the differences in the simulator's display and the TrainSim 
Modeler display.

Controlling Special System Options
You can change some of the characteristics of Train Sim Modeler by editing the file 
default.cfg. Train Sim Modeler uses this file to determine the settings whenever 
you start the application. You can edit this file with a text editor to change the default 
settings. Please make a backup of the original default.cfg file in case you want to 
restore the original settings.



This is a listing of the default.cfg file:

Scale:1
DoubleBuffer:1
CustomCursor:1

The 'Scale' value controls the default value for the 'Snap to Grid' command in the 
'Part' menu.

The 'DoubleBuffer' setting controls the smoothness of screen updates. If you are 
having display problems, try replacing the '1' with a '0'. The display will flicker while 
you are editing, but on some systems, double buffering causes problems.

Some graphics cards (Voodoo in particular) and systems running Windows 95 have 
difficulty displaying custom cursors used in TrainSim Modeler. If you have difficulty 
seeing cursors in the edit views, change the 'CustomCursor' setting from '1' to '0'. 
This causes TSM to use only the standard mouse pointer.
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About the Sample Projects
 

The Projects folder has completed projects that you can use as starting points for your own projects. Our 
thanks fo the respective designers for sharing them.

SEICO_Boxcar Stewart Clark A stylish boxcar

Palmetto Jason Webb A "Floridian" palmetto bush. This project 
demonstrates a technique to make shrubs and trees.

66animated Matt Peddlesden This is a Class 66 locomotive that has been 
animated. This is a commonly used train in the U.K.

wagontut2 Matt Peddlesden This is a simple wagon that you put together in 
Tutorial 2.

 dieseltut2 Matt Peddlesden This is a diesel locomotive that you put together in 
Tutorial 3

Continue with the Reference Section - Other Sources of Information 



Other Sources of Information
 

Websites

Abacus http://TrainSimulatorWorld.com/tsm/tsmain.com This is our official web page 
that contains, hints and tips, 
free downloads, tech support 
reports and other information 
about using Train Sim 
Modeler.

3dTrains http://www.3dtrains.com 3D Trains is owned and 
operated by professional 
designers. They have a variety 
of forums and one for 
designing for MSTS using 
Train Sim Modeler.

Train Sim Com http://www.train-sim.com A large site that specializes in 
free downloads. You'll also find 
a large number of active 
forums.

Kuju http://www.kuju.com/traindef.htm Kuju are the developers of 
MSTS.

Microsoft http://www.microsoft.com/games/trainsim/ This is the official word about 
everything related to Flight 
Simulator 2000

Auran http://www.auran.com Makers of add-ons for MSTS 
and developers of the Trainz 
Simulator.

http://trainsimulatorworld.com/tsm/tsmain.com
http://www.3dtrains.com/
http://www.train-sim.com/
http://www.kuju.com/traindef.htm
http://www.microsoft.com/games/trainsim/
http://www.auran.com/


Jason Webb http://www.calmstorm.com/scl-csx/ SCL/CSX Line 

Matt Peddlesden  http://www.uktrainsim.com  

 

 Reference Material

 

The Microsoft Train Simulator CD-ROM has detailed information that is useful for making objects for Train 
Simulator. These files are all located in the TechDocs folder:

●     Conversion of Shapes and Textures.doc 
●     Creation of a Complex Shape.doc - especially important to designers who are making animated objects. 
●     Creation a Simpler Shape.doc 
●     Conversion of Shapes and Textures.doc 
●     How to Write Track Hazard Files 
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Summary of Changes
 

Changes to the HELP file as of 11/29/01

The Basics - "Changing a Part's Surface Appearance" - Change - minor textual 
corrections and clarifications

Tutorials - Add - new tutorial describes the detailed steps for making a diesel 
locomotive
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Train Sim Modeler

 

Do you have a technical question?

If you have an Internet connection,
you can send your question directly to our Tech Support Staff

Please fill out the information below and send your question.

 

First Name        Last Name 

Email Address please type carefully

Question 

Please connect to the Internet
and click Send

 

Revision 6142 
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